# Contents

1 Introduction 14
   1.1 What is KMyMoney? 14
   1.2 What KMyMoney is not 14

2 What's new in this release 15

3 Making the most of KMyMoney 17
   3.1 Basic Accounting 17
      3.1.1 Defining the accounts (personal records) 18
      3.1.2 Defining the accounts (business records) 18
   3.2 Mapping your finances to KMyMoney 18
      3.2.1 Accounts 18
         3.2.1.1 Accounts - Asset 18
         3.2.1.2 Accounts - Liability 19
      3.2.2 Institutions 19
      3.2.3 Categories 19
      3.2.4 Sub-Categories 19
      3.2.5 Tags 19
      3.2.6 Payees 19
      3.2.7 Scheduled transactions 20
   3.3 Useful Tips 20

4 Using KMyMoney for the first time 21
   4.1 Running KMyMoney for the first time 21
   4.2 The main window 22
   4.3 Creating a new file 23
   4.4 Creating accounts 27
   4.5 Schedules 28
   4.6 Categories 28
   4.7 Tags 28
   4.8 Payees 28
   4.9 Quicken Interchange Format (QIF) Import 28
The KMyMoney Handbook

4.10 Searching for transactions ........................................ 29
4.11 Reconciliation ....................................................... 29
4.12 Backing up .......................................................... 29
4.13 Launching KMyMoney ............................................... 29
4.14 How to move KMyMoney to a new computer .................. 30
   4.14.1 Moving your data ............................................. 30
   4.14.2 Moving your settings ....................................... 30
     4.14.2.1 Moving plugin settings ................................. 30
4.15 Contacting the Developers / Reporting Bugs ................. 31
   4.15.1 Contacting the developers ................................ 31
   4.15.2 Reporting bugs ............................................. 31
     4.15.2.1 Writing High Quality Bug Reports .................. 31

5 Institutions ................................................................. 33
   5.1 Institution Options ............................................... 33
     5.1.1 New Institution .............................................. 34
   5.2 Account Options .................................................. 34

6 Accounts ................................................................. 36
   6.1 The Accounts View ............................................... 36
   6.2 Creating an Account .............................................. 36
     6.2.1 The Institution (Bank) name ............................... 37
     6.2.2 Account ....................................................... 38
     6.2.3 Credit Card Accounts ....................................... 39
     6.2.4 Investment Accounts ....................................... 39
     6.2.5 Loan Accounts ............................................... 40
     6.2.6 Parent Account .............................................. 44
     6.2.7 Review and save the account details .................... 45
   6.3 Opening / viewing accounts .................................... 45
   6.4 Editing Account Information ................................... 45
   6.5 Deleting accounts .............................................. 46

7 Categories ................................................................. 48
   7.1 Creating a category .............................................. 48
   7.2 Editing a Category ............................................... 49
   7.3 VAT Support ...................................................... 49
   7.4 Deleting a category .............................................. 50

8 Tags ....................................................................... 51
   8.1 Tags List .......................................................... 51
     8.1.1 Adding a Tag ................................................ 52
     8.1.2 Renaming a Tag .............................................. 52
     8.1.3 Deleting a Tag .............................................. 52
   8.2 Tagged transactions and Tag details ......................... 52
     8.2.1 Tagged transactions ....................................... 53
     8.2.2 Tag details ................................................... 53
9 Payees

9.1 Payees List ................................................. 54
  9.1.1 Adding a Payee or Payer ............................ 55
  9.1.2 Renaming a Payee or Payer ......................... 55
  9.1.3 Deleting a Payee or Payer ......................... 55

9.2 Additional Payee Details ................................. 55
  9.2.1 Personal Information ............................... 55
  9.2.2 Transaction Matching Settings ..................... 56
    9.2.2.1 Overview ..................................... 56
    9.2.2.2 Setting up ................................... 56
    9.2.2.3 Importing Transactions ....................... 56

9.3 Viewing Transaction History ......................... 57

10 Schedules .................................................. 58

10.1 Introduction ............................................. 58

10.2 Types of schedules ...................................... 58
  10.2.1 Bills ................................................. 59
  10.2.2 Deposits .............................................. 59
  10.2.3 Loans ............................................... 59
  10.2.4 Transfers ............................................. 59

10.3 The schedule view ....................................... 59

10.4 The new schedule dialog ............................... 60
  10.4.1 Filling in the fields ................................ 60
  10.4.2 Modifying the schedule behavior ................. 60
  10.4.3 Letting KMyMoney enter the transaction into the
        register ............................................. 61
  10.4.4 Letting KMyMoney know when the schedule will
        finish .............................................. 61

10.5 Editing schedules ........................................ 61

10.6 Deleting schedules ...................................... 61

10.7 The calendar view ....................................... 61

10.8 Entering scheduled transactions ..................... 63
  10.8.1 Manually entering scheduled transactions ....... 64
  10.8.2 Confirming the transaction to enter ............... 64
  10.8.3 Letting KMyMoney enter the scheduled transaction(s)
        for you ............................................. 65

11 Ledgers ...................................................... 66

11.1 The Ledger View ......................................... 66
  11.1.1 The filter area ..................................... 67
  11.1.2 The transaction list ................................ 67
  11.1.3 The transaction input form ....................... 68

11.2 Entering Transactions ................................. 68

11.3 Using the transaction input form ..................... 68
11.3.1 The fields of a transaction ................................................. 69
11.3.1.1 The Payee ................................................................. 69
11.3.1.2 The Category ........................................................... 69
11.3.1.3 The Tag ................................................................. 69
11.3.1.4 The Memo ............................................................... 69
11.3.1.5 The Check Number ..................................................... 70
11.3.1.6 The Date ................................................................. 70
11.3.1.7 The Amount ............................................................. 70
11.4 Directly inputting transactions into the list ................................... 70
11.4.1 Starting the edit ............................................................ 70
11.5 Split Transactions ................................................................ 71
11.6 Editing transactions ............................................................ 71
11.7 Deleting transactions .......................................................... 71
11.8 Matching Transactions ......................................................... 72
11.9 Understanding the Cleared State .............................................. 72
11.10 Changing Transaction Settings ............................................. 73
11.11 Other Functionality ............................................................ 74
12 Investments ............................................................................. 75
12.1 Investments in KMyMoney .................................................... 75
12.1.1 Investments ................................................................. 75
12.1.2 Base Currency ............................................................. 75
12.1.3 Investment Accounts ....................................................... 75
12.1.4 Brokerage Accounts ....................................................... 75
12.2 Creating an Investment Account ............................................ 76
12.3 Adding Investments to Your Account ...................................... 76
12.3.1 New Investment Wizard .................................................. 76
12.4 Editing an Investment .......................................................... 77
12.5 Investment Transactions ....................................................... 77
12.5.1 Activity ......................................................................... 78
12.5.2 Security ........................................................................ 78
12.5.3 Account ....................................................................... 78
12.5.4 Shares, Price & Total Amount ........................................... 79
12.5.5 Fees ........................................................................... 79
12.5.6 Interest ....................................................................... 79
12.6 Working With Foreign Investments ......................................... 79
12.7 Updating Prices .................................................................... 80
12.7.1 Manual Price Updates ..................................................... 80
12.7.2 Online Price Quotes ........................................................ 80
12.7.2.1 How Online Quotes Work .......................................... 80
12.7.2.2 Assigning a Quote Source .......................................... 81
12.7.2.3 Adjusting a quote ...................................................... 81
12.7.2.4 Fetching Quotes ......................................................... 81
12.7.2.5 Adding or Editing Quote Sources ................................. 82
12.8 Unimplemented Features ...................................................... 83
The KMyMoney Handbook

13 Currencies
13.1 Base currency ........................................ 84
13.1.1 Adding a new currency ......................... 85
13.2 Account setup ......................................... 85
13.3 Entering transactions using different currencies .... 85
13.4 Exchange rates for currencies ....................... 85
13.4.1 Entering prices manually ....................... 85
13.4.2 Online currency updates ....................... 86

14 Reconciliation
14.1 What is reconciliation? ............................... 87
14.2 The reconciliation wizard ............................ 87
14.2.1 Statement details ................................. 88
14.2.2 Interest ........................................... 88
14.2.3 Clearing transactions ............................ 89
14.2.4 Completing Reconciliation ...................... 90
14.2.4.1 Finishing Reconciliation ................... 90
14.2.4.2 Postponing Reconciliation ................. 90

15 Reports
15.1 Available Reports .................................. 92
15.1.1 Income and Expenses ......................... 92
15.1.2 Net Worth ........................................ 93
15.1.3 Transactions .................................... 93
15.1.4 Cash Flow ....................................... 93
15.1.5 Investments .................................... 93
15.1.6 Taxes ............................................ 93
15.1.7 Budgeting ....................................... 94
15.1.8 Forecast ......................................... 94
15.1.9 Information ..................................... 94
15.1.10 Charts ......................................... 94
15.1.11 Favorite Reports ............................... 94
15.1.12 Configuring Reports ......................... 94
15.2 Working With Reports .............................. 94
15.3 Configuring Reports ................................ 95
15.3.1 Working with custom reports .................. 95
15.3.2 Report Tab ..................................... 95
15.3.3 Rows/Columns Tab ............................. 95
15.3.4 Chart Tab ....................................... 97
15.3.5 Other Tabs ..................................... 97
15.4 Graphs & Charts .................................... 97
15.4.1 Viewing as a Chart ............................. 97
15.4.2 Available Chart Types ......................... 97
15.4.2.1 Line Graph .................................. 97
15.4.2.2 Bar Graph .................................. 97
15.4.2.3 Pie Chart ................................... 98
15.4.2.4 Ring Chart .................................. 98
16 Importing and Exporting

16.1 GnuCash Importer

16.1.1 GnuCash Files

16.1.2 Similarities, Differences, and Terminology

16.1.2.1 Small Business Usage

16.1.2.2 Accounts

16.1.2.2.1 Account types

16.1.2.2.2 Categories

16.1.2.2.3 Structure and Placeholders

16.1.2.2.4 Account Type map

16.1.2.3 Transactions and Splits

16.1.2.3.1 Balanced transactions

16.1.2.3.2 Payees

16.1.2.3.3 Transfers

16.1.2.3.4 Reconcile

16.1.2.4 Commodities

16.1.2.4.1 Currencies

16.1.2.4.2 Securities and Investments

16.1.2.4.3 Prices and currency rates

16.1.2.4.4 Online Quotes

16.1.2.5 Scheduled Transactions

16.1.2.5.1 Schedule types

16.1.2.5.2 Suspect Schedules

16.1.2.6 Reports

16.1.3 Selecting Importer Options

16.1.3.1 Investment Handling

16.1.3.2 Online Quotes

16.1.3.3 Scheduled Transactions

16.1.3.4 Decoding Options

16.1.3.5 Transaction Notes option

16.1.3.6 Debug Options

16.1.4 Import Report

16.2 QIF Importer

16.2.1 QIF format considered harmful

16.2.2 How to import a QIF file

16.2.3 Setting up a QIF profile

16.2.4 Transaction matching

16.2.5 Writing an import filter

16.2.6 Special KMyMoney QIF extensions

16.3 QIF Exporter

16.4 OFX Importer Plugin
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>16.4.1</td>
<td>Getting the plugin</td>
<td>110</td>
</tr>
<tr>
<td>16.4.2</td>
<td>What is OFX</td>
<td>110</td>
</tr>
<tr>
<td>16.4.3</td>
<td>Importing an OFX file</td>
<td>110</td>
</tr>
<tr>
<td>16.4.4</td>
<td>Importing Investments</td>
<td>111</td>
</tr>
<tr>
<td>16.4.5</td>
<td>Web Connect</td>
<td>111</td>
</tr>
<tr>
<td>16.4.6</td>
<td>Direct Connect</td>
<td>111</td>
</tr>
<tr>
<td>16.4.7</td>
<td>Exporting an OFX file</td>
<td>112</td>
</tr>
<tr>
<td>16.5</td>
<td>CSV Importer Plugin</td>
<td>112</td>
</tr>
<tr>
<td>16.5.1</td>
<td>Reasons for importing CSV Files</td>
<td>112</td>
</tr>
<tr>
<td>16.5.2</td>
<td>Getting the plugin</td>
<td>112</td>
</tr>
<tr>
<td>16.5.3</td>
<td>Importing a CSV file</td>
<td>112</td>
</tr>
<tr>
<td>16.5.3.1</td>
<td>CSV Import Wizard: Start</td>
<td>113</td>
</tr>
<tr>
<td>16.5.3.2</td>
<td>CSV Import Wizard: Separators</td>
<td>113</td>
</tr>
<tr>
<td>16.5.3.3</td>
<td>CSV Import Wizard: Banking</td>
<td>114</td>
</tr>
<tr>
<td>16.5.3.4</td>
<td>CSV Import Wizard: Investment</td>
<td>115</td>
</tr>
<tr>
<td>16.5.3.5</td>
<td>CSV Import Wizard: Lines</td>
<td>117</td>
</tr>
<tr>
<td>16.5.3.6</td>
<td>CSV Import Wizard: Securities and Symbols</td>
<td>117</td>
</tr>
<tr>
<td>16.5.3.7</td>
<td>CSV Import Wizard: Finish</td>
<td>118</td>
</tr>
<tr>
<td>16.5.3.8</td>
<td>Make QIF File</td>
<td>119</td>
</tr>
<tr>
<td>16.5.3.9</td>
<td>Finishing up</td>
<td>119</td>
</tr>
<tr>
<td>16.5.3.10</td>
<td>Adding Investment Activity Types</td>
<td>119</td>
</tr>
<tr>
<td>16.5.3.11</td>
<td>Configuration of CSV importer plugin</td>
<td>120</td>
</tr>
<tr>
<td>16.6</td>
<td>CSV Exporter</td>
<td>120</td>
</tr>
<tr>
<td>16.7</td>
<td>Writing Importer Plugins</td>
<td>121</td>
</tr>
<tr>
<td>17</td>
<td>Loans</td>
<td>122</td>
</tr>
<tr>
<td>17.1</td>
<td>Understanding Loans</td>
<td>122</td>
</tr>
<tr>
<td>17.2</td>
<td>Example</td>
<td>123</td>
</tr>
<tr>
<td>17.3</td>
<td>Creating a New Loan</td>
<td>123</td>
</tr>
<tr>
<td>17.4</td>
<td>Making Extra Principle Repayments On Loans</td>
<td>124</td>
</tr>
<tr>
<td>18</td>
<td>Budgets</td>
<td>125</td>
</tr>
<tr>
<td>18.1</td>
<td>What is a budget?</td>
<td>125</td>
</tr>
<tr>
<td>18.2</td>
<td>Your budgets</td>
<td>125</td>
</tr>
<tr>
<td>18.2.1</td>
<td>Viewing, creating, renaming, and deleting budgets</td>
<td>126</td>
</tr>
<tr>
<td>18.2.2</td>
<td>Account List</td>
<td>127</td>
</tr>
<tr>
<td>18.2.3</td>
<td>Assignments</td>
<td>127</td>
</tr>
<tr>
<td>18.2.4</td>
<td>Update and Revert</td>
<td>128</td>
</tr>
<tr>
<td>18.3</td>
<td>Budget Reports</td>
<td>128</td>
</tr>
</tbody>
</table>
The KMyMoney Handbook

19 Forecast

19.1 What is a Forecast? ......................................................... 130
19.2 Viewing Forecasts ......................................................... 130
  19.2.1 Summary Tab ......................................................... 131
    19.2.1.1 Account Summary ........................................ 131
    19.2.1.2 Key Summary Information ............................. 131
  19.2.2 Details Tab ......................................................... 132
  19.2.3 Advanced Tab ....................................................... 132
  19.2.4 Budget Forecast Tab ............................................. 132
  19.2.5 Chart Tab ........................................................... 132

20 KMyMoney Settings ......................................................... 133

20.1 General ................................................................. 133
  20.1.1 Global options .................................................... 133
  20.1.2 Views options ..................................................... 133
  20.1.3 Filter options ..................................................... 134
20.2 Home ................................................................. 134
20.3 Ledger ............................................................... 135
  20.3.1 Display tab ......................................................... 135
  20.3.2 Sorting tab ......................................................... 136
    20.3.2.1 Normal view tab ........................................ 136
    20.3.2.2 Reconciliation view tab ............................... 136
    20.3.2.3 Search view tab ......................................... 136
  20.3.3 Data Entry tab ..................................................... 136
  20.3.4 Import tab ........................................................ 137
20.4 Scheduled Transactions ............................................... 137
  20.4.1 Schedule startup options ..................................... 137
20.5 Online Quotes ........................................................ 137
20.6 Forecast .............................................................. 138
20.7 Encryption ............................................................ 138
  20.7.1 GPG Encryption ................................................. 138
20.8 Colors ................................................................. 139
  20.8.1 Foreground tab .................................................. 139
  20.8.2 Background tab ................................................ 139
20.9 Fonts ................................................................. 139
20.10 Plugins .............................................................. 139
  20.10.1 Print check plugin ............................................. 140
21 Search Transactions

21.1 General ............................................. 141
21.2 Search Criteria ..................................... 141
  21.2.1 Text ......................................... 142
  21.2.2 Account .................................... 143
  21.2.3 Date ....................................... 144
  21.2.4 Amount .................................... 145
  21.2.5 Category .................................... 145
  21.2.6 Payee ...................................... 146
  21.2.7 Details ..................................... 146
21.3 Search results .................................... 147

22 File Formats ........................................... 148

22.1 Plain text file ................................... 148
22.2 GZIP-compressed file ......................... 148
22.3 GPG-encrypted file ......................... 149
  22.3.1 GPG-Keys ................................... 149
  22.3.2 Setting the keys in KMyMoney ........... 149
  22.3.3 The KMyMoney recover key ............... 149
22.4 Anonymous file .................................. 150

23 Database ............................................. 151

23.1 Using relational databases .................. 151
  23.1.1 Introduction ................................ 151
  23.1.2 Preparation ................................ 151
  23.1.3 Administration ............................ 152
    23.1.3.1 Creating the database ......... 152
    23.1.3.2 Creating Tables ................... 152
  23.1.4 Creating a Database ...................... 152
    23.1.4.1 Database Type ....................... 153
    23.1.4.2 File (SQLite only) ............. 153
    23.1.4.3 Database name (others) ........ 153
    23.1.4.4 Host name ......................... 153
    23.1.4.5 User name and password .......... 154
  23.1.5 Accessing your data ...................... 154
    23.1.5.1 Table design ....................... 154
    23.1.5.2 Field formats ...................... 155
    23.1.5.3 Updating your data ............. 155
    23.1.5.4 Stored queries .................... 155
  23.1.6 Manual database creation .............. 155
    23.1.6.1 When to use ....................... 155
    23.1.6.2 Generating the SQL .............. 156
    23.1.6.3 Warning ........ .................... 156
  23.1.7 Encryption ................................. 156
The KMyMoney Handbook

24 Questions and Answers

25 Reference

25.1 Menus

25.1.1 File Menu

25.1.2 Edit Menu

25.1.3 View Menu

25.1.4 Institution Menu

25.1.5 Account Menu

25.1.6 Category Menu

25.1.7 Transaction Menu

25.1.8 Tools Menu

25.1.9 Settings Menu

25.1.10 Help Menu

25.2 Widgets

26 Credits

26.1 Original Author

26.2 Active Developers

26.3 Developers of Previous Versions

26.4 Special Thanks

A Installation
Abstract

KMyMoney, the personal finance manager by KDE.
This handbook describes KMyMoney version 4.8.1
Chapter 1

Introduction

2017-07-25
4.8.1

1.1 What is KMyMoney?

Put simply, KMyMoney is a personal finance manager by KDE. It enables users of open source operating systems and applications to keep careful track of their personal finances by providing a broad array of financial features and tools.

The principal goals of the project are:

• **Feature Parity** KMyMoney intends to provide all important features found in the commercially available personal finance managers. Although every release of KMyMoney gets closer and closer to that goal, there is still work to be done.

• **Ease of Use.** KMyMoney strives to be the easiest open source personal finance manager to use, especially for the non-technical user.

• **Correctness.** Based on tried and tested double entry accounting principles KMyMoney ensures that your finances are kept in correct order.

1.2 What KMyMoney is not

As a personal finance manager, KMyMoney is not intended to scale to the needs of an average business or organization. A small business might find sufficient functionality to use KMyMoney, but features such as accounts-receivable and accounts-payable are not directly supported. However, it would be possible to create client, supplier, document, or other features through plugins. There are also legal requirements on business bookkeeping in many countries, which KMyMoney does not meet.

KMyMoney is not simply a clone of the commercially available personal finance programs. Although many of the features present in KMyMoney can be found in other similar applications, KMyMoney strives to present an individual and unique view of your finances.
Chapter 2

What’s new in this release

2018-01-19
4.8.2
As with every release, the KMyMoney development team has worked hard to make this one better and easier to use in every way, although most of the developer effort has recently gone toward releasing a version of KMyMoney which runs under KDE Frameworks (aka KF5.) However, this release does include almost 70 bug fixes and four new features. For the future, any further releases in the 4.8.x series will likely contain only bug fixes.

Below are links to the full lists followed by highlights of the bugs fixed and new features found in this release.

• The complete list of bugs fixed in this release
• The complete list of new features in this release
• Improvements to data import, including:
  – Improved payee matching
  – Avoid crash if you provide an invalid name for the import file
  – Resolved numerous issues with importing QIF and CSV files
  – Removed some restrictions on the type of account to which data can be imported.
  – Allowed OFX import to use Client UID, required by some banks.
• Improvements to the Windows® version, including:
  – Changes to make the build process easier and more reliable.
  – Allow saving reports as .csv and not just .html.
  – Fixed localization problems on 64 bit versions.
  – Resolved issues with file backup.
• Improvements to the database back end
  – Avoid a crash if the database is not present restoring from hibernation.
  – Corrected SQL syntax issues causing errors.
• The user is now notified if changing a memo in a transaction would make it different from the memo in the other split of the transaction (such as in a transfer.)
• Added a setting to configure location of optional log file for imported data.
The KMyMoney Handbook

- Removed restriction on configuring VAT assignments for certain types of accounts.
- Eliminated false positive errors from Consistency Check
- Several improvements to importing and exporting templates.
- Eliminated several causes of crashes.
Chapter 3

Making the most of KMyMoney

Joe (joe1011010)
2010-07-19
4.5

While you could go ahead, clicking some buttons and filling in some data, after a time, you could decide you have done it wrong and start again, even if you did read the documentation on each part of KMyMoney.

You will get a more effective system if you spend a little time planning how you are going to use KMyMoney, so follow the steps given here.

3.1 Basic Accounting

Imagine your money as balls, or beans, and to stop them rolling around you keep them in a box, or pot. Accounting, or Bookkeeping, is the process of counting and keeping track of the beans in the pot, or several pots.

You have some money in the pot marked ‘Cash’. You buy some goods, so you take some beans out of the cash pot and place them into another pot marked ‘Supplier.’ The supplier gives you some goods in exchange for the cash, so you take the beans out of the pot marked ‘Supplier’ and put them in the pot marked ‘Goods’.

The goods have a value (the price you paid) so you still have the same amount of beans, some representing cash and some representing goods.

In this case you have two movements of beans, or transactions. Each transaction needs two entries, one to take beans out and one to put beans in. This is called ‘double entry bookkeeping’ or ‘double entry accounting.’ The recording of the transactions is done in a ‘Ledger,’ each pot is known as an ‘Account’ or ‘Ledger code’.

Now you take some goods and give them to a customer, who gives you some cash in exchange. The goods were worth some beans and, hopefully, the customer has given us more beans than that, so making a profit. To over simplify, the beans from the Goods pot come back as Cash, but we can split that as the ‘Cost of Goods sold’ and ‘Profit.’ This transaction has three entries; one side of the ‘double entry’ has been split.

This will be covered in more detail later on in this handbook.
3.1.1 Defining the accounts (personal records)

Most accounts, or pots, above represent a measure of our ‘Worth.’ The cash and goods represent our ‘Assets;’ so does what we are owed if our customers have not yet given us the money. The money we owe, say if we had not paid our suppliers, are our ‘Liabilities.’ These accounts are transferable to Cash and have a value.

Any pots that cannot be valued are ‘Income’ or ‘Expense.’ Our phone bill (or the phone company to which we pay the bill) cannot be valued; we know how much we have paid, but not how much anyone else has paid. We know how much our employer has paid us, but we do not know how much they have paid anybody else, or how much money they have left to pay us next month. Although we cannot determine an actual value for these pots, it is useful to monitor how much we have put into or taken out of each of them.

In some cases a supplier is a ‘Liability,’ in others it is an ‘Expense.’ This is something we need to consider and decide for each case. Similarly, you may set up a loan as a Liability, particularly if you transfer the money into your bank account, but it could be an Expense if it was to buy some furniture.

Consider how you want to track and analyze your income and expenses. This will help you decide how to set them up in KMyMoney.

Finally, consider if you want everything in one set of accounts, or two or more. This may depend on the legal framework or just how you want to analyze things. Each set of accounts would be handled separately.

3.1.2 Defining the accounts (business records)

There are similarities to setting up accounts for personal use, but there are additional considerations, including legal guidelines and requirements. KMyMoney does not explicitly address any of these issues, as it has been designed as a ‘personal’ finance manager. In addition, these additional issues are not addressed in this handbook, but you must be aware of them if you are going to attempt to use KMyMoney for a business.

3.2 Mapping your finances to KMyMoney

So, collect up your papers and see the following sections for each item in KMyMoney.

3.2.1 Accounts

These hold a value. Transactions are created against one or more accounts.

3.2.1.1 Accounts - Asset

These are the accounts which hold your money and possessions that you wish to monitor. The following types are available:

Checking
Standard bank checking account.

Savings
Standard bank savings account.
Cash
Money in your hand or wallet.

Loan
Loans you make to someone else.

Investment
Money you invest.

Asset
Property, collections, etc.

3.2.1.2 Accounts - Liability
These are the accounts which represent your debts and money owed that you wish to monitor. The following types are available:

Credit card
Standard credit card account.

Loan
Loans made to you, mortgages, etc.

Liability
Anything else you owe that is not a loan.

3.2.2 Institutions
These are completely optional and can be used to group accounts, and show a total value for all accounts in each group.

3.2.3 Categories
These represent non-managed income and expense accounts that do not have a value. The total value of transactions is shown against each category. A category or transfer account is required for each transaction.

3.2.4 Sub-Categories
Categories can be split into sub-categories, but this relationship is only for display purposes, as the sub-category totals are not included in the higher level category total.

3.2.5 Tags
Tags are very similar to Categories, as they are also non-managed accounts that do not have a value. However, unlike Categories, the use of Tags is completely optional.

3.2.6 Payees
These are optional for transactions. They are required for Scheduled transactions. A transaction history, with category, is shown against each payee.
3.2.7 Scheduled transactions

Where transactions occur on a regular basis, these can be set up against a Schedule. Transactions are created from a schedule; any that are overdue can be seen on the home page.

3.3 Useful Tips

Unless you keep your money under your mattress or under the floorboards, you probably make use of one or more institutions where you have accounts, which may be in credit or debit. In order to familiarize yourself with the way KMyMoney works, choose an account you want to track with KMyMoney and select **File → New** in order to set up an account file.

If you have used another personal finance manager, you may be able to import the data from it into KMyMoney.

If you have some regular receipts into or outgoings from this account, go to Payee and enter the names of both the payers and the payees involved; then go to Schedule and fill in a New Schedule for each recurring transaction. If you haven’t entered the payee or payer, KMyMoney will offer you the opportunity to do this in the middle of entering the schedule.

To add other new transactions go to Ledgers; you can add new payees and categories in the middle of a transaction or by going to Payees or Categories before entering the transaction.

You will probably find that the default Categories do not exactly match your needs; you can easily delete ones you know you are never going to need and add others that you need. But when you are entering a transaction, you only have to type a few letters of a category and KMyMoney will offer you a drop down list of the matching categories from which to choose.

You can add different accounts managed by different institutions; the preferred one will show when you open KMyMoney but you can quickly switch to any of the others.

When you make a payment, KMyMoney will work out what the next check number should be; delete this if you are not making a check payment or edit it if the first check you enter is not check number 1. Alternatively, it is possible to switch off auto-increment of check numbers.

Every so often you may get statements of your account from the institutions you use; you can reconcile your KMyMoney accounts against these statements so that you have an accurate statement of the current state of your finances.

If you go to Reports, you will find several default reports; to customize these, open one similar to the sort you prefer and then select ‘New’ (not ‘Copy’); you can then customize this to your needs and mark it as a preferred report if you wish.

Though KMyMoney is not intended for use in a business context, if you are running a business on your own and so do not need payroll functions, you will probably find that KMyMoney is sufficiently customizable to meet your needs particularly as it comes with budgeting and forecasting features and you can export your customized reports via CSV into other applications.
Chapter 4

Using KMyMoney for the first time

Michael T. Edwardes
2014-08-30
4.7.01

4.1 Running KMyMoney for the first time

Once KMyMoney has fully loaded two windows will be opened. The top window, ‘Tip of the Day’ offers one of a series of important or useful pieces of information about the application.

![Tip of the Day Window]

Did you know...?

...that you can switch to the payee of a transaction by selecting the context menu on a transaction in the ledger or in the transaction menu?

You are recommended to quickly read through these tips by pressing on the Previous and Next buttons at the bottom of the window.

Once you have read the tips the window can be closed; it will re-open each time KMyMoney is started. To stop this default behavior, uncheck the appropriate option on the Tip of the Day window.
All tips have been extracted from the Frequently Asked Questions list (FAQ) that provides more detailed help and can be found on the project website and in this manual. Please click on Close to close the Tip of the Day dialog.

4.2 The main window

The KMyMoney main window consists of four major parts

- A. The menu bar
- B. The toolbar
- C. The View selector
- D. The view

The menu and toolbars provide access to the features of KMyMoney and allow you to Create files or configure how KMyMoney operates.

The view selector consists of at least eleven icons in the left side of the main window, depending upon the software provided by your system. More icons could be added by various plugins. By clicking on an icon, the view window on the right hand side is loaded with the appropriate view of your financial data. Each view provides a unique representation of your financial situation and allows you to view or edit the information shown.

The view selector contains the following icons

- Home: A configurable overview of your current financial situation (or an introduction page when no data file is open).
• Institutions: All of your institutions and accounts displayed in a hierarchy.

• Accounts: All of your accounts displayed in a hierarchy.

• Schedules: Your recurring bills and deposits.

• Categories: Special accounts that provide a means for you to group associated transactions.

• Tags: Special accounts that provide an additional means to Categories for you to group associated transactions.

• Payees: All Payees used by KMyMoney.

• Ledgers: Your account transactions.

• Investments: Your portfolio summary.

• Reports: A collection of useful reports, providing alternate views of your financial data.

• Budgets: Your budgets

• Forecast: This view provides a forecast of your accounts and categories

• Outbox: Used by the online banking module to provide feedback on running processes. This is a view provided by the KBanking plugin and may not be present on your system.

4.3 Creating a new file

KMyMoney keeps all the data about your finances in a file. As was stated in Defining the accounts (personal records), you can keep more than one set of accounts, but the data for each will be kept in a separate file, and KMyMoney can only have one file open at a time. See the chapter on File Formats for more details about KMyMoney’s data files.
To create a new file you can either select **File → New** from the menu or choose the icon from the toolbar. KMyMoney will then open the ‘New File Setup Wizard’ which will guide you through the process of creating the file.

Since all fields are optional, you can use KMyMoney without entering any information now. Any information entered here is used only to personalize your file. In the future, it may be used in some reports and for online banking. If KMyMoney requires any personal information in future releases and finds none, you will be prompted to enter the relevant data then.

Please enter your name and address or nothing and press **Next**.

In case you have an address for yourself stored in the KAddressBook, the button **Load from Addressbook** is enabled and pressing it imports all information into KMyMoney.

KMyMoney supports multiple currencies. To set your base currency (the currency you use day to day and which will be used for your reports), select the appropriate entry from the list provided and press **Next**. A default will be selected from KMyMoney based upon your locale settings.
The following page allows you to create an initial account. For the typical KMyMoney user this is a checking account.

Enter the name of the account and a possible reference number assigned by the institution managing the account. Enter the opening date of the account and the opening balance of the account. For example, you want to use KMyMoney to manage all your finances as of 2008-01-01, then enter the balance of the account at the beginning of this date. The number can possibly be obtained from a paper statement. Also enter the name and routing number of the institution, though this information is optional and only required for online banking purposes.

In case you don’t want to setup an initial account, please uncheck the check box.
Once finished, press Next to proceed.

Choose the appropriate country and account template(s). Multiple templates, even from multiple countries can be selected using a combination of Ctrl and Shift together with the left mouse button. The account hierarchy to be setup will be shown in a preview part of the wizard. In case you cannot find a template that suits your needs, don’t select a template.

Once finished with the template selection press Next to proceed.

The next page of the wizard allows you to setup user preferences. Press Next if you are done and want to proceed.
The last page of the wizard allows you to select the filename that will be used to store your financial data. An initial filename will be constructed out of your HOME folder and user name. In case the file exists, a warning will be displayed which reminds you to select a name of a non-existing file.

Now you have entered all relevant information to create the file. Press **Finish** and KMyMoney will create the file for you and open it.

### 4.4 Creating accounts

You can create an account in one of two ways, both of which are described here:

#### Using the menu

To create an account using the menu select **Accounts → New account**.

#### Using the Accounts view

To create an account using the accounts view click on the Accounts icon in the view selector and then right click on the Asset tree icon in the right hand view and select **New account** from the popup menu. The Asset tree holds all of your accounts that are an asset. Assets, and all the other account types, are discussed in more detail later in this manual.

**Tip**

Note that KMyMoney uses the context menus a lot throughout the whole application. If you find yourself stuck trying to figure out how to do something, try right-clicking where you would expect to see a feature.
Creating a new account by either method opens the *New Account Wizard*. This wizard will take you step by step through the process of creating an account, gathering the required information at each step. To navigate through the pages click on the *Back* and *Next* buttons.

Create an account using either of the two previously mentioned methods to continue. A full description of creating accounts can be found in the *Accounts* section.

Now that one or more accounts exist in KMyMoney, your account summary is shown in the Home view. You can create transactions manually in the *Ledgers* view, or set up automatic transactions through the *Schedules* view.

### 4.5 Schedules

Sometimes called a recurring transaction, a *Schedule* is a transaction that occurs one or more times over a certain period of time. A typical example is your pay check that you receive every month or week. Rather than have to enter the transaction details each time you get paid, you can instruct KMyMoney to create a schedule that will enter a transaction for you when you get paid.

To maintain schedules click on the Schedules icon in the view selector.

### 4.6 Categories

To maintain categories click on the Categories icon in the view selector.

A full description of this topic can be found in the *Categories* section.

### 4.7 Tags

To maintain tags click on the Tags icon in the view selector.

A full description of this topic can be found in the *Tags* section.

### 4.8 Payees

To maintain your list of payees click on the Payees icon in the view selector.

A full description of this topic can be found in the *Payees* section.

### 4.9 Quicken Interchange Format (QIF) Import

If you currently use a financial manager application, KMyMoney can import an account’s transactions as long as they are in the Quicken Interchange Format (QIF). Most financial programs can
export this format and the different applications methods of exporting QIF is not discussed here for brevity.
A full description of this topic can be found in the QIF Import section.

4.10 Searching for transactions

KMyMoney provides a useful and powerful transaction search facility in the form of the search dialog.

The search dialog can be opened from the toolbar using the Find icon or by selecting Find Transaction from the Edit menu.
A full description of this topic can be found in the Search section.

4.11 Reconciliation

At some point you will want to reconcile the transactions you have entered with the transactions listed in a statement, be it a bank statement, credit card statement, loan statement, or any other statement. Reconciliation involves matching what you have entered with what the statement lists. If any discrepancies are found then either you or the person who created the statement have made a mistake.

To reconcile an account, first select the account, either from Accounts view or from Ledgers view. Then, either click on the Reconcile icon on the Toolbar, or select Reconcile from the Account menu.
A full description of this topic can be found in the Reconciliation section.

4.12 Backing up

Now that you have created some accounts and entered transactions it’s a good idea to perform a backup. Because the file used by KMyMoney is a standard Unix file you can just copy the file to another location to back it up or use the dialog provided by KMyMoney. Using the dialog is the preferred method because if KMyMoney ever starts using other file formats, such as SQL, then it would be much harder to copy the file manually.

To backup your file through KMyMoney Select Backup from the File menu and enter the folder where you wish the file to be copied to. If the folder needs mounting first and you have the sufficient privileges then check the tick box labeled Mount this directory before backing up and click on OK.

The file will be copied to the folder specified with the current date appended to the filename so it is easy to see the date the file was backed up.

4.13 Launching KMyMoney

Most commonly, you will launch KMyMoney from an icon or a start menu of your window manager. In this case, the default behavior is that KMyMoney will open the last file you had open. However, in some circumstances, you will want or need to launch KMyMoney from the command line.
For a complete description of all the available line options, see the man page for KMyMoney. However, there are two special cases which we describe here.

**kmymoney -n** The -n option tells KMyMoney not to open the last file it had open. This can be useful if the program crashes on startup.

**kmymoney <path to file>** Giving KMyMoney a filename on the command line tells it to open that file instead of the last file it had open. You can use the name of any valid KMyMoney file, as described in the chapter on file formats. In addition, this can be used to import a GnuCash file.

### 4.14 How to move KMyMoney to a new computer

#### 4.14.1 Moving your data

If you get a new computer, it’s very easy to move your data. In fact, all you have to do is to copy your KMyMoney data file. The name of the file is shown in the title bar when KMyMoney is running, it usually ends in .kmy. The first time you run the application on the new computer you will have to tell it where you have put the data file, either by running from the command line, or from the **File → Open...** menu. You should even be able to move between Windows®, Mac® OS, and Linux® systems.

If you have encrypted your data file, be sure the appropriate software and keys have also been set up on the new computer.

If your data is in an SQL database, refer to documentation for your database software for guidance on migrating your data.

Note that this assumes you have installed the same version of KMyMoney on the new computer as you were running on the old computer. Installing a newer version should also be safe, but you need to be aware of any issues related to that upgrade. Any such issues should be noted in the release notes for the new version.

#### 4.14.2 Moving your settings

If you only move your data file to the new machine, as described in the previous section, KMyMoney will work correctly, but you will have lost any settings you changed from the default on your old machine. To maintain these settings, you also need to copy your configuration file. This file is called ‘kmymoneyrc’. This file will be in a directory with other KDE application configuration files. On a Linux® system, this will be in ‘$KDEHOME/share/config’ where ‘$KDEHOME’ is usually ‘.kde4’ within your home directory.

#### 4.14.2.1 Moving plugin settings

If you have run any KMyMoney plugins, such as the csv importer or exporter, it may also have created a configuration file in that same directory, such as csvimporterrc or csvexporterrc. These should also be copied to the new computer.

As with the main data file, this assumes the same version of the plugin on both computers. Upgrades are generally safe, but if the functionality of the plugin has changed greatly, it is advisable to carefully test using the old configuration file, to be sure the plugin behaves as you expect.

### NOTE

These instructions are solely for moving your KMyMoney data and settings. However, there may be important items which are stored by KDE and not by KMyMoney, such as any passwords stored in kwallet. Moving other parts of your KDE setup is beyond the scope of this manual, although many of the relevant files are also stored under ‘$KDEHOME’.
4.15 Contacting the Developers / Reporting Bugs

4.15.1 Contacting the developers

For general questions or comments about KMyMoney, there is a users’ mailing list kmy-money@kde.org. In addition, you can contact the developers through their mailing list kmymoney-devel@kde.org.

We’re happy to hear about your experiences using KMyMoney.

4.15.2 Reporting bugs

To report a bug please use the interface provided by KMyMoney by selecting Help → Report Bug and filling in the required information. However, in case you have any difficulties with that method, you can report a bug (or file a wish-list or enhancement request) directly at the KDE bug reporting web page. Reports should be filed against the product ‘kmymoney4’. ‘kmymoney2’ was specifically for bugs in the 1.0.x versions of the application, and as those versions are no longer supported, it is closed for further bug reporting.

In any case, before reporting a bug, please read through the guidelines below. Following them will make it more likely that the developers will be able to quickly identify the problem without having to ask you for more information.

4.15.2.1 Writing High Quality Bug Reports

We encourage users to take extra time to write high-quality bug reports when submitting them. This reduces wasted effort on all sides, as the reporter and the developer who will fix it trade emails until this information is really in place.

Eli Goldberg wrote the canonical Bug-Writing Guideline, available at http://issues.apache.org/bugwritinghelp.html. Generally, you’ll be well-served by following these guidelines:

Include your system information The Help → Report Bug menu choice will fill this in automatically, but if you would prefer not to use this interface, there are several items you need to include in the report. We will need to know what operating system you are using (Linux®, Mac® OS, or Windows®), the version of KDE and the version of KMyMoney you’re running, and either the version of Mac® OS or Windows® or the name and version of your Linux® distribution and the version of your kernel.

Include a backtrace for crashes The backtrace is often the single most useful piece of information in solving crashes.

Try to reproduce it Let us know if you were able to do so. It’s useful to know whether the bug only happened once and you couldn’t get it to happen again or happens every time or happens sometimes but not others.

Include specific steps This is a bad bug report: ‘I entered a transaction, and KMyMoney crashed.’ A much better bug report is: ‘Using the transaction form, I entered a new transaction in my Credit Card account. I selected the Transfer tab, entered in an amount, then changed to the Deposit tab, and back to the Transfer tab. When I returned to the Transfer tab, KMyMoney crashed. This bug is fully reproducible for me.’

Tell us what you expected to happen In some cases, this is obvious, but in more subtle bugs, sometimes you’ll see a bug report where it is not obvious what the reporter expected to happen. Always tell us what you think should have happened.

Consider running with debugging enabled By compiling a version configured with --enable-debug=full you can ensure that the best possible backtraces are generated. If you encounter a
crash, run KMyMoney again from within gdb, and reproduce the crash. When it crashes, type
‘bt’ to generate a backtrace.

Running this way is a bit more difficult, so we don’t expect all users to do this. However, if you’re
interested in helping KMyMoney become as stable as possible, this is the best way to do it short
of finding the bug in the code and sending in a patch.
Chapter 5

Institutions

Roger Lum
2010-07-25
4.5

The Institutions screen provides a summary of all the accounts grouped under their respective institutions. Asset accounts are symbolized with a black arrow, and liability accounts are symbolized with a red arrow.

The Institutions screen displays several columns, including the type of account and the value of each account. It also shows the total value of all accounts in each institution.

5.1 Institution Options

Right-clicking an institution name brings up an Institution Options sub-menu, providing you with several choices. Selecting New Institution... opens the New Institution Dialog, where you can enter all the necessary information to create a new institution. Selecting Edit Institution...
brings up an editable window with institution details such as name and address. Selecting **Delete Institution** removes the entire institution and all its associated accounts. Keep in mind that you will only be able to delete an institution if you can delete all of its accounts, and you will only be able to delete each associated account if it has no transactions and no schedules refers to it. Selecting **New account...** steps you through the new account process, which is described in more detail in the next section.

5.1.1 New Institution

![New Institution Dialog](image)

**NOTE:** You must have a file open before you can create a new institution. If you do not have an existing file, you will need to create a new file.

Only the name is required in the New Institution Dialog, all other fields are optional. As with the personal information dialog, this data is not currently used by KMyMoney, but will be required by future releases for certain features. In particular, the Routing Number and the BIC (Bank Identifier Code) will be required for online banking.

5.2 Account Options

Right-clicking an account name brings up an Account Options sub-menu. Selecting **New account...** steps you through the new account process. Selecting **Open Ledger** brings you directly to the Ledgers view or Investments view, depending on the account type. Simply double-clicking an account name also opens the account. Selecting **Edit account** brings up a window allowing you to change an account’s name, start date, associated banking institution, and parent account. Deleting an account is only possible if there are no transactions associated with that account. Selecting **Reconcile...** opens up the Reconcile Wizard, which steps you through the process of
comparing your bank account statements to your electronic entries. More details, as well as information about the other options is presented in the appropriate sections of this manual.
Chapter 6

Accounts

Michael T. Edwardes
Roger Lum
2011-07-21
4.6

6.1 The Accounts View

The Accounts View provides a summary of all the accounts. There are four different account categories: Asset, Liability, Income, and Expense. Typical asset accounts include bank accounts, cash, and investments, while typical liability accounts include credit cards and loans.

There are two ways to view the accounts: List or Icon view, which may be selected by clicking on the appropriate tab at the top of the view.

In the List view, the accounts are grouped under four headings: Asset, Liability, Income, and Expense. List view shows the name and balance or value of each account. Income and Expense list the categories that each transaction is filed under, and provide similar functionality to the Categories screen. The options and features involving Income and Expense accounts are described in detail in the Categories chapter. The rest of this chapter will focus on Asset and Liability account functionality.

In the Icon view, the Asset and Liability accounts are shown with icons indicating the account type. KMyMoney initially places the icons alphabetically, but you can move the icons to any position you want, just by dragging the icon with the mouse. Note, however, that just moving an icon does not currently trigger KMyMoney to think that any data has been changed. This means that you need to make some other change, such as editing an account or a transaction and saying OK (even without actually changing any data) so KMyMoney allows you to save the file. The saved file will include the new icon positions.

6.2 Creating an Account

NOTE: You must have a file open before you can create a new account. If you do not have an existing file, you will need to create a new file.

To create a new account, you can either select Account → New account... from the menu or choose the icon from the toolbar.
Alternatively, to create an account using the accounts view, click on the Accounts icon in the view selector and then right click on the Asset tree icon in the right hand view and select **New account**... from the popup menu. The Asset tree holds all of your accounts that are an asset. Assets, and all the other account types, are discussed in more detail later in this manual.

### 6.2.1 The Institution (Bank) name

The first step involves selecting an institution for the account. If this is an account for an institution you have already created, you can select the institution from the dropdown list. If you want to create a new institution, click on the **New Institution** button. This will bring up the New Institution Dialog, as described in the previous section. If this is not a bank account, or if you do not want to use online banking, you do not need to specify an institution.

The Account Number and the IBAN (International Bank Account Number) are not currently used by KMyMoney. These fields may be left blank and filled in at a later time; they are only required for online banking.

To proceed to the next step click on **Next**.
6.2.2 Account

This page is used to configure the type of account.
First, enter a name for the account. This name will be used to identify it.
Next, select the type of account from one of the types available from the dropdown list:

**Checking**
A normal checking account, the type you get with any bank or credit union.

**Savings**
A normal savings account, the type you get with any bank or credit union.

**Credit Card**
An account to represent your credit card.

**Cash**
A general purpose account, typically used for accounts not held at a bank, such as the cash in your wallet.

**Loan**
An account to manage a loan for money either borrowed or lent. With a Loan account KMyMoney automatically calculates interest payments to help you track the remaining principal on the loan. Loans with no interest might use the plain Asset or Liability type below, depending on whether the money is lent or borrowed.

**Investment**
An account to manage an investment such as stocks or investment funds.

**Asset**
An account to manage an asset that does not fit in one of the above types.

**Liability**
An account to manage a liability such as money you borrowed or a future expense. If interest needs to be calculated, you might be better using the Loan type above.
Select the currency to be used for the account from the dropdown list.
Enter the date the account was opened or select it from the calendar using the icon to the right.
Enter the opening balance for the account. If this is an existing bank account this information can be found on your statement. If it is a new account, the opening balance can be left at zero.
Selecting the Preferred Account check box will allow preferred access in some dialogs and views of KMyMoney.
To proceed to the next step click on Next.

6.2.3 Credit Card Accounts
When creating a Credit Card account, you can optionally have KMyMoney create a scheduled transaction for you.

If you want such a transaction generated, make sure the tick box is checked and enter the required information.
Click on Next to continue.

6.2.4 Investment Accounts
For Investment accounts, you have the option to create an associated Brokerage account. For more information see Investments
6.2.5 Loan Accounts

Loan accounts are special accounts used to help you manage Loans with interest and scheduled repayments. By providing KMyMoney with information about the loan, KMyMoney can help you track interest payments and the remaining principal of the loan.

On the Details page you enter the general information about the loan.

First, select whether you are borrowing or lending money. If you are borrowing money the loan will be listed in Accounts under Liabilities. If you are lending money the loan will be listed under Assets.
The KMyMoney Handbook

Next, select the payee or payer of the loan. As always, if the name doesn’t yet exist in the Payees list, enter it here and KMyMoney will create it for you.

The next three items are for handling Loans on which you’ve already made payments. If you select Yes in the “Have you made/received any payments yet?” item you can then select whether you want to record all payments or just those from the beginning of the current year. If you want to record from the beginning of the current year, you are then asked to input the current balance.

Then, select how often payments will be made and how often interest is compounded. Compounding is where the interest is added to the amount owed on the loan so that when the interest is next calculated there will be more interest paid on the interest. It’s common for interest to be compounded at the same frequency that payments are made.

Next, enter the date the first recorded payment will be made.

Finally, enter information about how the interest rate varies. If the loan is fixed-rate there is nothing to do. If the rate varies, select Variable in “Type of interest rate” and then enter the interval between interest rate changes and the date the first change of interest rate is due: KMyMoney will ask you to update the interest rate when that date arrives.

The Payments page is where you enter the payment and interest values for the loan.
First, select whether the interest rate is calculated when the payment is received or when it becomes due. If you don’t know, leave it on the default value.

Next, enter the following values:

**Loan amount**
- The amount of the loan.

**Interest rate**
- The annual percentage interest rate of the loan.

**Term**
- The length of the loan. Enter a number and select either Months or Years.

**Payment (principal and interest)**
- The amount paid for each loan payment. This is the total of the principal and interest paid with each payment.
Balloon payment

Additional final payment made at the end of the term to pay off the remaining principal of the loan. For a repayment loan this is often zero. For an interest-only loan this will be the same as the loan amount.

Finally, use the Calculate button to check the values you have entered. You must have entered either all or all but one of the values listed above. If you omit two or more values the button is disabled because it is not possible to check that the entered values are consistent: in that case you will not be able to use the Loan account facility in KMyMoney and will instead have to use a Liability or Asset account to track the loan manually.

If you omit one value KMyMoney will try to calculate it for you. If you have entered all values KMyMoney will check the values are consistent. KMyMoney will not adjust entered values other than the “Balloon payment”, which it may adjust slightly to deal with rounding. If the values are inconsistent or KMyMoney cannot calculate the offered value KMyMoney will let you know so that you can correct any errors and repeat the calculation.

Once the values are consistent the Next button is enabled and you can advance to the next page.

The Fees page is where you can enter any fees added to the loan payments.

If there are any fees press the Additional Fees button. The Transaction Split editor will be displayed for entry of the fees. Any lines added here will be included in the payment schedule for the loan. When you save the splits the Fees page will display the principal and interest payment, the total additional fees and the total periodic payment.
KMyMoney will create a scheduled transaction for your loan. The Schedule page is where you enter the remaining details needed to create the schedule.

First enter the Category to which loan interest will be assigned. Then enter the account from which the loan payment will be made.

The page also displays the first payment date for which the Schedule will be created.

Optionally, KMyMoney can create a transaction representing what was received or paid when the loan was created. If you borrowed or lent cash select the account from which or to which the loan amount was paid.
If you borrowed money to purchase a car you can select or create an Asset account to help you track the value of the new car.

If you re-financed an existing Loan check the “Refinance existing loan” check box, select the Loan account and KMyMoney will create a transfer transaction paying off the existing loan.

If you don’t want to create the payout transaction, check the “Do not create transaction” check box.

6.2.6 Parent Account

This is the penultimate step in creating a new account. A tree of accounts is displayed. The tree will be of your Asset or Liability accounts, depending on the type of account that is being created.

Select the account you wish contain the new account. If you do not select a parent account, the new account will be created at the top level.

The Parent Account page is not currently shown for Loans because they cannot be created as subaccounts. Also, Investment accounts cannot contain other accounts so they are not shown in the tree.
6.2.7 Review and save the account details

This is the final step in creating a new account. A summary of the information entered is displayed. Review it, and if everything is OK press the Finish button. Otherwise, either press the Back button to make corrections or the Cancel button to abandon creating a new account.

NOTE: The Type and Currency cannot at present be changed after the account is created.

6.3 Opening / viewing accounts

To open an account in the Ledger view you can either click on the link to the account from the Home view, or click on the Ledgers icon in the view selector and select the account in the drop down box at the top of the view. Alternatively, in the Account view, either double-click the account entry or right click and select Open ledger.

6.4 Editing Account Information

To edit a particular account, right-click that account and choose Edit account... or with that account open in the ledger, select Account → Edit Account.... A window will pop-up with several tabs, each allowing you to view and change certain information about the account. For more information on any of these details, see the section on creating a new account.
General View the general information about the account, and change the name, start or opening date, as well as some of the other basic settings of the account.

Institution View and change the associated banking institution and account numbers. You can also create a new institution here.

Hierarchy You can change the parent account by clicking on another parent account in this view of the account hierarchy.

Limits This tab is only present for asset and liability accounts. If you enter amounts in the available fields, KMyMoney will warn you when the account balance reaches those values.

Tax Here you can check whether this is a VAT account, and whether to include this account on tax reports.

Online Settings This tab is only be present if the account has been mapped to an online account. It has three subtabs.

- Account Details This shows the status of the online connection, the bank/broker and account number, and allows you to store or change the password for the online account.
- OFX Details Here you can adjust certain details KMyMoney uses when it establishes an OFX connection with the institution. This should only be necessary if you get certain errors when you first set up the online account, or perhaps if your institution changes its OFX server software.
- Import Details Here you can tell KMyMoney what to use as the start date for the import. In addition, starting with version 4.6, you can choose whether the payee’s name is based on the PAYEEID, NAME, or MEMO field of the imported transaction.

### 6.5 Deleting accounts

To delete an account, first remove all the transactions from that account in the ledger. Next, find the account in the accounts view and after right clicking on the entry to show the popup menu select Delete account... from the popup menu.
If you are unable to delete an account which looks like it has no transactions in it, check your filter. See **Settings → Configure KMyMoney → General → Filter**. Clear all filters. Set the start date to 1.1.1900 or so.

There may be transactions in your ledger that are not shown, for example, if you have inadvertently typed in the wrong year when making an entry so that an entry remains outside the opening date of KMyMoney. This appears beneath the ledger page as remaining funds.
Chapter 7

Categories

Roger Lum
2014-08-30
4.7.01
The Categories screen provides a summary of all the existing categories under which transactions are filed. The categories are split into income and expense, and a balance is displayed for each category.

7.1 Creating a category

To create a new category, either select **Category → New category** in the menu, or in the Categories view, select a parent in the tree, right click and select the **New Category** option. Either way will open the Create new categories wizard. Enter the new category name, and select the currency if the default shown is not correct. In the Hierarchy tab, ensure the required parent account is
selected. Finally, in the Tax tab, there is a check box to enable VAT support, and a check box to include this category in certain tax related reports.

Enter the category name any notes and click on OK to save the new category. To create a complete hierarchy of accounts, separate the names by colons (:) as in Bills:Car:Gasoline.

7.2 Editing a Category

To edit a category, right-click on a category name, and choose Edit category. A window comes up with three tabs: General, Hierarchy and Tax.

The General tab allows you to edit the name of the category and any notes you entered when you created the category.

The Hierarchy tab allows you to change the parent category. You can change the parent category by clicking on another category in this view of the category hierarchy. In an earlier version of KMyMoney it was possible to change the parent of a category by dragging and dropping. This functionality will return in a future version, but possibly not until the conversion of KMyMoney to KDE Frameworks.

The Tax tab allows you to assign or change VAT category, or alter the automatic VAT assignment. It also allows you to toggle whether or not the category is included in certain tax related reports.

7.3 VAT Support

You can turn an expense/income category into a VAT category, which means that it receives all the splits that actually make up the VAT payment towards the government. You can also enter a specific percentage rate.

Categories can be assigned a VAT category, which allows KMyMoney to split a transaction for a category into two parts, one for the category and one for the VAT. Depending on the setting of the gross/net amount switch, the amount you enter for the transaction is the gross or net amount.
Example: In Germany, there are three VAT percentages (0%, 7%, and 19%). So I have a main category “VAT paid” and three subcategories, one for each percentage rate. I create these on both the income and the expense sides so that I have eight categories in total. For the goods I buy, I select one of the above mentioned categories as the “VAT category assignment”.

When I buy goods, I enter them into a transaction. Let’s assume I have selected the gross amount entry method, once I enter the category and amount, KMyMoney will recognize that there’s a VAT assignment and calculate the VAT part, create a second split with the VAT account and VAT amount and reduce the category amount.

The same applies to income categories but the other way around. Hope that makes sense.

### 7.4 Deleting a category

To delete a category, select it in the tree, right click to bring up the popup menu, and select **Delete**. If there are any transactions assigned to this category, a popup will allow you to move these to another parent category. If you try to delete a parent category, a dialog allows the choice of either having the sub-categories moved up one level or alternatively having them all deleted at the same time.
Chapter 8

Tags

Cristian Oneț
2014-08-30
4.7.01

The Tags screen provides detailed information about all the tags which are applied to transactions. The Tags screen is split into two main areas: a tags list and a detail area.

8.1  Tags List

A list of tags is on the left side of this screen. The tags list is sorted alphabetically.
8.1.1 Adding a Tag

To add a tag, either click on the Add tag icon or right-click on any tag and choose New tag. This creates a new tag called ‘New tag’. Right-click on this tag and select Rename tag to enter the name of the new tag.

8.1.2 Renaming a Tag

To rename a tag, either click on the tag name to select it and click on the Rename tag (between the add and remove icons) or right-click on the name and then select Rename tag. The name then becomes editable. Changing the name will affect the name in all the transactions in which it appears.

8.1.3 Deleting a Tag

To remove a tag, either click on the Delete tag icon or right-click the name and select Delete tag. If the tag has any transactions, you will be presented with a dialog that allows you to reassign them to a different tag.

**NOTE**
As Tags have just been introduced to KMyMoney in version 4.7, none of the methods for importing data are able to import tags. It is understood that this is an important feature, and each import method is likely to introduce it in an upcoming release.

8.2 Tagged transactions and Tag details

To view the transactions or view and edit the information associated with a particular tag, select the tag from the list and select the appropriate tab on the right side of the dialog.
8.2.1 Tagged transactions

To see a list of the transactions associated with the selected tag, select the **Transactions** tab. This list is similar to the list of transactions for a Payee. You can double-click on a transaction, and you will be taken to the ledger view of that transaction for the account in which the transaction has been tagged.

8.2.2 Tag details

To view and edit the information associated with a particular tag, select the **Details** tab.

- You can select the color used to highlight transactions with which this tag has been associated. If you click on the color bar, you will get a color chooser dialog.
- To modify the notes associated with the tag, just edit the text in the box.
- Clicking the **Closed** checkbox will not alter any transactions already associated with the tag, but it will prevent assigning the tag to any additional transactions.

When you are done, don’t forget to click the **Update** button, although you will be prompted if you leave the dialog without having done so.
Chapter 9

Payees

Roger Lum
Ace Jones
2010-07-25
4.5

The Payees screen provides detailed information about all the payees and payers involved in transactions. The Payees screen is split into two main areas: a payees and payers list and a detail area.

The Payees screen allows for viewing the transactions for the selected payee, updating personal information associated with a particular payee or payer, and specifying transaction matching criteria.

9.1 Payees List

A list of payees and payers is on the left side of this screen. The payee list is sorted alphabetically.
9.1.1 Adding a Payee or Payer

to add a payee or payer, right-click on any payee name and choose New payee. This creates a new payee called ‘New Payee’. Right-click on this payee and select Rename payee to enter the name of the new payee or payer.

9.1.2 Renaming a Payee or Payer

To rename a payee or payer, simply right-click on the name, select Rename payee and the name becomes editable. Changing the name will affect the name in all the transactions in which it appears.

9.1.3 Deleting a Payee or Payer

To remove a payee or payer, right-click the name and select Delete payee. If the payee has any transactions, you will be presented with a dialog that allows you to reassign them to a different payee, and also a check box to enable a deleted name to be added to the new payee’s matching list.

9.2 Additional Payee Details

9.2.1 Personal Information

To view and edit the personal information associated with a particular payee, select the payee from the list and select the Address tab. To modify this information, edit the detail area directly and press the Update button when finished.
9.2.2 Transaction Matching Settings

9.2.2.1 Overview

KMyMoney has the ability to automatically assign the proper payee to imported transactions. This can be handy when importing transactions from your bank, when the payee name has extra unnecessary characters, or worse, if the payee names change.

For example, let’s say your monthly mortgage payment comes in from your bank like this ‘SUNTRUST BANK MAPLE VALLEY, GA 111506’ one month and then ‘SUNTRUST BANK MAPLE VALLEY, GA 121606’ the next month. You would really like both of those transactions to be assigned simply to your payee ‘SunTrust’. The transaction matching feature is for you!

9.2.2.2 Setting up

From the Matching tab, you can set the Transaction Matching Settings. You have 3 major options:

- **No Matching.** Disables the feature for this payee. This is the default setting for all payees.
- **Match on Payee Name.** Enables the feature, and uses the payee name itself as the Match Key.
- **Match on Key.** Enables the feature, and allows you to enter one or more Match Keys of your choosing. In general, entering a plain string will work perfectly. However, the match keys are actually regular expressions, so it is possible to match on more complicated patterns.

You can also choose whether you want to ignore the case of the Match Key. If you choose this option, the Match Key ‘SunTrust’ would match ‘SUNTRUST BANK’ or ‘SunTrust Bank’.

9.2.2.3 Importing Transactions

When you import transactions using the QIF import, or using a plugin such as OFX or AqBanking, the Match Keys you have set will be considered. If the Match Key for one of your payees
is found anywhere in the payee of the imported transaction, the corresponding payee from your list will be assigned to that transaction. Thus, a Match Key of ‘SunTrust’ will match ‘SUNTRUST BANK MAPLE VALLEY, GA’ or even ‘MORGENSUNTRUST& LOAN’. So choose your Match Keys carefully.

**NOTE**
If a transaction payee matches more than one Match Key, the behavior is undefined. KMyMoney will arbitrarily pick one of the matching payees.

### 9.3 Viewing Transaction History

To view all transactions associated with a particular payee, select the payee from the list and the Transaction tab in the detail area. Double-clicking a particular transaction will bring you directly to that transaction in the Ledgers screen.

<table>
<thead>
<tr>
<th>Date</th>
<th>Account</th>
<th>Details</th>
<th>C</th>
<th>Payment</th>
<th>Deposit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2005-06-28</td>
<td>My Checking Account</td>
<td>Car: Fuel</td>
<td>C</td>
<td>52.89</td>
<td></td>
</tr>
<tr>
<td>2006-06-14</td>
<td>My Checking Account</td>
<td>Food: Groceries</td>
<td></td>
<td></td>
<td>25.34</td>
</tr>
</tbody>
</table>

**Balance:** 78.23
10.1 Introduction

'Schedules maintain information about transactions that occur one or more times over a specified period of time.'

Sometimes called a recurring transaction, a schedule provides a means to record information about a transaction that happen on a regular basis. A common schedule is your salary. Once a month, or maybe weekly, the company you work for pays you for services rendered. This payment can happen in many different ways, but each month or week you will receive a payment that needs to be recorded.

Because you know these payments are regularly made to you, you can create a Schedule to record information about the payment and even create the transaction for you when pay day arrives.

Other types of schedules can also be recorded to reflect money coming in and out of your accounts. Common expenses, such as utility bills or money transfers, can be recorded with schedules, along with loan repayments. Scheduling a payment can also provide a useful reminder that you need to make a payment.

A schedule consists of two main parts: the scheduling data and the transaction data. The scheduling data records the occurrence of the schedule, i.e., when the transaction is to be entered into the ledger and how. The transaction data records the normal details about the transaction, and will be entered into the ledger as-is.

10.2 Types of schedules

There are four different types of schedules in the current version of KMyMoney:

- Bills
- Deposits
- Loans
- Transfers
10.2.1 Bills
A Bill Schedule is used for money going out of your account, such as a Gym membership or a utility bill.

10.2.2 Deposits
A Deposit Schedule is for money coming into your account, such as a pay check.

10.2.3 Loans
A Loan Schedule is a special type of schedule and is created when dealing with Loan accounts.

10.2.4 Transfers
A Transfer Schedule is used for money coming out of one account and going into another, such as making a credit card payment from your checking account.

10.3 The schedule view
Open the schedule view by clicking on the Schedule icon in the view selector.

The schedule view consists of a view area with two tabs along with a New Schedule button above it. The first tab List View shows all schedules, grouped by type. The second tab Calendar View is described in its own section below.

To create a new schedule click on the button. For Bill, Deposit, and Transfer schedules, KMyMoney will display the new schedule dialog. Loan schedules are handled differently, and are described in the section on Loans.
10.4 The new schedule dialog

A new dialog window is now shown, prompting for the schedule and transaction data. The requested data includes the following:

1. Schedule Name
2. Next due date
3. Frequency
4. Payment method
5. Amount
6. Other transaction details
7. Schedule options

10.4.1 Filling in the fields

Enter the name and the date of the next occurrence of this schedule into their respective fields. The name is how the schedule will be shown in the list view. Specify how often the schedule should occur, using the Frequency field and drop down list. For example “every 6 weeks” or “every 3 months”. If the amount varies transaction to transaction make sure to check the Estimate check box and you will be prompted for the correct amount when it is entered into the ledger. Fill in all the transaction fields as you would normally with the ledger view.

10.4.2 Modifying the schedule behavior

At the bottom of the dialog are some optional fields that can modify how the schedule behaves. If the schedule occurs on a weekend you can choose whether to enter the transaction on the weekend day, the previous Friday, or the next Monday. Typically this option is used to replicate some real world operation such as a bank transaction.
10.4.3 Letting KMyMoney enter the transaction into the register

To let KMyMoney automatically enter the transaction for you when needed, make sure that the check box labeled **Enter this schedule into the ledger automatically when it is due** is checked. Otherwise, when the transaction is due to be entered, KMyMoney will open a dialog box asking you to confirm that you want it to be entered. This behavior is configurable, and more information can be found in the Settings section.

10.4.4 Letting KMyMoney know when the schedule will finish

If you know how many transactions are left or when they are due to finish, this information can be entered so the transactions are not entered indefinitely. Check the appropriate check box and enter the appropriate information. Only the date or the number of transactions remaining is needed because the other can be calculated.

When you have entered all the necessary information click on **OK** to continue.

10.5 Editing schedules

To edit a schedule simply select the entry in the list and right click to bring up the context menu and select **Edit**. This will bring up a dialog similar to the New Schedule dialog, where you can alter the necessary data.

10.6 Deleting schedules

To delete a schedule simply select the entry in the list and right click to bring up the context menu and select **Delete**.

10.7 The calendar view

The calendar tab presents the schedules in a calendar format so it is easier to see when they occur. To switch to the calendar view click on the **Calendar View** tab.
The calendar type can be changed using the Select Style button. Currently only two types exist: Week and Month. The monthly view is the default, and is usually the most useful. Navigate through the dates using the controls as you would with the date input control.

On any day with scheduled transactions, the number of transactions scheduled for that day is displayed on the calendar.

To view the schedule(s) that fall on that day, move the mouse cursor over the highlight and a popup window will be displayed allowing you to view the schedule summary.
If more than one schedule falls on that day you can cycle through them using the arrow buttons in the upper corners of the popup window.

If you find that the display is cluttered with schedules and you only want to view one type of schedule, then this is possible from the Select Schedules dropdown. After clicking on this button the different schedule types are listed and are checked by default.

To remove a type from the calendar view simply uncheck it in the list.

### 10.8 Entering scheduled transactions

Entering a scheduled transaction means actually entering a transaction into the appropriate ledger, using the details specified in the schedule. Scheduled transactions can be entered in one of four different ways:

- Manually by right clicking on the list entry
- Manually via the popup window in the calendar view
• KMyMoney can enter them with or without your interaction upon startup
• KMyMoney can enter them with your interaction during online banking or import of an electronic bank statement

10.8.1 Manually entering scheduled transactions

You can enter a scheduled transaction manually by right clicking on the list entry and selecting Enter from the popup menu or by clicking on the Enter button on the popup window in the calendar view.

10.8.2 Confirming the transaction to enter

After selecting either method the Enter Scheduled Transaction dialog window is shown prompting you with the required information that was entered when you created the schedule.

This information can be changed, and the changes can be applied to just this one instance of the schedule or to all subsequent transactions. After checking that all the data is correct clicking on OK will add the transaction to the ledger and update the next due date of the schedule to the next occurrence. If you have changed any of the transaction data a further confirmation of what you changed will be displayed, giving you a final chance to accept or reject the changes.
Select what you want to do with the information presented and click OK or Cancel.

**10.8.3 Letting KMyMoney enter the scheduled transaction(s) for you**

Alternatively, KMyMoney can check which schedules are due upon startup and enter them for you if the appropriate option was checked when setting up the schedule.

If the option was not checked then KMyMoney will open the previously mentioned dialog and you can follow the steps mentioned there. KMyMoney will also open the dialog if the amount is an estimate so you can enter the real amount.

You can also opt to have KMyMoney not check which transactions are scheduled on startup by deselecting the option in the Settings dialog and any overdue transaction or transactions due ‘today’ will be shown in the Home view for you to enter manually.
Chapter 11

Ledgers

Michael T. Edwardes
Roger Lum
2010-07-23
4.5

11.1 The Ledger View

The Ledger view is where most of the functionality of KMyMoney lies. This view is for examining and entering transaction data in the various accounts. The view is split into three main areas: the filter area, the transaction list, and the input area.

This view allows for several key actions: searching and viewing transactions, entering new transactions, and editing or deleting existing transactions. Other functionality includes modifying account details and reconciling the account.

The view has three elements:
11.1.1 The filter area

You can select an account via the account dropdown list at the top of the view area. Note that depending upon the type of the account the transaction input form at the bottom of the view changes.

To the right of the account dropdown list, are two additional fields. The search box acts as a filter on the transactions that are shown in the list view. Only transactions that include the text typed in the search box are displayed. The text specified can be in any of the fields of the transaction. The status field is a dropdown list. Only transactions of the type selected in that dropdown are displayed.

11.1.2 The transaction list

<table>
<thead>
<tr>
<th>No.</th>
<th>Date</th>
<th>Details</th>
<th>C Payment</th>
<th>Deposit</th>
<th>Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>105</td>
<td>2010-05-15</td>
<td>NiceApartments Ltd.</td>
<td>800.00</td>
<td></td>
<td>234,493.24</td>
</tr>
<tr>
<td>107</td>
<td>2010-05-18</td>
<td>GasCo.</td>
<td>60.00</td>
<td></td>
<td>234,433.24</td>
</tr>
<tr>
<td></td>
<td>2010-05-21</td>
<td>Checking</td>
<td></td>
<td>3,000.00</td>
<td>237,433.24</td>
</tr>
<tr>
<td></td>
<td>2010-05-21</td>
<td>Savings</td>
<td>250.00</td>
<td></td>
<td>237,183.24</td>
</tr>
<tr>
<td>106</td>
<td>2010-05-28</td>
<td>My Bank</td>
<td>1,048.98</td>
<td></td>
<td>236,134.26</td>
</tr>
</tbody>
</table>

This month

<table>
<thead>
<tr>
<th>No.</th>
<th>Date</th>
<th>Details</th>
<th>C Payment</th>
<th>Deposit</th>
<th>Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>109</td>
<td>2010-06-04</td>
<td>Checking</td>
<td></td>
<td>3,000.00</td>
<td>239,134.26</td>
</tr>
<tr>
<td></td>
<td>2010-06-04</td>
<td>Megatel</td>
<td>45.00</td>
<td></td>
<td>239,080.26</td>
</tr>
<tr>
<td></td>
<td>2010-06-04</td>
<td>Savings</td>
<td>250.00</td>
<td></td>
<td>238,839.26</td>
</tr>
</tbody>
</table>


After you have entered a transaction, it is displayed in the transaction list. You can also change transaction properties or even create new transactions directly in the list. In the transactions list,
the default arrangement of transactions is sorted by date with the most recent transaction on the bottom. Clicking the Right Mouse Button on the header of the transaction list brings up a dialog that allows you to change the sort order of the transactions. For instructions on how to change the default sort order, see the Sorting tab section of the KMyMoney Settings Chapter.

Note that the balance column is based on the currently displayed sort order, and will not be calculated if the display is filtered by the search box or transaction type dropdown, as described above.

At the bottom of the transaction list, KMyMoney displays three values:

**Last reconciled** This is the most recent date on which you reconciled this account. Reconciliation is an important process for many accounts, and is described [here](#).

**Cleared** This is the total of all cleared and reconciled transactions in this account. See [this section](#) for more information about the cleared and reconciled states of transactions.

**Balance** This is where KMyMoney displays the total balance of the account, which is the sum of all transactions in the account. However, if you select more than one transaction in the transaction list, this changes to display the sum of the selected transactions. This returns to the balance when only one transaction is selected.

### 11.1.3 The transaction input form

The exact layout of the bottom area of the ledger view depends on your configuration and the type of account being displayed. However, it generally includes fields for all the details of a single transaction, as well as buttons for various actions that can apply to a transaction. It is described in more detail in the following sections.

### 11.2 Entering Transactions

There are two methods of entering transactions into the ledger: using the transaction input form and entering the data directly into the transaction list. The transaction input form is displayed by default and this is the method we will discuss first.

The fields in the input area match the information fields in the transactions list. Additional fields include the Memo field, for a more detailed description of the transaction, and a Category selection. The Split button allows you to split the transaction into multiple categories.

### 11.3 Using the transaction input form

The transaction input form at the bottom of the ledger view is the interface for creating transactions.

![Transaction Input Form]

The transaction input form at the bottom of the ledger view is the interface for creating transactions.
Depending upon the type or method of transaction you wish to enter there are several tabs available on the transaction form. Click on the tab that best describes your transaction (deposit, transfer, or withdrawal) and the form will load several fields ready for your input.

Please note that the actual transaction method is not used directly by KMyMoney but is purely for grouping/reporting purposes.

If you are unsure which method to choose simply use Deposit for any money going into the account, Withdrawal for money coming out of the account, and Transfer for money moving from one account to another. The transaction methods and the differences between them are discussed in more detail elsewhere.

Select the transaction method by clicking on one of the tabs.

### 11.3.1 The fields of a transaction

Enter the information using the following notes on the available fields. Note that many fields have ‘Auto Completion’ turned on. That is, if you start typing, KMyMoney will offer alternatives matching the characters you have entered so far. To select an entry click on it using the mouse or keyboard, or if your entry is not listed keep typing to add the new value. The next time you type the value in, KMyMoney will find it for you after the first few characters have been input.

#### 11.3.1.1 The Payee

The Payee is who the money came from/to. If the payee is a new entry KMyMoney will ask if you wish to add this to the list of Payees. Any other information related to a payee or payer, such as address details can be updated in the Payees view later.

#### 11.3.1.2 The Category

The Category associates a transaction with an income or expense category for accounting and reporting purposes, and enables you to group certain transactions. Type the name of the category into the required field. If you have entered the category and it does not exist then KMyMoney will ask if you want to create a new one.

If you wish to associate parts of the transaction with different categories, KMyMoney can let you do that. An example transaction might be a cash machine withdrawal of 50 of which you use 10 on food, 20 on beer and 20 as spare cash. The transaction will therefore be assigned three categories: Food, Beer, and Cash. To do this, you need to use Split Transactions, which is described in more detail below.

See the special KMyMoney fields section for more information on how to use this field.

#### 11.3.1.3 The Tag

Tags were introduced to KMyMoney in version 4.7, and they are not yet fully documented in this handbook. Tags are similar to Categories, and can be used to maintain an orthogonal view to Categories. For example, you might have a Category for each different type of automotice expenses, and then have a Tag for each vehicle. As with Categories, you can select from the dropdown list, or type a new Tag name, and be prompted if you want to create a new Tag with that name.

#### 11.3.1.4 The Memo

A multi-line memo can be entered if you wish to help you remember what the transaction was for.
11.3.1.5 The Check Number

The check number can be entered if needed. Note that the check number can always be visible if desired. This is configured in the Settings dialog.

11.3.1.6 The Date

The transaction’s posting date must be entered to specify when the transaction took place. See the special KMyMoney fields section for more information on how the date input field can be used to make entering dates quicker and easier.

11.3.1.7 The Amount

Finally, enter the transaction amount into the required field. Note that a simple calculator can be displayed, either by clicking the icon to the right of the amount field, or by entering the % character into the field, or by entering a formula, as in 12 + 3. When entering the plus sign, the calculator will be opened.

When you are satisfied that all the fields have been filled in correctly, click on Enter. If you accidentally press or click on Enter before you have finished entering all the data, click on Edit to resume entering the data.

11.4 Directly inputting transactions into the list

The second method of entering transactions into the ledger involves editing the transaction list itself directly.

To do this you must first let KMyMoney know that you don’t want to use the transaction form by opening the settings dialog and unchecking the Show transaction form option.

This is performed by selecting Settings → Configure KMyMoney from the menu bar and selecting the Register icon from the list on the left. The option to uncheck is labeled Show transaction form. When finished click on OK to be ready to directly enter transactions.

11.4.1 Starting the edit

To enter a new transaction into the register you can now either click on an empty entry, press Ctrl+Ins, or click New at the foot of the window. The Up and Down arrow keys let you navigate through the list. After pressing Enter or double clicking on an entry, the transaction list displays the fields required to enter the transaction and waits for input.

To move through the fields press the Tab key and when done press Enter to save the changes or Esc to cancel.
In case the option **Use Enter to move between fields** is selected, the **Enter** moves to the next field just as the **TAB** key except for the last entry field where it stores the data.

Which method you use to enter transactions is up to you and is a matter of personal preference.

### 11.5 Split Transactions

The Split transaction feature allows you to divide up a transaction into multiple categories, representing, for example, the different items bought with a single purchase at a store.

To enter a split transaction, using either the transaction input form or the transaction list, start a new transaction as normal, including entering the total amount. Then, instead of selecting a category, click the **Split** button. If you have already selected a category, that becomes the first entry in the split editor screen.

In the split editor screen, double-click an empty line to enter a new sub-transaction or press **Ctrl+Ins**. Specify the category, add an (optional) memo, and enter the amount. To save this part of the split, press the green check mark under the category. To cancel, press the red cross.

After entering a split, the bottom of the split editor shows how much of the total transaction is still unassigned. After entering all the splits, press the **OK** button to save the entire transaction. If there is still an unassigned amount, you will be prompted to either return to editing the splits, change the total transaction amount, or leave part of the transaction unassigned.

Note that the category field in the transaction input form or the transaction list now displays **Split transaction**.

### 11.6 Editing transactions

To edit a transaction, select it in the list view and either click on **Edit** in the transaction input form or right click on the entry and select **Edit** from the popup menu. If you are editing transactions directly in the list you can edit the transaction simply by double clicking on an entry or by pressing **Enter** when a transaction is highlighted.

### 11.7 Deleting transactions

To delete a transaction, select it in the list view, right click on the entry, and select **Delete** from the popup menu when it appears, or click **Delete** on the transaction form.
11.8 Matching Transactions

Generally, when importing transactions, either via QIF, OFX, or HBCI, KMyMoney will automatically attempt to match them against existing transactions. To allow for differences in the dates, there is a default setting of 4 days, which may be changed in the settings - Register/Import. Any transactions so matched will be highlighted in green. On completion of the import, you should review these and either accept or unmatch them.

If you should find that an imported transaction was not automatically matched with an existing transaction when it should have matched, then it is possible to match them manually. Note that there is a difference between manually matching two transactions and simply deleting one of them, even though they may appear to have the same effect. Specifically with OFX or HBCI, it is important not to delete the imported transaction, because you will find that the next time you import your transactions, the deleted transaction shows up again. This is because modern import formats like OFX and HBCI use a 'Transaction ID' to identify transactions. When you delete the imported transaction, the transaction ID goes with it, so the importer has no way to know this transaction was already imported.

The solution is to tell KMyMoney that the transactions are the same, using the manual matching interface. This allows you to match an imported transaction with a hand-entered (non-imported) transaction. To do so, select one of the transactions to be matched by clicking on it, then select the other by left clicking on it while pressing the Ctrl key, and then select Match from the context menu. This changes the background color to a pale green. This will match and combine the two transactions together. The values of both transactions must be the same for the match to work, except that the dates may differ by the window specified in the settings, as described above. If you are happy with the result, right click the matched transaction, then select Accept.

During import of online statements - either directly or by importing a downloaded file - KMyMoney performs matching as best as it can based on the name of the payee and the amount of the transaction. In case of an invalid match, a matched transaction can be unmatched.

**NOTE**
The matching interface will not allow you to match two transactions which have both been imported. Likewise, it won’t allow matching between two transactions which have both been entered by hand.

11.9 Understanding the Cleared State

A transaction can have one of three states: non-reconciled, cleared (C), and reconciled (R). When you enter a transaction, it has state non-reconciled. Once the bank posts the transaction, the user can clear it and thus transform it to state (C). When you receive a statement from the bank, all cleared transactions should be on the statement.

When you reconcile your account, you actually mark the statements as cleared and check that the difference between the beginning balance and the cleared transactions equals the ending balance.
of the statement. When this is the case, you can ‘finish reconciling’ which actually changes the state of all cleared transactions (C) to reconciled (R).

If you try to edit a transaction with at least one split marked as reconciled (R), you will be warned.

A fourth state is defined (frozen (F)) but there’s currently no way to set it. It is reserved for future use. Nevertheless, if a transaction has at least one split in state frozen it cannot be edited anymore.

11.10 Changing Transaction Settings

There are several settings options that change the appearance and behavior of the ledger view in terms of transactions. These settings are found by selecting Settings Configure KMyMoney from the menu bar, and selecting the Register icon from the list on the left.

Most of the settings are self explanatory. For clarity, several of the settings are explained below.

- Show transaction form (under the Display tab) - toggle to hide the transaction input area at the bottom of this screen. Transactions can still be entered directly into an empty line at the end of the transaction list, through an automatic compact entry area.

These images show what direct transaction entry looks like compared to the transaction form.

The transaction input form

Transactions entered directly

- Keep changes when selecting a different transaction/split - by selecting the next line in the transaction list or split editor, the changes are kept, instead of the default behavior where you have to push the green check mark to save changes.
11.11 Other Functionality

Additional options are available from the Transaction Options menu, accessed by right-clicking any transaction in the list.

Options include jumping to the Payee’s page, creating a schedule, and changing the reconciled or cleared indication.

To edit the account information from the ledger view, select Account from the menu bar. From this menu, you can change the account details, or bring up the Reconcile menu, which allows you to match transactions against an official bank statement or credit card notice.
Chapter 12

Investments

Ace Jones
2014-08-30
4.7.01

12.1 Investments in KMyMoney

12.1.1 Investments

Investments are instruments for investing money that are traded on a market. Stocks, bonds, and mutual funds are the most common investments; so they are the ones supported most directly. Futures, commodities, options, and more complex derivatives are also sometimes used, but KMyMoney has no special functionality for them. As long as they behave like a stock or a bond, they can be tracked easily.

12.1.2 Base Currency

Each investment has a Base Currency. This is the currency in which it is traded. When a price quote is entered for an investment, the currency of the value given is always its base currency. A stock on the NYSE (New York Stock Exchange) would be in US dollars, and one on an Australian market would be in Australian dollars.

12.1.3 Investment Accounts

Investment Accounts hold a collection of investments. An Investment account contains transactions, such as buys and sells, of those investments. All transactions in an Investment account must relate to a specific investment. There is no separate ‘cash balance’ in an investment account. For that, you need a Brokerage Account.

12.1.4 Brokerage Accounts

An investment account often has an associated Brokerage Account. This is also sometimes referred to as a ‘Cash Account’. Investment accounts cannot contain cash transactions, like a transfer from your bank. When a stock is sold, the proceeds are typically placed in the Brokerage Account.

When you create an Investment Account, you have the option of creating an associated Brokerage Account with it.
12.2 Creating an Investment Account

The first step on the path to working with investments is to create an account to hold your investments. Choose Account → New account... to begin the process of adding a new account. Create an account as usual, making sure to choose ‘Investment’ as the type of account.

To work with the new investment account, navigate to the Investments view, and choose the account you have just created from the Select Account dropdown box.

12.3 Adding Investments to Your Account

To add individual Investments to your Investment Account, navigate to the Investments view, select the Equities tab, and choose the account where the investment is held from the Select Account drop-down box.

Right-click the mouse in the empty space in the view. This brings up the Investment Options context menu. Choose New investment... from this menu. This launches the New Investment Wizard which you use to create your new Investment.

12.3.1 New Investment Wizard

The first thing you’ll be asked to enter is the type of investment, whether it’s a stock, bond, etc. Next, the investment details page is presented. The following information is entered on this page:

- Trading Symbol. The ticker symbol used to identify the investment on whatever market it trades. KMyMoney requires a trading symbol for all investments; however some investments do not have symbols. In this case, you will need to make up a symbol for it.

- Full name. The friendly, readable name of the investment you’re creating, e.g., ‘Advanced Micro Devices, Inc.’ This name is also referred to as the security.
• Fraction. The degree of precision to which your holdings are measured. For example, in the US most mutual funds measure holdings to three decimal places, so you would enter 1000 in this field. Stocks are often measured to only whole units, so you could enter 1 for a stock like this.

• Trading market. Where the stock trades. This is an optional field which is provided for your convenience. This information is not used anywhere else in KMyMoney.

• Identification. An optional field to enter additional identification information you might like to keep track of. Again, this information is not used anywhere else.

• Trading currency. The underlying currency in which this investment trades on its market.

• Price entry. Choose whether the price will be entered as an individual price, or as the total for all shares.

If you are using Online Quotes, ensure that the symbol exactly matches the symbol used by your quote source. Yahoo covers most of the world’s markets, and requires a suffix on the end of symbols outside the US. For example, Rubicon Limited on the New Zealand market should be entered as ‘RBC.NZ’.

Finally, you’re presented with the Online Update screen. This is where you tell KMyMoney how you would like to update the prices of your investment. The following items are set here:

• Use Finance::Quote. This is an option for GnuCash users who are used to this style of quotes. Most users can leave this unchecked.

• Online Source. The online source you’d like to use for this particular investment. The most common choice is ‘Yahoo’. Try that first, and if the investment cannot be found using this source, then experiment with the others.

• Factor. A multiplier that should be applied to quotes retrieved for this investment. This is most commonly needed for UK stocks where the price quoted is in pence (1/100), and the stock is denominated in pounds. In this case, enter 0.01 for the Factor.

12.4 Editing an Investment

The Equities tab of the Investments view window lists your current holdings in this account, along with their symbol, value, quantity, and price. Right-click the mouse on any of the investments to bring up the Investment Options context menu, where you have the option to add, edit, or delete individual investments from this account. Also, you can update the price of your investments here either manually or via their online source. In addition, it is possible to close an empty account, or to reopen a closed account.

12.5 Investment Transactions

Investment transactions are entered and edited in the ledger view, as with other kinds of accounts. However, the fields are different, and vary depending on the investment transaction type or activity. Investment transactions have some additional elements:
12.5.1 Activity

The Activity for an investment transaction describes what action is happening to the stock. The following activities are supported:

**Buy/Sell**
Use to record purchases or sales of individual investments. This action requires an account to transfer the funds from/to.

**Dividend/Yield**
Also known as a ‘Cash Dividend’, this action is used for when you receive an interest or dividend disbursement from your investment. This action requires an account to transfer the funds from/to.

**Reinvest Dividend**
Reinvest Dividend. This is a dividend where the proceeds are re-invested back into the investment.

**Add/Remove Shares**
A simple increase or decrease in your balance. This should be used very rarely, because it’s uncommon for shares to just show up in your account (or disappear) unless it’s a purchase or a sale.

**Split Shares**
Used when the stock is split. Enter the ratio of the split in the ‘Split Ratio’ field. For example, in a 3:2 split, enter 1.5

12.5.2 Security

Each investment transaction must be associated with an individual security, which is here just another name for an investment. Choose the investment name when adding or editing a transaction. The symbol will be displayed when viewing it.

12.5.3 Account

For any transactions which generate or require money, you must enter the account where the money is transferred to/from. If your investment account has an associated brokerage account, it’s usually best to transfer the funds there. This applies to funds for purchase or sale of the investment, as well as for fees paid or interest or dividends earned.
12.5.4 Shares, Price & Total Amount

For buy, sell, and cash dividend transactions, the number of shares, the price per share, and the total amount of the transaction must be established. You can enter any two of these, and KMyMoney will calculate the third. It’s usually best to enter just the total amount and the number of shares, because these are the known facts of the transaction. The price per share can be calculated from these.

12.5.5 Fees

With many investment transactions you can include the fees (or commission) you paid the broker. If you enter a category for the fee, then a field will be shown to the right where you can enter the amount of the fee. If you need to enter more than one fee for the transaction, you can use the Split Transactions feature. In this case, when you complete entering all the splits, the total amount of the fees will be shown to the right.

12.5.6 Interest

This is how you enter an interest or dividend payment from an investment. As with fees, if you enter a category, then a field will be shown to the right where you can enter the amount. You can also use the split transaction feature, if required.

12.6 Working With Foreign Investments

KMyMoney supports multiple currencies and investments, and you may want to combine the two. However, doing so requires extra care. As noted above, when you added an investment, you had to specify its trading currency. This might not be the same as your base currency, and it also might not be the same as the account in which you hold the stock or the account where you transfer your funds to/from for buys/sells.

Consider a hypothetical case. Your base currency is USD. You have an investment account in EUR, and a brokerage account also in EUR. In that account, you hold shares of TietoEnator, which is traded in SEK.

When you enter a buy transaction on this investment, use SEK as the currency. So if you buy 100 shares at a price of SEK 248.00, for a total of SEK 24,800.00, enter these values in the transaction.

When you choose the brokerage account to fund the transfer, you’ll be warned that it’s in a different currency.
When you finish the transaction, you will be prompted for a price update to the investment account’s currency, in this case, SEK -> EUR. Review the documentation on Entering Prices Manually for more information on the price dialog.

If you then switch over to the brokerage account, you will see the transaction as EUR 2,254.54, assuming an exchange rate is 11.0000 SEK / EUR.

12.7 Updating Prices

There are two ways of updating the prices for your investments. You can either enter the new price manually or have KMyMoney fetch it from the web.

12.7.1 Manual Price Updates

You can enter prices for your investments using the same Price Editor as used for currencies.

12.7.2 Online Price Quotes

KMyMoney has the ability to download the latest prices for your investments and currencies via the web.

12.7.2.1 How Online Quotes Work

At your request, KMyMoney will fetch a page from the web that contains the latest price for each item. By default, prices are fetched from finance.yahoo.com, and are subject to the terms and conditions of that site.

The online quote lookup uses the investment’s trading symbol to find the price. Therefore, it’s important to set the symbol correctly. Yahoo supports stocks from most major world markets, so
it’s usually just a matter of finding the correct symbol. For example, TietoEnator trades on the Stockholm Stock Exchange market, and its Yahoo symbol is TIEN.ST.

To find the trading symbol for a security supported by Yahoo, use the ‘Symbol Lookup’ feature at finance.yahoo.com.

### 12.7.2.2 Assigning a Quote Source

In order to get online price quotes, you first have to enable it for each investment or currency you want updated, by setting a ‘Online Quote Source’. This is the name of the service from which the quote should be fetched. KMyMoney ships with several sources to choose from. Yahoo is the recommended default source, and should work for most investments and all currencies.

To assign a quote source to an investment, navigate to the investment summary view for the account in which the security is held. Edit the security by right-clicking it and selecting *Edit Investment* ... In the Investment Detail Wizard, click *Next* twice, for the Online Update section. In the Online source dropdown box, select the online source.

Versions of KMyMoney starting with 0.9 contain support for the Finance::Quote package for obtaining online quotes. This is intended primarily as a convenience for those users converting from the GnuCash finance package, which uses it as its native method. If you do select this option, you should see a different list of sources, those supported by Finance::Quote. If the list is empty, it suggests that the package is not properly installed. See their web site at [http://finance-quote.sourceforge.net](http://finance-quote.sourceforge.net) for more information.

### 12.7.2.3 Adjusting a quote

Some online sources do not report the price in a base quantity (e.g., EUR) but in a fraction (e.g., Cent). Using this information as price will produce wrong values for your investments.

If this is the case for your online source, you can use the *Factor* field to enter an adjusting factor. For the above mentioned example the factor would be 0.01.

The *Factor* field is only available if a *Quote Source* has been selected.

### 12.7.2.4 Fetching Quotes

Typically, you will update the prices for all your investments and currencies at once. Choose the *Tools* → *Update Stock and Currency Prices...* menu option to bring up the online price quotes dialog. Press *Update All* to fetch quotes for all investments and currencies in your KMyMoney file.
12.7.2.5 Adding or Editing Quote Sources

Adding or editing quote sources is not recommended for anyone but the most technical user. You should feel comfortable reading HTML and writing complex regular expressions. If this doesn’t sound like you, we recommend writing to the developer’s list if none of the quote sources work for you. Ideally, please point us to a web page where these quotes can be obtained.

If you do feel up to the challenge, here’s how it works. The quote sources are contained in the settings dialog. Choose **Settings → Configure KMyMoney**. From there, choose the **Online Quotes** section. You can choose an existing source to edit, or create a new one. When you are done with your changes, be sure to press the **Update** button before exiting the dialog. Your changes are not saved by default.

The first thing to worry about in an online quote source is the URL. This is the page that is fetched from the web. You will see a %1 in all sources, and a %2 in currency sources. For investments, %1 is replaced by the trading symbol. For currencies, %1 is replaced by the From currency, and %2 is replaced by the To currency. This URL is then fetched, all HTML tags are removed, and that stripped file is then sent to the page parser.

Note that the URL can also be a file: URL, which the quote fetcher takes to mean an executable script. It will pass any command-line arguments to it that you have specified, and feed the stdout to the page parser. For example, you might have a script called getquote.sh that contains custom quote logic, taking the symbol as a single parameter. Your URL would be ‘file:/path/to/getquote.sh %1’.

The page parser looks for a symbol, a date, and a price. Regular expressions tell it how to extract those items from the page. Please review the documentation for the QRegExp class for the exact makeup of the regular expressions. There should be exactly one capture expression, surrounded by parentheses, in each regexp. The date format further tells the date parser the order of year, month, and day. This date format should always be in the form “%x %x %x”, where x is y, m, or d. The date parser is very smart. ‘%m %d %y’ will parse ‘December 31st, 2005’ as easily as ‘12/31/05’. Two digit years are interpreted as being in the range of 1950-2049.
12.8 Unimplemented Features

Certain common features that are normally found with investments are not yet implemented in KMyMoney. These include: Derivatives (options, futures, etc), capital gains, and tax reporting for investments.
Chapter 13

Currencies

Thomas Baumgart
2014-08-30
4.7.01

KMyMoney supports the use of multiple currencies in different accounts. For example, you can set up a bank account in Euros, another in British Pounds, and still have your credit card account in US Dollars.

13.1 Base currency

Once you create a KMyMoney file, you will be asked for the base currency. The base currency is the one that all income and expense categories use and that reports will be based on. Usually, the base currency is the currency you use in your country. If not otherwise selected, new accounts will use this currency as the default.
13.1.1 Adding a new currency

Although it does not happen often, sometimes a new currency is introduced. This can be a new virtual currency, such as Bitcoin, or a change introduced by a country for financial policy reasons. While any such currency will be added to the next version of KMyMoney it is possible to add it manually, in case you have a need to begin using it immediately.

To manually add a currency, select **Tools → Currencies...** to display the **Currencies** dialog, as shown above. Right click on any existing currency and select **New currency** from the **Currency Options** context menu. Enter the official code for the currency and click **OK**. The currency will be created with the name ‘New Currency’. To change the name, either press **F2** or right click and select **Rename currency**.

13.2 Account setup

If you create a new account you have the option to specify the currency in which it will be managed. The ledger for the account will then show all values in the selected currency. The new account wizard defaults this setting to the **base currency**.

13.3 Entering transactions using different currencies

Whenever a transaction is entered that refers to more than one currency, the exchange rate editor pops up and allows you to enter an exchange rate. Initially, the current price available from the price database will be used as exchange rate. See **Entering exchange rates for currencies** for more information on how to provide exchange rates manually and obtain online price information.

Optionally, the exchange rate is saved in the price database once entered by the user.

13.4 Exchange rates for currencies

13.4.1 Entering prices manually

The price database editor allows you to enter exchange rates between currencies or prices for investments. You can pull it up using the **Tools → Prices...** menu option.
In KMyMoney a ‘Price’ is the price of one currency in terms of a second currency. For example, as I write this, the price of 1 USD in terms of 1 EUR is 0.83; that is, 1 USD costs 0.83 EUR. The first currency is the one being bought or sold, and the second one is the currency used to buy or sell it.

When you press the **New** button, you get the New Price Entry dialog. Enter the first currency (USD in the example above) in the Security field. Enter the second currency (EUR in the example above) in the Currency field. Enter the effective date of the price in the Date field.

### 13.4.2 Online currency updates

KMyMoney will fetch currency conversions from the web. Once you have entered a single price for a pair of currencies, the online quote feature will always list that pair amongst its options.

See the section on **Online Price Quotes** in the Investments chapter for more details.
Chapter 14

Reconciliation

Michael T. Edwardes
2010-07-21
4.5

14.1 What is reconciliation?

Reconciliation is the process of matching the transactions you have entered into KMyMoney with the transactions listed for that account by the institution. This is most commonly done with the list of transactions in a statement, be it a bank statement, credit card statement, loan statement, or any other statement. It can also be done against an on-line listing of the account, although this is less common. If any discrepancies are found, then either you or the person who created the statement have made a mistake.

To reconcile an account, choose your account from the drop down box and click on the Reconcile icon, select Account → Reconcile... or use the key combination Ctrl-Shift-R.

14.2 The reconciliation wizard

This will open the reconciliation wizard. The first page of the wizard briefly describes the process you will follow. Click on Next to actually start the wizard.
14.2.1 Statement details

The statement date, starting balance, and ending balance can be found in your statement. Make sure that the figures match and click on the Next button. If the figures do not match then enter the figures as listed on your statement and click on the Next button.

14.2.2 Interest

If the statement reconciliation is on a bank account or any account with interest and/or charges fees, then enter these values in the appropriate fields. A category can be assigned for each of these amounts.
The interest field is for interest you gained. If you have to pay interest, e.g., for a credit card account, this has to be entered as a charge.

Click on Continue to start matching your statement to what you have entered. Note that this completes the Reconciliation Wizard, but not the process of reconciliation. It also changes the ledger display by only showing transactions that have not already been marked as reconciled. As described below, you still need to clear transactions and then tell KMyMoney that the account is reconciled.

14.2.3 Clearing transactions

During the reconciliation, any transaction can be edited to make it match the statement, and new transactions can be created as usual. To mark a transaction as cleared, click on the C column in the list view. A transaction is cleared when it matches the transaction on your statement.

The command frame (just below the transaction list area) displays the statement amount on the left, the cleared amount in the center, and the difference on the right. As you mark transactions cleared, these values update to show the change.

Note, however, that as reconciliation is the process of matching the data in your account with that on a statement, changes to any transaction with dates after the statement date you entered in the wizard will be saved, but will not have any effect on the cleared amount shown in the command frame.
14.2.4 Completing Reconciliation

14.2.4.1 Finishing Reconciliation

When the difference between the statement and the cleared balance is zero then the account is reconciled and you can click the Finish button. When you do this, KMyMoney takes all the transactions which have been marked as cleared and marks them as reconciled, and the value in the C column changes from ‘C’ to ‘R’ to reflect the change. In addition, it saves the changes and records that the account has been reconciled. (You still need to save the file to permanently save all the changes.)

14.2.4.2 Postponing Reconciliation

If you’re having trouble completing the reconciliation, or you need to gather some additional information before you can complete the process, you can postpone the process to a later time by clicking on the Postpone button. When you do this, KMyMoney remembers the values you entered when you started the wizard, it does not mark cleared transactions as reconciled, and it returns the ledger to its normal view. If you exit KMyMoney before clicking either Finish or Postpone, it has the same effect as clicking Postpone. Any edits you have made, such as marking transactions cleared or entering new transactions, are not touched, and you can still save them before you exit KMyMoney. However, you will have to run the reconciliation wizard again in order to reconcile the account.

When you run the reconciliation wizard on this account the next time, KMyMoney remembers the values you entered when you previously ran the wizard, and you will be able to change them, if necessary. In this case, the initial screen of the wizard is different, to remind you of this.
You have previously postponed the reconciliation of this account. If you have entered charges or interests the last time you started reconciling this account, you can modify these in the ledger later on.

It is important that you continue with the same statement you used when you postponed the reconciliation.

All information you have entered into this wizard will be shown and all transactions that you already cleared are marked with a ‘C’.
Chapter 15

Reports

Ace Jones
2010-07-25
4.5

15.1 Available Reports

The Reports View lists all available reports, grouped under the following headings.

15.1.1 Income and Expenses

The reports in this section show your income and expenses either for the current month or for each month in the current year. Of course, the duration of the overall report and the duration captured by each column can be configured to your liking. Graphs and Pie Charts also may be produced.
15.1.2 Net Worth

Here there are reports that describe your net worth, either at the current moment, every month for the current year, or every year of your history. In addition, there is a 7-day Cash Flow Forecast and a Net Worth Graph. There are also reports to get the balances for all of your accounts at any given point in time.

15.1.3 Transactions

This section includes reports that list individual transactions. This is the best way to print your account register for a specific period of time. The transactions printed can be grouped together according to your liking by choosing the appropriate report, such as:

- By Account
- By Category
- By Month or Week
- By Payee

15.1.4 Cash Flow

The Cash Flow report is similar to a Transaction report, but it displays all cash-flow related transactions.

15.1.5 Investments

These reports help you keep track of your investments. They only include investment accounts. There are a variety of presentation filters and styles, as shown in this partial list.

- Investment Transactions: Similar to a Transactions report, and includes the share price and quantities.
- Investment Holdings by Account: Shows the current shares, price, and value for each account.
- Investment Holdings by Type: Same as the previous report, but organizes the accounts by type (Stock, Mutual Fund, etc)
- Investment Performance by Account: Shows the annualized performance over any period of time. This performs a cash flow analysis of all money coming into and going out of the account. As a result, this is a very accurate picture of how well your investments are doing.
- Investment Performance by Type: Same as the previous report, but organizes the accounts by type (Stock, Mutual Fund, etc)

There are also graphs for Investment Prices and Investment Worth.

15.1.6 Taxes

The tax reports are just like the transactions reports, with the addition that only Tax related categories are included. This allows you to flag certain categories as being tax-related, and then get one big report at the end of the year to see them all in one place. They may be listed either by Category or by Payee, and for the last fiscal year.
15.1.7  Budgeting

The budgeting reports are similar to net worth reports, but the reports can display the budget for a given year, or even compare it to the actual income and expenses for the same period.

15.1.8  Forecast

The forecast reports are just like the net worth reports, but they use the information to display forecast information. You can display the information at various levels and for the time frame of your choosing.

15.1.9  Information

These reports display non-transaction information about schedules, accounts, and loans.

15.1.10  Charts

If Charts are enabled, this section lists all the reports which are marked to display a graphical chart as the default. They are also listed in one of the other sections, but they are also aggregated here for your easy reference.

15.1.11  Favorite Reports

This section lists all the reports you have marked as a favorite in the report configuration dialog. They are still listed in one of the other sections, but they are also aggregated here for your easy reference. Favorite reports are also included on the financial summary page for even easier reference.

15.1.12  Configuring Reports

To access the report configuration dialog, bring up the report you wish to configure, and press the Configure button at the top of the report.

15.2  Working With Reports

There are a number of actions you can take on each report. You can access these by right-clicking the report name in the list of reports. Alternately, once you have run a report, there are buttons across the top of the view to invoke each of these:

- Chart: Only present if the report is capable of displaying a chart. Clicking this option toggles between the report and the chart.
- Configure: Change the properties of this report. You can customize the report to your liking and save it for future use.
- New: Create a new customized report based on the selected report.
- Copy: The report output can be copied to the clipboard to paste them in another application, like a spreadsheet, for further analysis.
- Export: Reports can be saved in HTML or CSV format.
- Delete: Customized reports can be deleted. The default reports that ship with KMyMoney cannot be deleted.
- Close: Close the current report.
15.3 Configuring Reports

15.3.1 Working with custom reports

You can configure the default reports or create your own from them by selecting 'New' and then configuring the new report. When you select 'Configure' you will be presented with the Report Tab. Initially, it is named the same as the old report with '(Customized)' added to the end. You can change the name to whatever you want. You can even name your custom reports the same as a default report, or the same as another custom report. Also, you can always use the Comment field to further distinguish reports.

The Report Configuration dialog has a number of tabs across the top. Each tab displays options for configuring different aspects of the report.

15.3.2 Report Tab

On this tab, you set the basic properties of this report.

- Report Name: Choose a name for this report.
- Comment: Enter a comment to help you remember the details of this report.
- Convert values to base currency: Select this option to convert all values in the report to your base currency. Leave it unchecked if you’d like to see values in their original currency. If currencies are not converted, then subtotals will not be shown.
- Mark as favorite report: Check this to cause this report to show up on the home page and in the group of Favorite Reports.

15.3.3 Rows/Columns Tab

On this tab, you configure how you would like the rows and columns to be selected and organized. This tab presents different configuration options depending on the style of report you have selected.
For income/expense and net worth reports:

- **Columns**: Choose how large of a time period each column should encompass
- **Rows**: Choose what kind of accounts to display as the rows of this report
- **Detail**: Choose the level of detail required for this report.

The following levels of detail are available:

- **All**: Show every category or account.
- **Top-Level**: Show only the highest-level categories or accounts, and roll up the sums of the subordinates categories or accounts into those values.
- **Groups**: Show only the totals of the income, expenses, assets, or liabilities.
- **Total**: Show only the grand totals line.

For transaction reports:

- **Organize by**: Choose how to group the transactions in this report
- **Show Columns**: Choose which columns should be shown in the report. The date and transaction amount are always shown.
- **Include only Tax Categories**: Only show categories which have been marked as tax-related.
- **Include only Investment Accounts**: Only show transactions from investment accounts.
- **Include only Loan Accounts**: Only show transactions from loan accounts.
15.3.4  Chart Tab

This tab allows you to configure what the report should look like when it is displayed as a chart. See the Graphs & Charts section for more explanation of the charting functions.

- Chart Type: The visual format of chart desired.
- Show grid lines: Whether to print horizontal and vertical grid lines on the chart.
- Draw values on chart: Whether to print the data values on the chart itself for chosen data points.
- Show chart by default: Whether this report should first be displayed as a chart when it’s opened.
- Line width: The width of data lines on the chart.

15.3.5  Other Tabs

The other tabs in this dialog are the same as in the Search Transactions interface. Please refer to the documentation on that interface for details on the other tabs.

15.4  Graphs & Charts

15.4.1  Viewing as a Chart

Each report can be viewed in either textual form or graphical (chart) form. The same report configuration parameters are used in either case. You can easily jump back and forth between the textual and graphical forms by pressing the Chart or Report buttons along the top of the report view.

Care should be taken to limit the amount of data you choose to display on a chart. If you are not careful, using the same configuration for both textual and graphical forms means it’s possible to configure a chart to be visually cluttered, unappealing, and uninformative. KMyMoney will not force you to keep your charts readable and useful!

15.4.2  Available Chart Types

15.4.2.1  Line Graph

A line graph is one of the most simple forms of a chart. There is one line for each series. (Usually a series is a single account or category; see below for more details on that.) The time periods stretch out along the bottom axis, and the currency values are along the left.

The detail level for each line is controlled in the Rows/Columns Tab of chart configuration. If you choose the ‘Top-Level’ detail level, there will be one line for each of the top-most accounts or categories which show the sum total of all underlying accounts or categories. If you choose ‘Groups’ it will instead show one line each for Income, Expenses, Assets, or Liabilities, depending on the other settings.

15.4.2.2  Bar Graph

The bar graph works exactly the same as the line graph, except there is one bar for each series in each time slice.
15.4.2.3 Pie Chart

The pie chart is the most simple chart available. It shows only one time slice, as opposed to showing the values across time. This chart shows only the totals column of whatever report is selected. If your report is configured to NOT convert values to the base currency, there will be no totals column, and therefore this report is not useful.

15.4.2.4 Ring Chart

The ring chart is very similar to a pie chart, except there is one ‘ring’ for each time slice in the report.
Chapter 16

Importing and Exporting

Ace Jones
2017-07-25
4.8.1

16.1 GnuCash Importer

16.1.1 GnuCash Files

The KMyMoney GnuCash importer handles direct reading of standard (XML) files as produced by GnuCash versions 1.8 and 2.0. The following are not supported:

• import of database (Postgres) data
• import of ‘multi-book’ files
• import into an existing KMyMoney file
• import of small-business specific features (Employees, Invoices, etc.)
• export to GnuCash files.

The import will probably only work correctly if presented with a valid file. It is recommended that the GnuCash Check & Repair All function (in the Actions menu) be run before attempting to import.

Files can be opened by specifying the filename on the command line (kmymoney <path to file>), or by means of the KMyMoney File → Open (Ctrl-O) or File → Import menu items.

The similarity between the two products means that much day-to-day data can be imported in a straightforward fashion. However, there are some areas where differences arise, and various options are provided to deal with these. The following sections will describe some of these differences; understanding them should lead to a smoother importation.

16.1.2 Similarities, Differences, and Terminology

16.1.2.1 Small Business Usage

It should be noted that KMyMoney is a personal finance manager, and as such, does not directly support any of the business features of GnuCash, such as tax tables, payroll, and tracking of lots. Any Accounts Payable or Receivable accounts found in a file will be imported as Liability or Asset accounts respectively.
16.1.2.2 Accounts

16.1.2.2.1 Account types

For both products, the highest level of structure in the file is the account. KMyMoney supports 5 main types of account: Asset, Liability, Income, Expense and Equity, each of which may have various subtypes, e.g., Checking, Credit Card, etc. KMyMoney includes a ‘standard’ account for each of these five types, and all other accounts are held subordinate to one of these. KMyMoney enforces more consistency (or less flexibility, depending on your point of view) between account types than does GnuCash, and the importer will correct any inconsistencies it detects. This may result in a slightly different account structure, though this can, within reason, be amended after the import is complete.

16.1.2.2.2 Categories

KMyMoney uses the term Category to denote an account of an Income or Expense type. Unlike GnuCash, these are not considered as ‘ledger’ accounts, and entry of transactions folder into categories is not supported; allocations are made during transaction entry into other account types.

16.1.2.2.3 Structure and Placeholders

GnuCash supports the use of Placeholder accounts. In effect, these are just read-only accounts into which no transactions can be entered, but which function in an analogous fashion to folders in a folder structure, as a holder for other accounts. Though KMyMoney does not support this feature as such, it does provide a parent/child account relationship, so the importer simulates placeholders by creating empty accounts.

16.1.2.2.4 Account Type map

<table>
<thead>
<tr>
<th>GnuCash type</th>
<th>KMyMoney type</th>
</tr>
</thead>
<tbody>
<tr>
<td>BANK</td>
<td>Checking</td>
</tr>
<tr>
<td>CHECKING</td>
<td>Checking</td>
</tr>
<tr>
<td>SAVINGS</td>
<td>Savings</td>
</tr>
<tr>
<td>ASSET</td>
<td>Asset</td>
</tr>
<tr>
<td>CASH</td>
<td>Cash</td>
</tr>
<tr>
<td>CURRENCY</td>
<td>Cash</td>
</tr>
<tr>
<td>MONEYMRKT</td>
<td>MoneyMarket</td>
</tr>
<tr>
<td>STOCK</td>
<td>Stock</td>
</tr>
<tr>
<td>MUTUAL</td>
<td>Stock</td>
</tr>
<tr>
<td>EQUITY</td>
<td>Equity</td>
</tr>
<tr>
<td>LIABILITY</td>
<td>Liability</td>
</tr>
<tr>
<td>CREDIT</td>
<td>CreditCard</td>
</tr>
<tr>
<td>INCOME</td>
<td>Income</td>
</tr>
<tr>
<td>EXPENSE</td>
<td>Expense</td>
</tr>
<tr>
<td>RECEIVABLE</td>
<td>Asset</td>
</tr>
<tr>
<td>PAYABLE</td>
<td>Liability</td>
</tr>
</tbody>
</table>
16.1.2.3 Transactions and Splits

16.1.2.3.1 Balanced transactions

As with GnuCash, data is entered in the form of transactions, each generally consisting of 2 or more split entries. In fact, valid GnuCash transactions will always contain at least 2 splits, and to conform to GnuCash’s double-entry bookkeeping standard, these must be in monetary balance (i.e., they must balance out to zero). KMyMoney encourages, but does not enforce, this standard, but any imported transaction which is not balanced will be marked in the ledger view as having a problem.

16.1.2.3.2 Payees

KMyMoney prefers that all transactions have a Payee (a generic term that encompasses both payees and payers), and unlike GnuCash, a list of these payees is maintained. Payee names are generated by the importer from the GnuCash transaction’s Description field.

16.1.2.3.3 Transfers

KMyMoney uses the term Transfer to describe a transaction which does not involve a Category, but only transfers money between Asset and/or Liability accounts.

16.1.2.3.4 Reconcile

KMyMoney provides an account reconciliation function similar to that of GnuCash, and the corresponding transaction status will be imported.

16.1.2.4 Commodities

GnuCash uses the term Commodity to cover both currencies and non-currency assets. These are treated separately in KMyMoney.

16.1.2.4.1 Currencies

KMyMoney has built-in support for all foreign currency types. KMyMoney also requires that the user specify a base currency, this being the default currency for new accounts. The importer will attempt to determine the most likely base currency, though this choice may be rejected in favor of an alternative.

(Note: KMyMoney does not currently support accounts denominated in ‘defunct’ currencies (except those replaced by the Euro). At present, it will be necessary to remove any such accounts from your GnuCash file before importing. We hope to improve on this situation in a future release.)

16.1.2.4.2 Securities and Investments

Non-currency assets (normally stocks and bonds) are called Securities by KMyMoney, and represent the main difference between the two products, in that KMyMoney requires any account denominated in a security to be subordinate to an Investment Account. This is described in more detail in the chapter on Investments. Though users may have implemented such a relationship, GnuCash imposes no defined structure on it, so the importer is unable to detect it and perform an automatic conversion. Three options are therefore made available:

• Create a separate Investment account for each security, with the same name as the security
The KMyMoney Handbook

- Create a single Investment account which will act as ‘parent’ for all security accounts
- Create several Investment accounts, and assign securities to them as directed by the user.

It depends entirely on user requirements which of these options is relevant in each situation, and in some cases, manual restructuring of accounts after importation may be necessary.

16.1.2.4.3 Prices and currency rates

Security prices and currency exchange rates as displayed in the GnuCash Price Editor will be imported. In addition, price and rate entries will be generated from all transactions involving securities and multiple currencies.

16.1.2.4.4 Online Quotes

For obtaining online price and currency rate quotations, GnuCash uses a package called Finance::Quote. Recent versions of KMyMoney contain support for this package for obtaining stock quotes, and this will be used by default when importing data. You may however select to convert to the native method used by KMyMoney which is covered in more detail in online quotes.

If you choose to do so, the following dialog will allow selection of a ‘native’ KMyMoney price source, or a user-defined source, for each account for which online quotes are required. However, the stock (ticker) symbol will be imported unchanged. Since this symbol will almost certainly be different in the two packages, it will need to be manually edited after completion of the import process. Future currency rate updates will not use Finance::Quote, and will always use the native retrieval method.

16.1.2.5 Scheduled Transactions

KMyMoney does not retain the separation made in GnuCash between template transactions and their frequency of occurrence. Transaction data will be duplicated if the same template is used in different schedules, but this is not likely to be of great significance.
16.1.2.5.1 Schedule types

KMyMoney classifies all schedules as one of three types, Bills, Deposits, or Transfers. Since GnuCash does not make such a distinction, the importer attempts to determine the classification from the accounts and direction of money movements. It may be that in some cases incorrect assumptions are made, and these will need manual correction.

16.1.2.5.2 Suspect Schedules

Some features of GnuCash scheduled transactions are not available in KMyMoney, so the importer tries in each case to reach a reasonable compromise in converting the data. These transactions will be flagged as suspect, and the user will be given the option of editing them directly during the import process. Examples of situations which may cause this are:

- some frequency intervals supported in GnuCash are not currently available in KMyMoney
- KMyMoney does not support the use of formulae and variables in amount fields
- complex cases which have not yet been identified for import.

Despite best efforts, it is possible that, due to the many options involved, a scheduled transaction may cause a fatal error within KMyMoney. If this sort of problem seems to be occurring, the importer offers the option to drop all suspect schedules.

16.1.2.6 Reports

KMyMoney provides a comprehensive selection of configurable reports, described in more detail in Reports. These will not necessarily, however, match precisely those reports available in GnuCash.

16.1.3 Selecting Importer Options
16.1.3.1 Investment Handling

See “Securities and Investments” above.

16.1.3.2 Online Quotes

Turn this off if you wish to use the native method for future online price quotes.
See “Online Quotes” above.

16.1.3.3 Scheduled Transactions

See “Scheduled Transactions” above.

16.1.3.4 Decoding Options

If your native language is written in letters or symbols which are different from those used in the ‘Latin’ languages (i.e., generally Western European), these are represented in a special fashion (‘encoded’) in your GnuCash file. If these letters are not displayed correctly on your screen, then they must be decoded. Currently, it is often not possible to detect accurately which form of decoding must be used, so you may need to set this option and select an entry from the list. In general, the first item in the list will be that which is considered appropriate for your locale (i.e., the country and language which was selected as native when your operating system was installed), so this should be tried first. Since the import process does not overwrite your GnuCash file, you are free to experiment with any of these selections.

16.1.3.5 Transaction Notes option

Under some usage conditions, non-split GnuCash transactions may contain residual, often incorrect, memo data which is not normally visible to the user. When imported into KMyMoney however, due to display differences, this data can become visible. Often, these transactions will have a Notes field describing the real purpose of the transaction. If this option is selected, these notes, if present, will be used to override the extraneous memo data.

16.1.3.6 Debug Options

These need only be used in the event of import problems. If you have such problems, you should also report them to the KMyMoney developer list kmymoney-devel@kde.org. Note that the traces produced by these options may contain data of a confidential nature, and the Anonymize option should be used if they are to be made publicly available.

16.1.4 Import Report

At the end of processing, the importer produces a report showing the number of different entities processed, and any errors or anomalies encountered. This report will be displayed on screen, and may be saved to a file for later review. A full report may contain the following sections:

- Record counts
- Inconsistencies in account types and actions taken
- Details of suspect schedules
16.2 QIF Importer

16.2.1 QIF format considered harmful

Generally speaking, the QIF format should be avoided wherever possible. It is a poor choice for transporting financial data. Among other things, QIF suffers from these problems:

- Lack of standardized format: Different versions of the same program will impart different meanings to the same element.
- Lack of transaction identifier: Because there is no ID number associated with each transaction, matching duplicate transactions is haphazard at best.
- Lack of expressiveness: The grammar is really simple, and cannot portray the depth of financial information found in today’s financial environment.

This is generally why Intuit stopped supporting QIF input at all with Quicken 2005. If you have the option of getting data some other way, like OFX, always choose that option.

16.2.2 How to import a QIF file

To import a QIF file, first ensure you have a valid KMyMoney file open. Then select **Import → QIF...** from the **File** menu.
The resulting dialog prompts for the QIF filename allowing you to locate the file by clicking on the **Browse** button.

Also, KMyMoney differentiates between the import of a bank statement file and historic data exported from another application. The default is to import a bank statement file. In case you are importing data from your previous personal finance manager application select the appropriate option.

In general the default QIF profile should work with your QIF data. In some cases it might become necessary to use a modified QIF profile. See the next section for more details on that subject.

Click on **Import** to import the QIF file.

KMyMoney will start scanning the file to determine the formats used to represent dates and numbers. In case it cannot determine a date format unambiguously, KMyMoney will ask the user to select one from the list of possible date formats.

Next, KMyMoney imports the data and creates all necessary objects, such as payee information, accounts and category records, and stock price information. Wherever possible, existing transactions will be matched against the imported information. A progress bar is shown and updated during the import process.

In case KMyMoney could not detect the name of the account to be imported, the user will be asked to select the account into which the data should be imported. If the account does not already exist in your file, a new account can be created by clicking on **Create**.

At the end of the import, KMyMoney shows a statement import statistics window.
The KMyMoney Handbook

After importing, all of the imported transactions will be shown with a yellow background in the ledger view. In case KMyMoney was able to match an imported transaction with an already existing transaction, the background is shown in light green.

The next step is to verify the imported data and accept it. This is a general process and also applies to imports from other sources. It is outlined in a separate section of this document.

**NOTE**
The colors used to mark imported and matched transactions are customizable and may be different in your environment.

### 16.2.3 Setting up a QIF profile

Because there is no universally standard format for a QIF file, different vendors have taken liberties with the format, and introduced their own nuances. The QIF Profile allows KMyMoney to know about the peculiarities of your file. To edit an existing QIF Profile, or to create a new one, press the **New** button on the QIF Import dialog, near the profile selector.
NOTE

Previous versions of KMyMoney used to have a tab for date and amount specifications. KMyMoney now determines those settings by scanning the file. If it cannot figure out all settings, it will interrogate the user during import.

Another possible use of a profile is if your QIF file uses a non-standard character set, such as ISO-8859-1. To have KMyMoney convert the file to UTF-8 on import, you can use

\texttt{iconv -f iso-8859-1 -t utf-8}

as the value of the filter.

16.2.4 Transaction matching

As noted previously, one of the major drawbacks of the QIF format is the lack of a unique identifier for each transaction. Thus, if you import a QIF file and some of the transactions are already in your ledger, you may get duplicates. KMyMoney attempts to get around this by looking for transactions that look similar to those you already have. If it finds something that looks like the same transaction, it will match the apparent duplicate.

This can be a problem if you have transactions that look too similar but are actually different. In this case, you can unmatch those transactions later in the ledger view.

16.2.5 Writing an import filter

Sometimes you may have data in a custom format, like comma-separated-values (CSV) or something else unique to your situation. As of version 4.6, KMyMoney includes a CSV Importer Plugin, but you can still import other types of files into KMyMoney using a QIF Import Filter. A filter is a custom program you write which takes your special file as input, and produces a QIF file as output. This can be a shell script, a perl script, a compiled program written in C/C++, or anything else you can dream of, as long as the system can run it.

To use it, edit your favorite QIF Profile, and select the Filter tab. Enter the location of your filter program where prompted. Then, whenever you do a QIF import using this profile, the file you select for importing will be run through your filter first.

A common problem is to convert a list of comma-separated-values into a QIF file. This is a textbook case for the awk tool. Create a script called `csv2qif.awk`, with the following two lines as contents:
Then, change the QIF keys (D,T,N,P,M) to match the order of your csv data. Set the input filter to:

```
awk -f csv2qif.awk
```

Another problem sometimes arises in the encoding of QIF files. KMyMoney expects files to be UTF8 encoded. If your file is encoded in something else, it can be useful to convert it to UTF8. For example to convert it from iso-8859-1, you would set the input filter to:

```
recode iso-8859-1..utf-8
```

### 16.2.6 Special KMyMoney QIF extensions

As already mentioned, one of the major drawbacks of the QIF format is the lack of a unique identifier for each transaction. If you are writing your own QIF file creator (or filter, as described above), you can overcome this problem. KMyMoney supports the ‘#’ field. The importer will interpret this as a unique transaction ID, and disregard the record if the transaction is already in the system.

### 16.3 QIF Exporter

To export one of your accounts to a QIF file, choose the **Export → QIF** from the **File** menu. You will be prompted for which single account to export, what file to export it to, and what QIF Profile to use.

**NOTE**

At the moment, QIF Exporter does not handle export of investments.
16.4 OFX Importer Plugin

16.4.1 Getting the plugin

KMyMoney will import OFX files painlessly. However, this functionality is not built into the core program. You must obtain and install the OFX Importer Plugin. Once that is installed, the command to import OFX files will automatically show up under the File → Import menu.

Note that many prepackaged versions of KMyMoney were built with the OFX importer already included or available as a separate package. If the OFX importer does not seem to be installed in your version, the first place to check is in the same place you got your base KMyMoney package.

If you have installed from RPM, the OFX Importer Plugin is contained within the kmymoney-ofx RPM. It should be available from whatever source you got the base KMyMoney RPM. If you have built from sources, all you need to do is have preferably the libOFX 0.9 development headers and libraries installed on your system. The KMyMoney build process will detect these and compile the plugin. At the time of release of KMyMoney 4.6, the latest libofx version was 0.9.4, which is also the minimum required version.

Should you run into trouble trying to compile KMyMoney, and you are certain you have the correct version of libOFX installed, please contact the developers list kmymoney-devel@kde.org for assistance. Include a copy of your config.log file, compressed first via gzip.

16.4.2 What is OFX

OFX stands for ‘Open Financial Exchange’. According to the OFX web site ‘Open Financial Exchange (OFX) is a unified specification for the electronic exchange of financial data between financial institutions, businesses and consumers via the Internet. OFX is not a financial institution.’ The specification defines formats for transfer of financial data both by file and by direct interchange.

Although the standard is much more complete and robust than QIF, there are still variations, depending on the specific implementation used by any institution. OFX files may have an extension of ‘OFX’ or ‘QFX’ (upper or lower case); this does not imply any particular difference in the content. The specification is based on XML, so the files can be read in any text editor, but as whitespace is not relevant to the content itself, some implementations do not use any, making it very hard for a human to read.

Another site with good information is OFX Home. They maintain a directory of financial institutions that support OFX. This can be useful if you have problems setting up OFX direct connect. They also have a forum for discussions about OFX issues.

16.4.3 Importing an OFX file

The most basic way to import an OFX file is to choose the importer from the menu bar. From the File menu, choose Import, and then OFX.... If OFX does not show up under Import, you do not have the OFX Importer Plugin installed correctly. Please see the previous section.

The first thing the importer will do is ask you into which account to import the transactions. If there are transactions from multiple accounts in your file, you will be asked this question multiple times.

After importing, some of your transactions may be shown with an exclamation mark on a yellow triangle in the ledger. This is because they need to be assigned a category. The importer was not able to automatically assign a category based on your past transaction history. You can edit each transaction in the ledger to assign a category, and the mark will be removed.

Please note that this section describes the ‘native’ OFX importer. OFX files may also be imported using the AqBanking Importer Plugin if you have installed that. Note that the two importers do behave slightly differently, and they are written and supported by two different developers.
16.4.4 Importing Investments

Please note that if you are importing a file with investment transactions, those investments must first exist in your KMyMoney file. The trading symbol is used to match, so please ensure that the symbol in KMyMoney is exactly the same as the one in the file you’re importing.

16.4.5 Web Connect

The easiest way to import an OFX file is to set up Web Connect. Visit your bank’s web site, and click on a link to download an OFX file. Your browser should ask you what program you would like to use to open the file. Point your browser to KMyMoney. It will then import the downloaded OFX file into the KMyMoney file you most recently had open. You can also change the file associations of your desktop environment, and have KMyMoney open the OFX file automatically for you.

If you need to import the OFX file into some other KMyMoney file, load up that file in KMyMoney first, and then visit your bank’s web site.

16.4.6 Direct Connect

OFX Direct Connect is now supported in KMyMoney. This gives you the ability to contact your bank directly to obtain statements. In the future, there will be more help written, and this will be moved to its own section.

To enable this feature, you must compile KMyMoney with the --enable-ofxbanking switch (now the default).

Please be warned: Many banks require a separate signup, will give you a separate password or PIN, and may even charge you a separate fee for this service. No bank directly supports KMyMoney. You will have to tell them you want to bank directly from MS Money or Quicken.

The first step is to configure each account for which you wish to download statements. Go to the Accounts view, right click on the account you wish to configure, and choose Map to online account…. In case more than one online banking plugin is installed on your system you will be asked which one to use. For the internal OFX method select KMyMoney OFX. A list of banks will be downloaded from the Internet and a wizard will guide you through choosing a bank, entering your username and password, and selecting an account. Should you find that your bank is not listed, then it may still be possible to use the manual option. Your bank may be able to provide the required parameters, or you may have to do some research to find them.

NOTE

Setting up OFX Direct Connect can sometimes be a challenge, especially as the implementation at most institutions do not provide sufficient details in error messages. One particular issue to note is that many institutions require you to change your password the first time you access it online using this method. Unfortunately, at this time, the library that KMyMoney uses (libofx) does not have a way to interactively change a password. In some cases, it is possible to get a technical support person at the institution to change the password for you. Until we are able to expand this section with more detailed troubleshooting information, if you have trouble getting this to work for you, you can ask for help on the KMyMoney developer list kmymoney-devel@kde.org.

Once you have an account set up with online banking, go to the ledger for that account. Then from the Account menu, choose Update account…. This will connect to your bank, and download a statement for the last 60 days.
NOTE
In version of KMyMoney prior to 4.6, the payee name was always taken from the PAYEEID field. As of version 4.6, the payee name can be based on either the PAYEEID, NAME, or MEMO field in the OFX transaction. You can configure this feature and some other OFX direct connect settings by selecting the appropriate tab in the Edit account dialog.

16.4.7 Exporting an OFX file

It is not possible to export your data as an OFX file currently. If you are interested to contribute in this area, please contact the libofx development team for details.

16.5 CSV Importer Plugin

16.5.1 Reasons for importing CSV Files

In general, it is preferable to import OFX. However, not all institutions provide data in that format. CSV (comma separated value) files are almost always available, sometimes described as Excel or spreadsheet files. Also, they can often be created fairly easily by capturing the data you want to import, such as in a text file, and manually editing it.

The primary focus of the plugin is on importing data from bank statements, but there is also a capability to import some investment statements. This plugin was initially created, before becoming a CSV importer, to produce QIF files from CSV, which could then be imported. This functionality is still present, but is likely to be removed, as the plugin now focuses on directly importing CSV files. Also, KMyMoney has the native ability to export QIF files, so there is no real reason to produce a QIF file from a CSV file.

16.5.2 Getting the plugin

KMyMoney will import CSV files. This functionality is provided as a plugin, and it is now built into the core program, both in distro packages and in the source files. Once the distro package is installed, or the source files are compiled and installed, the menu choice to import CSV files will automatically show up under the File → Import menu.

The CSV importer plugin is much newer than the OFX plugin, but most distributions are now built with the CSV importer already included or available as a separate package. Ensure that it is enabled within KMyMoney. Check the Settings → Configure KMyMoney → Plugins menu. If the CSV importer does not seem to be installed in your version, the first place to check is in the same place you got your base KMyMoney package. See if a later version is available, or if the importer is available as a separate package.

If you have installed from RPM or Deb, the CSV Importer Plugin should be contained within the KMyMoney package. If you have built from source, there should be no additional requirements. The KMyMoney build process should detect the plugin source and compile the plugin.

16.5.3 Importing a CSV file

To import a CSV file, choose the importer from the menu bar: File → Import → CSV... If CSV does not show up under Import, you do not have the CSV Importer Plugin installed correctly. Please see the previous section.

The CSV Importer is in the form of a wizard, with a separate page for each individual step of the process. There may be some minor differences between the text in this handbook, the labels in the screenshots, and the labels you actually see in the wizard. In such cases, the handbook describes what the wizard will look like in the next release.
16.5.3.1 CSV Import Wizard: Start

When started, the CSV Importer displays the Start page. The upper area, where data will be displayed, is initially empty. Below that, on the left, is a list of the steps of the import process, with the current one highlighted. To the right of that are some brief instructions and two radio buttons, allowing the choice of either Banking or Investment. Next there is a profile selector box, which is enabled once one of the radio buttons has been selected. At the bottom of the display are buttons to move on to the next step of the wizard, go Back to the previous step, or Cancel the import. At the initial step, there is also a button Select File to initially select the file to import.

Also, note the Skip setup checkbox next to the profile selector. Initially, you should not select this check-box. Once you have set up a profile and finished the wizard, those parameters are saved in the resource file. Next time you use that same profile, the parameters will be loaded into the UI (User Interface). The wizard would then plod through the following pages of parameters that you won’t need to change. So, instead, once you are happy with a profile, it may be helpful to check this box. The wizard will then move directly to the final page, and, assuming no problems are found, you just have to click Import.

First select either Banking or Investment, then click in the selector box, which displays “Add New Profile.” If you have previously created any profiles, you can select one of them, otherwise enter a new profile name, possibly the name of the account into which you wish to import. If you enter a new profile name, hit Enter to create it. Then, click on Select File, and a standard file selector box will open, from which you should select the CSV file you wish to import.

16.5.3.2 CSV Import Wizard: Separators

The wizard will now have advanced to the Separators page, and you should now see your data.
The KMyMoney Handbook

**WARNING**

It may appear that the displayed entries in the upper section of the plugin window may be edited, and in fact they may, but any edits are not kept. The table is purely for display, not for editing. The input file is never altered by the plugin, and the data actually imported comes from the input file, not from the display. The one exception to this is covered in *Securities and Symbols* below.

The plugin should have detected the appropriate **Field Separator** to use, and it is not usually possible to select a different one. In fact, attempting to do so will reset any field choices you may already have made. There is also a selector for the **Text Delimiter**, but generally the quote (") is correct. Now click on the **Next** button. Depending upon the earlier selection you made, you will now be on either the Banking page or the Investment page.

### 16.5.3.3 CSV Import Wizard: Banking

On this page, you select the column numbers from which to import the relevant fields.
For most fields, you just need to use the appropriate dropdown to select the appropriate column. However, there are a few special considerations.

- In the center are two radio buttons. If your file has a single column for all values, select **Amount col**. However, if there are separate columns for debits and credits, select **Debit/credit col**. This will enable either the **Amount column** selector or the **Debit column** and **Credit column** selectors.

- It is possible to select more than one column for the Memo field, by consecutive selections. Memo columns already selected are marked in the drop-down with an asterisk (*). If you select multiple columns in this way, their contents will be concatenated in the Memo field.

- If you attempt to choose the same column number for two fields, the plugin will alert you and clear both selections. However, it is possible, if desired, to use the same column in both the **Payee/Description** and **Memo** fields. If you select a column for the **Payee/Description** field, and then select the same field for the **Memo** field, you will receive a warning that duplicate columns have been selected, but asking if you wish to proceed. If you do, click **Yes**.

- One particular reason to also capture the Payee/Descriptor field in the Memo field is that the incoming Payee/Description field might get completely changed on import when KMyMoney does transaction matching. Selecting that field also as Memo will preserve that data, which would otherwise get lost.

If you notice you have made an incorrect choice, just change that selection. If several changes need to be made, click the **Clear** button.

Once columns have been chosen for all the necessary fields, the **Next** button will be enabled, and clicking it will advance the wizard.

### 16.5.3.4 CSV Import Wizard: Investment

This page is similar to the **Banking** page, although it is somewhat more complex. Most selections are fairly obvious, but there are some items which can seem confusing until you have completed the process once or twice.
• As on the Banking page, you may select more than one column for the Memo field.

• The Type/Action selector is to identify the column which contains the action type, such as Buy, Sell, Dividend, etc.

• The Price Fraction selector is to indicate the fraction/multiplier for compatibility between imported and stored prices. For instance, if the import file price is in cents, but your KMyMoney account is priced in dollars, select 0.01. Or, if your KMyMoney data file pricing is in dollars, and so is the CSV file being imported, then set Price Fraction to 1.0.

• Use the Fee Column selector if your file has a distinct column for fees. Beware, though, that the fee might have been taken into account in the price. If there is a fee, and it is a percentage figure, rather than a value, click the Fee is percentage check box. Note that on this page, this is the only field to explicitly include “column” in the label, to emphasize that it is for the fee column, not for any actual fee.

• Below the column selectors are two areas for the security identity. Depending upon your broker or financial institution, your file may contain entries for only one or for several securities.
  
  – If the file contains transactions for just a single security, with the name possibly in a header row, the name should be entered into the Security Name box. The name you enter will be added to the drop-down list for future use. You may subsequently wish to remove that name from the list. If so, select it, then click the Hide security button. This removes it only from this list, and has no effect on your main KMyMoney file.
  
  – If the file includes transactions for several securities, each will be identified by its ticker symbol in a column with further detail in another column. Select those columns in the Symbol and Detail selectors. It may be that a security has no official symbol, and in this case a pseudo-symbol may be invented; this is not a problem, as long as it uniquely identifies that security in the import file. Sometimes the actual activity type is embedded in the detail column, possibly prefixed by a standard text. For instance, if the field contains ‘type: dividend’, enter into the Filter text box ‘type: ’ including the trailing space.

When all required fields are selected, the Next button will be enabled, and clicking it will advance the wizard.
16.5.3.5  CSV Import Wizard: Lines

On this page, you indicate if any lines should be ignored at the beginning or end of the file. You also indicate the format of any date column.

Start line Set this so the importer skips any header lines in the file. Your choice will be saved in this profile for future use. The start and end lines interact, and the start line may not be higher than the end line. If the Start line selector does not respond, check the end line setting.

End line The importer will automatically set this to the last line in the file, or to the setting last saved. You will only need to adjust it if there are footer lines in the file the importer should ignore. Otherwise, you are likely to get a data error warning when the plugin attempts to parse incorrect data. Again, if the End line selector does not respond, check the Start line setting.

Date format This needs to be set according to the order of year, month, and day in the dates in the file. If the plugin finds data incompatible with this setting, it will complain when you try to import. However, if the setting is wrong, but does not produce invalid results (such as data with no days higher than 12, so month and day could be switched) you will simply get incorrect data, because the plugin cannot know you made a mistake. In this case, the error will be obvious in the ledger after import.

Once ready, the Next button will be enabled, and clicking it will advance the wizard.

16.5.3.6  CSV Import Wizard: Securities and Symbols

For an Investment file, after the Lines page has been accepted, you need to assure that each security in the file is matched to the correct security in your KMyMoney file, before import can proceed. At this point, another window will open, showing the securities and symbols contained in the import file. Note that unlike the data display in the main wizard windows, the changes you make on this page are imported.

Completing this page is straightforward, if you consider these items:

• Each row represents one transaction, and so it may appear there are duplicate rows. This is OK.
• Each security name must match exactly the existing security as specified in KMyMoney. If it does not match, it will be created as a new security, which you probably do not want, unless it represents the purchase of a new security.

• A symbol must be shown for each security.

• The only information on this page should be the security symbol and name. Any other information initially shown (such as date or activity type) is still in the actual import file, but should not be shown here.

You can edit a symbol or security name by double clicking the cell. For each security, if necessary, edit the name in one of its rows, If the correct security name appears in the imported file, double click on it to select it, then copy and paste/edit, taking care if you have used a variation or abbreviation within KMyMoney. If you edit a security name, that edit will be applied to all rows with the same symbol.

Any line without a symbol will be treated as a brokerage-type checking item. If any transaction involves another account, e.g., a checking or brokerage account for a received dividend or for making a payment, a message box will pop up for the account name to be entered for the transfer. This will generally be the Brokerage account you chose or created when you created the Investment account. Similarly enter the column number containing the payee, if requested. If a mistake is made when entering the account name, the import will go ahead, but KMyMoney will not recognize it, and will flag those transactions as missing a category assignment. If the required account name is rather long, just enter a few characters. The import will proceed but the transactions will be flagged by KMyMoney as missing a category assignment, and you will need to select the correct transfer account after the import. Click OK when done. The import process then gets handed over to KMyMoney.

If you have more that one transaction referring to the same security, you can edit all of them at once, using multi-select. For instance, to add a symbol for several lines, press and hold the CTRL key, and in the symbol column, select each transaction. While still holding the CTRL key, all those symbol cells should still be selected, so click on one and enter the symbol. Click inside the window but outside that column, or hit Enter (not OK). Now that those transactions all have the same symbol, double click one detail entry and edit the security name as you wish. Click elsewhere on the window (or Enter) to accept the edit, which will then change all those entries. The remaining entries will show the symbols picked up from the transactions in the import file.

Now click OK, then Import. In the Enter Account box, enter the name of a Brokerage/checking account for funds. If you enter a valid name that account will be used. If you can’t be bothered entering a correct but long name, enter a few characters. The import will accept that but the transactions in the ledger after import will need a proper account to be selected. For the Brokerage Item box, enter the number of the column containing that detail. Now, on the Invalid transaction box you may get a few entries because the activity type does not match the qty/price/amount combination. On each message, click Select Transaction Type, and a drop down will appear indicating valid activity types for that combination of values.

Now the import has occurred and you’re into KMM to select the investment account to use. Then the checking account, if there were any brokerage type transactions.

16.5.3.7 CSV Import Wizard: Finish

On reaching the Final page, the plugin automatically validates the values. If the numeric value column/s is/are highlighted in green, then the validation was successful and all that is necessary is to click Import CSV and control then passes to the main KMyMoney program. However, if the start and/or end lines are incorrectly set, or if the wrong columns were selected, the highlighting will be in red, and an error message will appear indicating where the error lies. The user will then need to click Back to get to the relevant page to correct the error.

It might also be that if debit and credit columns are in use, one of those columns may legitimately contain no entries. This would mean that that column has no decimal symbol present, and this
would result in a warning. If you see that this is the case, you may click either of the **Accept** buttons (Accept this or Accept all.)

**Decimal Symbol** Another possible problem might be that the selected decimal symbol is incorrect. Selecting the symbol to match the data should clear that error. Normally, you should not need to change this selection. Note that the **Decimal Symbol** must be set to match your file, not your locale. If your locale setting has a different value, conversion will be seen to take place. The display of the file in the upper part of the window will show numeric fields highlighted in green if the current setting produces valid results, otherwise in red. The highlighting also reflects the Start line and End line settings. There could be warnings if any of the selected cells appear not to contain the selected symbol.

**Thousands Symbol** This does not need to be selected, as it is set automatically based on the **Decimal Symbol**. It is provided purely as a guide. In addition, the selector will be inactive if none of the values to be imported is greater or equal to 1000.

**Import CSV** Clicking this button tells the plugin to actually import the data from the file, based on the choices you have made above. KMyMoney will prompt you for the correct account into which to import the data.

### 16.5.3.8 Make QIF File

This button gives you the ability, after the import has been completed, to save the data from the csv file as a qif file, should you require one for any reason. This was actually the original functionality that drove the creation of this plugin. However, as KMyMoney itself is now able to export a qif file, the capability is now probably of little use and is likely to be removed eventually.

### 16.5.3.9 Finishing up

For a **Banking** import, the plugin has finished, and KMyMoney will prompt you, as stated above, for the correct account into which to import the data. For an **Investment** import, however, a little more may be required. If, during import of a transaction, the plugin finds no valid transaction type, it will display the offending transaction, and the user may select a valid type to substitute, depending on the combination of quantity, price, and amount values. For every transaction, the plugin will validate the column contents to ensure they match the action type. For instance, if a quantity appears but no price or amount, it is assumed that the transaction can be only an Add or Remove Shares. Or, if there is an amount but no quantity or price, then a Dividend is assumed, etc..

If you wish to save your settings, remember to click the Finish button, and the plugin will then close.

### 16.5.3.10 Adding Investment Activity Types

If you find that your investment statements keep including activity types that are not recognized, just add them to the section in the resource file. (See below for more details on this file.) For instance, in the [InvestmentSettings] section of the file, the BuyParam field includes entries for Purchase, Buy, New Inv, and Switch In. If you find a different one, add it to the correct list and restart the plugin. You may notice that there are similarities in the entries in different fields, and you may find that the wrong activity type is being selected. The plugin checks these lists in the following order: Shrsin, DivX, Reinvdiv, Brokerage, Buy, Sell, Remove. Re-ordering the lists to suit this does not work as might be expected, since the entries in the resource file get sorted into alphabetical order. If the offending parameter is one you don’t need, just delete it from the file. If that is not possible, you may need to edit your file before input.
16.5.3.11 Configuration of CSV importer plugin

A well-known drawback of QIF format is that it is a fairly loose format. With CSV files, there is this same problem, only more so, in that there is no agreed standard at all. With investment files, in particular, there is much more scope for variation in specifying the different types of activities represented in the data. The plugin handles this by listing these activity types in a resource file, called csvimporterrc. The location of this file depends on your distribution. It will usually be located in ~/.kde4/share/config/, or in ~/.kde/... instead. Using this resource file allows the user to add an activity type that the developer had not encountered. If the file does not exist when the importer first runs, the plugin will create a default version, containing a few of the more obvious descriptions.

A number of sample csv files are provided (in the kmymoney/contrib/csvimporter/ folder in the source tree) in the hope that they may help. For example, in the investment sample, an activity type is “ReInvestorContract Buy : ReInvested Units”. In the validation process, the first successful match is on the ReInv in ReInvestorContract Buy, so the transaction therefore gets classed as Reinvdiv, even though Buy also is mentioned. Another example which has been observed is an activity type of Reinvest even though the transaction included neither price nor amount, but only a quantity, so that needed to be treated as Add Shares, or Shrsin.

When this plugin was created, only a few investment formats had been seen as examples, and it may well be that you will encounter one which cannot be handled correctly. If you find such a file, please send a suitable example (edited to remove or replace personal information) to the KMyMoney user list kmymoney@kde.org or developer list kmymoney-devel@kde.org, the developer will do his best to modify the plugin to handle it.

16.6 CSV Exporter

To export one of your accounts to a CSV file, choose the Export → CSV from the File menu. You will be prompted for some options.

![CSV Export dialog](image)
16.7 Writing Importer Plugins

KMyMoney contains explicit support for importer plugins. If you have a custom format, and you would like to write an importer plugin, we would value your contribution. To do so, you'll need to compile the program from source. Then use the OFX Importer Plugin as an example.
17.1 Understanding Loans

This section provides an overview of how KMyMoney handles loans. Loan regulations and customs vary from locality to locality. For detailed explanations of loans, as well as information on local regulations and customs, please see other resources.

A loan is an agreement under which a borrower receives money from a lender and agrees to repay the money at some future date. KMyMoney allows you to track loans by which you, as borrower, borrow money from or, as lender, lend money to someone else. Most individuals borrow more than they lend, so you will generally be the borrower and a finance company will generally be the lender. If you lend money to a family member or a friend, you can use KMyMoney to keep track of this loan as well.

This guide will assume that you are borrowing from some sort of finance company, but the topics discussed here apply equally well to loans that you might make to a person. The main difference between borrowing and lending money is that an expense category is used to keep track of interest when borrowing money and an income category is used to keep track of interest when lending money.

**Loan Principal** The amount that is lent out is called the ‘loan amount’ or ‘principal’.

**Term** The period of a loan is called its ‘term’ of the loan. At the end of the term, the entirety of the principal will have been returned to the borrower. Terms are generally expressed in weeks, months, or years. A term can also be expressed by the number of payments. For example, a one year loan with weekly repayments could be described as a one year loan or a loan with 52 repayments.

**Repayments** The repayment of the principal to the lender is generally not done as a lump sum. Instead, a series of repayments are made, each representing a portion of the principal. Such repayments are sometimes known as ‘amortization payments’ and in KMyMoney ‘Amortization’ is defined as the act of paying off a loan in installments.

**Payment Frequency** The frequency of installments is referred to as ‘Payment Frequency’ in KMyMoney. Examples of period might be weekly, bi-weekly, monthly, quarterly, or yearly. In the US, periodic payments are most commonly made every month, therefore the loan’s period is one month.

**Interest Rate** For the privilege of being able to use the money, the borrower will pay the lender a fee called the ‘interest’, normally expressed as a percentage of the amount of the principal over...
a defined period. Interest rates can be fixed, where the interest rate does not change over the lifetime of the loan, or variable, where the interest rate can change over time. Typically, interest payments are included with each periodic repayment.

**Periodic Repayments** Since these repayments are generally made on some sort of scheduled basis, such as weekly, monthly, quarterly, or yearly, they are referred to as ‘periodic repayments’. The sum of all periodic repayments plus the final repayment will add up to the loan principal plus the interest.

**Fees** There may be other fees besides interest that are required to be paid with every installment. These are called ‘recurring fees’. Examples of recurring fees include (but are not necessarily limited to):

- ‘Impound’ or ‘escrow’ account payments. (Payments of this sort are commonly used to hold funds to pay annual or bi-annual property taxes.)
- Mortgage insurance
- Disability insurance
- Loan account maintenance fees

**Summary** In summary, the borrower receives a lump sum from the lender at the start of the loan. The borrower makes a periodic payment to the lender. The periodic payment is the sum of the principal payment (which is used to pay down the balance of the loan) plus the interest payment (which rewards the lender for allowing the use of the money by the borrower) plus any recurring fees (which cover any incidentals.) At the end of the loan, the borrower has paid back the entire principal.

### 17.2 Example

For an example, you might borrow $25,000.00 for a new auto and agree to pay the bank one payment each month for 60 months. The interest rate on the loan might be 5.5%.

In this scenario, the loan amount is $25,000.00. The term of the loan is 60 months or 5 years. The term of the loan could also be described as 60 payments since there will be one payment per month for 5 years. The repayment frequency is one month since periodic repayments will be made once a month. The periodic repayment, which is calculated by KMyMoney, would be $477.53.

A ‘loan schedule’ is a chart or table that shows the date that a repayment should be made and the amount of each periodic repayment. Often, these schedules break the periodic payment down into its constituent parts: the principal repayment, the interest payment, and the recurring fees payment.

### 17.3 Creating a New Loan

In KMyMoney, a loan is a type of account. Therefore, to create a new loan, you begin by selecting **Account → New Account**. Continue by answering the questions that the wizard poses to you.

Optionally, a loan can be associated with a particular institution. If you are borrowing from a mortgage company or a car loan company, you could create an institution entry that describes this firm and associate the institution with your loan. If you are borrowing from your Uncle Ted, there is no requirement to set up an institution.
17.4 Making Extra Principle Repayments On Loans

If you would like to make an extra principal repayment, you can do so. Simply enter a transaction using the ledger. This extra repayment of principal will be taken into account for the interest calculation that happens for the next periodic payment.

Examples of extra principal payments include (but are not necessarily limited to):

- Contributing an extra $50 a month
- Doubling the periodic principal repayment for every period. (The principal repayment can be found for any particular period by referring to the loan schedule.)
- Making a 13th principal repayment every year. (This assumes a loan that is repaid in monthly installments.)

Note: If you are doubling the principal repaid with every periodic payment, you will need to recalculate the loan schedule for each installment. This will allow there to be an accurate value for the required principal repayment with each installment.
Chapter 18

Budgets

18.1 What is a budget?

A budget is a categorized list of expected income and expenses for a period.

The Budget facility of KMyMoney allows you to create annual budgets. More than one Budget can be created for any year. You set monthly Budget values against any Income or Expense categories that you have defined. The values can be set in three ways, depending on the Period:

Monthly
   (Default) specify a single value applied to every month in the Budget

Yearly
   specify a single value to divide evenly across each month in the Budget

Individual
   specify separate values for each month.
   This is used for income and expenses spread irregularly through the year.

KMyMoney provides a number of reports which compare actual income and expenses against the entered Budgets. These are described in more detail in another section.

18.2 Your budgets

You can access your budgets by clicking the appropriate icon in the navigation pane at the left hand side of your KMyMoney window.

There are two major sections to the budget window. These are described in more detail below. On the left, the main section displays the list of budgets you have created. Above that are buttons for creating, renaming, and deleting budgets. On the right, there are three sections. At the top is the Accounts List. At the bottom is a display of the amounts assigned to the budget for the category selected in the Accounts List above. Between those two areas are some additional controls for managing the budget.
18.2.1 Viewing, creating, renaming, and deleting budgets

This section of the Budgets window displays the list of Budgets contained in the current KMyMoney file. If no Budget has yet been created the list will be empty. The list of Budgets has two columns:

Name
   Name of the Budget

Year
   Fiscal year of the Budget. Note that the starting month and day of the fiscal year can be specified in the Configure KMyMoney dialog.

Values from the selected Budget are displayed to the right. To select a different Budget you can click on the Budget in the list. Alternatively, when the list has focus, you can select a different Budget using the up and down keys. If you have made changes to a Budget and then select a different budget KMyMoney will ask you whether you want to save or discard the changes.

There are three buttons above the list of Budgets.

New
   Create a new, empty budget. The default name of a new budget is “Budget <year>” where <year> is the current fiscal year.

Rename
   Edit the name of the selected Budget.
   You can also edit the name of a Budget by double-clicking on the name of a Budget in the list.

Delete
   Delete the selected Budget

Additional options are available on a menu accessed by right-clicking on a Budget.

New Budget
   Create a new, empty Budget.

Rename Budget
   Rename the selected Budget.

Change budget year
   Displays a window with a list of years to select a different fiscal year for the budget.

Delete budget
   Delete the selected Budget.

Copy budget
   Creates a copy of the selected Budget. The new Budget has the name “Copy of <budget>“, where <budget> is the name of the copied Budget.

Budget based on forecast
   Fills in budget amounts based on data from KMyMoney’s Forecast values. See the section on Forecasts for more information.
18.2.2 Account List

The Accounts List displays the list of Income and Expense Categories. (Remember, within KMyMoney, categories are treated as a special type of account.) As in other places in KMyMoney, the list is organized in a tree structure. The list can be expanded or collapsed to show or hide Subcategories within a Category. The Accounts List has a number of columns:

**Account**
- Account (Category) name

**Type**
- Category Type (Income or Expense)

**Total Balance**
- Current balance of Account. This will be blank for Categories, unless the Category is defined in a foreign currency. In this case, Total Balance will show the value for the Category in its defined currency.

**Total Value**
- Total yearly value in the Budget. If a Category has Subcategories and the Category’s list of Subcategories is collapsed the value displayed is the sum of the values for the Category and all of its Subcategories. If a Category is defined in a foreign currency, the Total Value will show the value in the base currency.

Below the Accounts List are several controls. The Update and Revert buttons are described further below. The collapse and expand buttons collapse or expand the entire Accounts List.

The Accounts List can be filtered in two ways. Checking the “Hide unused categories” checkbox hides any Categories for which no value has been assigned to the Category or any of its Subcategories. To the right of this, is an unlabelled text box. Only categories which include whatever is typed in this box are listed, but their parent categories are also listed.

Note that changing either the “Hide unused budget categories” or the filter value is likely to change the list of Categories display. You may need to re-expand the list to see all the Categories that should be displayed with the current settings.

18.2.3 Assignments

The Assignments area shows the values for the Category selected in the Accounts List.

**Account**
- Displays the name of the selected Category. If the Category is a Subcategory, its full name is displayed in the Category:Subcategory format.

**Total**
- Displays the total yearly value assigned to the Category

**Include subaccounts**
- If this is checked, then Reports show actual income or expenses in Subcategories belonging to the Category against the Category instead of the Subcategory.
- If a Subcategory has a value defined in the Budget, then the income and expenses are shown against the Subcategory.
- If the Category selected in the Accounts List has its Subcategories collapsed, although its Total Value will show the sum of the Total Values for all its Subcategories, the amounts in the Assignments area may still show 0, unless this box has been checked or an amount has explicitly been assigned to the Category.
In general, for you will either check this box and assign values to the Category and not to any of its Subcategories, or not check the box, and assign values to the Subcategories but not the Category. If any Subcategories have assigned amounts when this box is checked, then those amounts are rolled up to the Category.

Clear

The Clear button resets the budgeted category value or values to zero.

Period

The Period radio buttons allow you to select the period for which the value applies

- **Monthly**
  A single value is entered, specifying the amount per month. This is the default setting.

- **Yearly**
  A single value is entered, specifying the amount per year.

- **Individual**
  Values are specified for each Calendar month. This is used where expense or income is spread irregularly through the year.

If a value is or values are already specified and the Period is changed KMyMoney will ask whether to use the current total yearly value to assign the new values.

18.2.4 Update and Revert

For performance reasons, changes made to a Budget are not saved immediately. Instead, they must first be stored using the Update button and then permanently saved using the KMyMoney Save.

When a Budget’s values are first modified, the Update and Revert buttons are enabled. Multiple changes can be made to the Budget. Pressing Update will store the changes and disable the Update and Revert buttons.

The KMyMoney Save only saves changes that have been stored using the Update button. Thus, if you have modified a Budget but not yet stored the changes KMyMoney Save will not affect the modified Budget and the Update and Revert buttons remain enabled.

Revert undoes any changes made to a Budget since the last Update and disables the Update and Revert buttons.

Changes stored using Update but not yet saved using KMyMoney Save can only be reverted by reloading the KMyMoney file.

18.3 Budget Reports

KMyMoney provides a number of reports to compare actual income and expenses against a Budget. These are listed in Reports under “Budgeting”. There are two types of Budget Reports:

**Budget only**

These reports display values from a Budget.

- **Monthly Budget**
  Displays the monthly values from a Budget.

- **Yearly Budget**
  Displays the monthly values from a Budget, with yearly total.
Budget vs. Actual

These reports compare values from a Budget to actual income and expenses. In each budget report you can find the columns Budget, Actual, and Difference. Each report differs in the period that is shown.

**Budget vs. Actual This Year**
From the beginning of the year until today

**Budget vs. Actual This Year (YTM)**
From the beginning of the year until the last day of the previous month

**Monthly Budgeted vs. Actual**
From the beginning of the year until the last day of the current month

**Yearly Budgeted vs. Actual**
From January 1st until December 31st

**Yearly Budgeted vs. Actual (Graph)**
Same as the previous report but it shows the graph by default

These reports provide a base from which custom reports can be created by changing the date range and Budget, among other options.
Chapter 19

Forecast

Colin Wright
2010-07-25
4.5

19.1 What is a Forecast?

In KMyMoney, a Forecast is a prediction of the balances of Accounts during a specified future period of time.
Forecasts can be predicted using one of two methods.

Scheduled and Future Transactions
KMyMoney uses a combination of future transactions already entered into the ledgers and the entries in the Schedule.

History-based
KMyMoney uses values from past transactions in the ledgers to predict future transactions.

The forecast method and forecast period can be set in the KMyMoney Settings, in the Forecast pane.

KMyMoney Forecast provides a summary, showing the predicted balances at account cycle dates and the expected difference between the starting and ending balances. The length of the account cycle can be set by the user. The summary also displays messages about significant predicted changes to the accounts during the forecast period.

As well as the summary, KMyMoney Forecast also allows you to view day-by-day balances and view the minimum and maximum balances for each forecast account cycle.

By default the Forecast is created for 90-days, with 30-day account cycles using Scheduled and Future Transactions.

19.2 Viewing Forecasts

You can view a Forecast by clicking the appropriate icon in the navigation pane at the left hand side of your KMyMoney window.
The Forecast window is split into five tabs
19.2.1 Summary Tab

The Summary tab is split vertically into two halves.

19.2.1.1 Account Summary

The Account Summary contains a grid displaying a row of information for each Asset and Liability.

The following columns are displayed:

**Account**
- The name of the Asset or Liability account

**Current Balance (Current)**
- The current balance of the account is displayed.

**Account Cycle Balance**
- The Forecast period is split into account cycles. The default account cycle length is 30 days, but can be set by the user.
- The first account cycle date is the first Forecast date. By default this is the current date plus one account cycle, but can change depending on the “Day of Month to start Forecast” setting.
- Remaining account cycle dates are determined by adding the account cycle length to the previous account cycle date. This is continued until the calculated account cycle date would be beyond the Forecast period.
- For each account cycle date the predicted balance is displayed.

**Total Variation**
- The rightmost column displays the predicted difference in value between the balances at the start and end of the forecast. If the predicted end value of the account (in terms of net worth) is less than the start value the whole row is highlighted in red.

19.2.1.2 Key Summary Information

The bottom half of the Summary tab displays noteworthy information about accounts. This includes:

**Assets below zero**
- A message is displayed for any asset for which the value starts or will drop below zero during the forecast period.

**Liabilities above zero**
- A message is displayed for any liability for which the value starts or will rise above zero during the forecast period. Note that the value of a liability is the negative of its ledger balance, since a positive balance indicates money owed.
19.2.2 Details Tab

The Details tab contains a grid displaying a row of information for each Asset and Liability.

Account
The name of the Asset or Liability account

Dates
For each date in the Forecast period a column displays the predicted balance of the account on that date. The date columns are in ascending order from left to right.

Total Variation
The rightmost column displays the predicted difference in value between the balances at the start and end of the forecast. If the predicted end value of the account (in terms of net worth) is less than the start value the whole row is highlighted in red.

19.2.3 Advanced Tab

The Advanced tab contains a grid displaying a row of information for each Asset and Liability. The information is split into columns as follows:

Account
The name of the Asset or Liability account

Minimum Account Cycle Balance
For each account cycle number \(<n>\) in the Forecast period the following columns are displayed:

Minimum Balance (Min Bal \(<n>\))
The minimum predicted balance during the account cycle

Minimum Balance Date (Min Date \(<n>\))
The date on which the balance reaches its predicted minimum.

Maximum Account Cycle Balance
For each account cycle number \(<n>\) in the Forecast period the following columns are displayed:

Maximum Balance (Max Bal \(<n>\))
The maximum predicted balance during the account cycle

Maximum Balance Date (Max Date \(<n>\))
The date on which the balance reaches its predicted maximum.

Average
The average balance of the account during the forecast period

19.2.4 Budget Forecast Tab

The Budget tab displays a forecast calculation for the Income and Expense categories. The columns are similar to the Summary and Detailed tabs.

19.2.5 Chart Tab

It displays a chart showing the forecast. The level of detail varies depending on the detail level selected on the option above.
Chapter 20

KMyMoney Settings

Roger Lum
2014-08-30
4.7.01
The settings described below modify the behavior of KMyMoney. These settings can be changed through Settings → Configure KMyMoney....

20.1 General

20.1.1 Global options

Price Precision
Enter how many digits of precision your prices will have after the decimal point. For example, setting this to 2 will result in prices like 35.18, where setting it to 4 might cause the same price to show 35.1791

Autosave periodically
Check this box if you wish KMyMoney to autosave your files periodically. The default is 10 minutes.

Your fiscal year starts on
Enter the starting day and month of your fiscal year

20.1.2 Views options

Startup
Choose the initial view upon startup.
- Start with home page
- Start with last selected page

Show titlebar on each page
Whether the title of the current view should be displayed on each page.

Synchronize account selection of ledger and investment view
If this option is selected, selecting an account on the investments view will change the account selection on the ledger view, and vice versa.
20.1.3 Filter options

Do not show unused categories
  Hide unused categories.

Do not show closed accounts
  Hide closed accounts.

Show equity accounts
  Equity accounts are normally hidden. Select this option to show them.

Do not show finished schedules
  Hide finished schedules.

Do not show transaction prior to
  Hide transactions prior to the selected date.
  Setting this option to January 1, 1900 is a good way to debug date-related file import problems.

Do not show reconciled transactions
  Filter transactions by reconciliation state. Transactions that are marked as Reconciled will not be shown.

20.2 Home

These options allow you to customize the appearance of the Home page by choosing which entries to show on the Home page and the order in which they appear.

Assets and Liabilities
  It shows the balance of all your assets and liabilities

Payments
  It shows the first 5 occurrences of your scheduled transactions

Preferred accounts
  It shows the balance and credit of your favorite accounts

Payment accounts
  It shows the balance of your asset and liability accounts, except for the investment accounts

Favorite Reports
  It shows a list of your favorite reports

Forecast (schedule)
  It shows a forecast for your asset and liability Accounts

Net worth forecast
  It shows a chart of your forecast net worth for the next 90 days

Budget
  It shows the budget items for the current month which have a negative difference compared to the actual income or expense
CashFlow
   It shows an analysis of your cash flow for the current month

Percentage of default font size
   Select the size of the font on the Home page

Remember font size when leaving the program if manually changed with mouse-wheel
   Selecting this will save your font size preference if you have changed it from the Home page by using the mouse-wheel

Show account limit information
   Shows the limit of the accounts on the Payment Accounts and Preferred Accounts sections of the Home page

Show balance-status of mapped online accounts
   Shows the balance-status of mapped accounts on the Assets and Liabilities Summary, the Payment Accounts and the Preferred Accounts sections of the Home page. The balance-status is symbolized by an icon in the columns preceding the account names. A green checkmark is displayed when online-balance and local file balance are in sync. If the local file has transactions newer than the previously online-updated ones a mailbox with a green arrow gets shown. This alerts the user to start an online-update. Mismatching local file and online-balances are highlighted by a red warning sign.

Show number of not marked transactions per account [!M]
   Insert an additional column between account name and current balance showing the number of not marked transactions for the accounts on the Assets and Liabilities Summary, the Payment Accounts and Preferred Accounts sections of the Home page

Show number of cleared transactions per account [C]
   Insert an additional column between account name and current balance showing the number of cleared transactions for the accounts on the Assets and Liabilities Summary, the Payment Accounts and Preferred Accounts sections of the Home page

Show number of not reconciled (not marked + cleared) transactions per account [!R]
   Insert an additional column between account name and current balance showing the number of not reconciled transactions (i.e. the sum of all not marked and cleared transactions) for the accounts on the Assets and Liabilities Summary, the Payment Accounts and Preferred Accounts sections of the Home page

20.3 Ledger

These options allow you to modify the behavior of the transaction registers.

20.3.1 Display tab

Show a grid in the register
   Show grid lines in the transaction register.

Use the ledger lens
   With this option enabled, the ledger will show all lines of detail for the transaction you have currently selected, even if you have set the Show Transaction Detail menu option turned off.
Show transaction form
Show the transaction form at the bottom of the transaction register for entering and editing transactions. With this option turned off, you edit the transaction within the register itself.

Always show a No. field
Always have the number (‘No.’) field when entering or editing a transaction.

Show group header between transactions
Display group headers in the register

Show header for the previous and current fiscal year
Display group headers for the current and the previous fiscal year

20.3.2 Sorting tab

20.3.2.1 Normal view tab
Choose the sort order of the ledger while in the Normal view.

20.3.2.2 Reconciliation view tab
Choose the sort order of the ledger while in the Reconciliation view.

20.3.2.3 Search view tab
Choose the sort order of the ledger while in the Search view.

20.3.3 Data Entry tab

Insert transaction type into No. field for new transactions
Automatically place the type of the transaction, e.g., Deposit, Withdrawal, etc., in the No. field.

Auto increment check number
Have the check number automatically increment whenever entering a new check transaction.

Keep changes when selecting a different transaction/split
When enabled, selecting a different transaction or split will save edits to the current transaction.
When disabled, selecting a different transaction will cancel them. Instead, you must explicitly accept the changes.

Use Enter to move between fields
When enabled, pressing Enter will change the focus to the next field of the transaction form.

Match names from start
Mark this option if you always want to match names e.g., for payees from the start. If unset, any substring is matched

Default reconciliation state
Select the default reconciliation state for new transactions.
Autofill
Select the desired behavior for autofill or deactivate it

- No Autofill
- Same transaction if amount differs less than X percent
  When entering a new transaction with this option, KMyMoney will display a list of previous transaction for the payee and account. If previous transactions differ in less than X percent, they will be considered identical. If the percentage is 0, all previous transactions for the payee and account will be displayed. When selecting a transaction, all transactions details except the date will be autofilled with those of the selected transaction.
- With previously most often used transaction for the payee
  When entering a new transaction with this option enabled, KMyMoney will fill in all the transaction details based on the previously most often used transaction with the selected payee.

20.3.4 Import tab

Match transaction within days
Search for matching transactions within the range of the imported transaction +/- given days

Ask for a new payee’s default category
Whenever a new payee is detected during an import, the user will be asked for the default category for the payee.

20.4 Scheduled Transactions

These options allow you to modify the behavior of the scheduling features.

20.4.1 Schedule startup options

Check schedules upon startup
Enables checking the schedule upon startup of KMyMoney.

Enter transactions this number of days in advance
Specify how many days in advance should the scheduled transactions be entered.

Number of days to preview schedules in ledger
Specify how many days should the schedules show up in the ledger. The scheduled transactions will be listed in the ledger. You can enter or skip the scheduled transactions by right-clicking on them.

20.5 Online Quotes

These settings modify how online quotes are retrieved from different online sources.
This tab allows you to change the online quote sources for KMyMoney. Generally speaking, this is an advanced feature, and should only be attempted by the most technically adept users.
For more details, please refer to the Online Price Quotes section.
20.6 Forecast

These options allow you to modify how the forecast is calculated.

**Number of days to forecast**
Select how many days you want to forecast. The default is 90 days.

**Number of days of account cycle**
The normal number of days that your commonly-used accounts go through an income-expense cycle. For example, if you receive your salary on a monthly basis, you should select 30 days here.

**Day of month to start forecast**
Select the day of the month when you want to start the forecast. This would usually be the day when you receive your salary or other income.

**Forecast Method**
The forecast method to be used.
Scheduled and future transaction forecasts your balance based on the information of your scheduled and future transactions.
History-based uses your past transactions to extrapolate a forecast.

**Number of cycles to use in forecast**
If using a history-based method, how many previous account cycles should KMyMoney use to calculate the forecast.

**History forecast method**
Select the method to use when calculating a forecast based on historic information
Simple moving average averages your past transactions to calculate a forecast.
Weighted moving average averages your past transactions, but it will give more importance to the most recent transactions.
Linear regression uses a linear-regression formula based on your past transactions to calculate the forecast.

20.7 Encryption

These options allow you to modify the data encryption settings.

**Use GPG encryption**
Enables the use of GPG to encrypt data file. See the section on GPG Encryption for more details.

20.7.1 GPG Encryption

**Your key**
Enter the email address or the hexadecimal key id to use for data encryption.

**Additional keys**
Select additional keys to use for data encryption.

**Also encrypt with kmymoney-recover key**
Encrypts data with the KMyMoney recover key. Selecting this option will allow core KMyMoney developers to decrypt your data file in case you lose your encryption key.
20.8 Colors

These options allow you to change colors within KMyMoney.

20.8.1 Foreground tab

Modify any of the foreground colors by clicking on the color button and opening a color select palette.

20.8.2 Background tab

Modify any of the background colors by clicking on the color button and opening a color select palette.

Note the Use system colors checkbox at the top of the tab. If this is checked, KMyMoney uses colors provided by the system, such as those associated with a selected theme, although the details depend on which operating system and possibly which window system or display manager is running. Very often, if you experience odd colors or odd combination of colors, toggling this checkbox will help.

20.9 Fonts

These options allow you to modify the fonts.

Use system fonts
Select this to use system fonts. Deselecting this option allows you to customize fonts.

Cell font
Specify the custom font to use within each cell.

Header font
Specify the custom font to use for the headers of each view.

20.10 Plugins

These options allow you to modify the behavior of any installed plugins. Note that the list of plugins displayed will depend on which plugins KMyMoney found when it started. It does not matter whether the plugin was compiled as part of the application or added as a separate package.
For most plugins, the only choice is to enable or disable it, as indicated by the checkbox next to the name of the plugin. In addition, there is also an information button for each, which will show the plugin version and author. Further information on configuring and using these plugins may be found in the separate sections for CSV Import and OFX Import plugins. It is also true for the Reconciliation report, although that report is only a minor part of the larger reconciliation process. The one plugin that does require a configuration step is the Print Check plugin.

20.10.1 Print check plugin

This plugin is included with the source of KMyMoney, and should always be enabled. It allows printing of a check based on the data from a selected transaction, with the layout controlled by an html template. You need to use a template which is matched to your pre-printed checks. When you click on the configure button, the Print check configuration dialog is displayed. At the top is a text box for the path to the selected template. To the right of that is a button which brings up a file chooser, to select an alternative template file.

A template file is an html file, in which specific strings are used to reference the fields from the transaction and from the current account and institution to show where they will be printed on the check. KMyMoney is shipped with some sample template files. You should either be able to use one of them, or modify one to suit your needs. When the default template is selected, the configuration dialog will show you the directory which contains the sample files.
Chapter 21

Search Transactions

Darin Strait
2010-07-25
4.5

21.1 General

The Search Transactions dialog searches your data based on criteria that you specify. You can access the dialog by going to the Edit menu and selecting Find transaction....

There are two main tabs in this dialog. The ‘Criteria’ tab displays a number of sub-tabs for specifying the search criteria.

The results will be displayed under the ‘Result’ tab after the search has completed. Below the list of results, KMyMoney shows the number of transactions that met the search criteria. Double-clicking on an individual transaction in the result list will bring up the appropriate ledger and display the transaction.

When the Find button is pressed, the search is initiated and all criteria that have been entered on any tab will be taken into account.

The Reset button resets all of the fields on all of the criteria sub-tabs back to the defaults. This allows you to specify new search criteria.

The Close button closes the Search Transactions dialog box.

21.2 Search Criteria

There are several sub-tabs under the main ‘Criteria’ tab, each of which allows you to specify different types of search criteria. Below the area for specifying the criteria, KMyMoney lists each of the different types of criteria that are currently specified for the search.
21.2.1 Text

This tab allows you to specify text to search for. There are also two check boxes that control how the text is used in the search.

By default, this will match on simple substrings. For example:

- ‘Best’ will find ‘Best Cakes, Inc.’
- ‘est’ will also find ‘Best Cakes, Inc.’

In the dropdown field next to the text field, select **Contains** if you want to find transactions that contain the text, or select **Does not contain** if you want to find transactions that do not contain the specified text.

If you check the **Case Sensitive** box, the search will be case sensitive. For example, ‘best’ would not find ‘Best Cakes, Inc.’ if this option is set.

If you check the **Treat Text as regular expression** box, the text will be treated as a regular expression. For details on how to craft a regular expression, visit the Qt™ documentation about the QRegExp class.
21.2.2 Account

This tab allows you to specify the accounts that should be searched. Accounts are displayed in a tree format. Accounts that are marked for search are indicated with a check box. If you click the All button, all accounts are marked for searching. If you click the None button, no accounts will be marked for searching. Individual accounts can be marked or unmarked by clicking on the box next to the account name using the left mouse button. A complete hierarchy of accounts can be marked or unmarked by clicking on the box using the right mouse button.
21.2.3 Date

This tab allows you to specify which dates should be searched.

The ‘Range’ control provides a convenient way to set the From and To controls. The From and To controls can be manipulated individually. Dates can be entered manually. The controls will prevent you from entering non-existing dates. Date values can also be changed by clicking on the up and down arrows when a particular part of a date is highlighted. Clicking on the small calendar icon will bring up a calendar to easily select dates.
21.2.4 Amount

This tab allows you to specify what amounts should be searched for.
You can search for an exact amount or for a range of amounts. If you click on the calculator icon, a small on-screen calculator will pop up to assist you in entering a value.

21.2.5 Category

This tab allows you to specify which categories should be searched.
Categories are displayed in a tree format. Categories that are marked for search are indicated with a box. If you click the **All** button, all categories are marked for searching. If you click the **None** button, no categories will be marked for searching. If you click the **Income** button, income categories will be marked and expense categories will be unmarked. If you click the **Expense** button, income categories will be unmarked and expense categories will be marked.

Individual categories can be marked or unmarked by clicking on the box next to the category name using the left mouse button. A complete hierarchy of categories can be marked or unmarked by clicking on the box using the right mouse button.

### 21.2.6 Payee

This tab allows you to specify which payees should be searched.

Payees that are marked for search are indicated with a box. If you click the **All** button, all payees are marked for searching. If you click the **None** button, no payees will be marked for searching. Individual payees can be marked or unmarked by clicking on the box next to the payee name.

If you check the **Select transactions without payees** box, only transactions with no payee will be selected.

### 21.2.7 Details

This tab allows you to specify various additional search criteria.
TYPE CAN BE ONE OF THE FOLLOWING:

- All Types
- Payments
- Deposits
- Transfers

STATE CAN BE ONE OF THE FOLLOWING:

- All states
- Not reconciled
- Cleared
- Reconciled

VALIDITY CAN BE ONE OF THE FOLLOWING:

- Any transaction
- Valid transaction
- Invalid transaction

You can search for a particular transaction number or search for a range of transaction numbers.

### 21.3 Search results

The ‘Result’ tab displays the Date, Account, Details, Reconciliation status, Payment, and Deposit for each transaction that matches the search criteria you have entered. Right clicking on the header row of the results list allows you to alter the sort order of the results.

Double-clicking on a transaction will display the corresponding account ledger and focus on the selected transaction.
Chapter 22

File Formats

Thomas Baumgart
2014-08-30
4.7.01

Unless you choose to use a relational database, KMyMoney will store all your financial information in a file ending in .kmy. Also, unless you use a command line option that tells it not to do so, when you launch KMyMoney, it will open the last file it had open. However, it is important to know that there is more than one type of file KMyMoney can use to hold your financial data. This chapter describes the formats in which KMyMoney stores its data in permanent form on the user's storage device. In general, KMyMoney stores its information in form of an XML document. Depending on the actual format, this XML document will be written

- as a plain text file encoded in UTF-8,
- as a compressed file using GZIP compression,
- as an encrypted file using GPG encryption, or
- as an anonymous plain text file encoded in UTF-8 but with all your personal data scrambled.

22.1 Plain text file

This is the most space consuming format supported, as no compression is performed. It is not intended for normal use, and is provided to support debugging purposes and the capability to modify the file manually. If you end a filename in .xml, the file will be stored in this format.

**Caution**

Manual modification of the file is not recommended to the normal user, and should only be performed if the internal working of KMyMoney is fully understood or if instructions from the developers tell you what to do. Don't blame the KMyMoney developers if you screw up your data: You have been warned!

22.2 GZIP-compressed file

This is the normal format used by KMyMoney when you store a file with the extension .kmy.
NOTE
If encryption has been selected, the file will be stored encrypted.

If you want to look at the contents of a GZIP compressed file, rename it to a filename ending in .gz (e.g., rename myfinances.kmy to myfinances.kmy.gz), then use gunzip to uncompress the file and look at it. You don’t have to compress it before loading it into KMyMoney the next time, because KMyMoney can read the uncompressed data as well. Nevertheless, if you save it thereafter, it will be saved compressed again. Use the .xml extension to write it in uncompressed format.

22.3 GPG-encrypted file

Using the GPG-encrypted file format is a very secure method of storing your personal finance data on your storage device. When KMyMoney has been instructed through the settings dialog to store your data encrypted, it will cipher the data using GPG and the key you provided before actually storing it. When opening an encrypted file, you have to provide the passphrase necessary to open your keyring. The encrypted file itself will be stored in GPG’s ASCII armored format.

NOTE
When using GPG encryption, GPG also compresses the file, so no extra compression is necessary.

22.3.1 GPG-Keys

If you have not done so already for mail encryption, you need to generate a key-pair in order to use the GPG encryption feature of KMyMoney. Also, GPG must be installed on your system.

The details about how to generate a key-pair and how to take care of it are beyond the scope of this document. A Mini Howto on this subject can be found at http://www.gnupg.org/documentation/howtos.en.html.

22.3.2 Setting the keys in KMyMoney

On the encryption page of the settings dialog, there is a drop down list where you can select the key that should be used for encryption and decryption. Additionally you can find a field where you can enter the key-id of a key not in the listbox. You can use either the key-id, the email address associated with this key, or any other valid GPG key identification as the value for this field. When you enter the key-id, KMyMoney will check its validity and display a green LED icon in the dialog if a key is found.

CAUTION
Make sure you have both the public and the private key for this id. If you do not own the private key for the id entered, you will not be able to open the file again.

22.3.3 The KMyMoney recover key

Also on this page of the settings dialog you have the choice of selecting supplemental encryption with the KMyMoney recover key. This option is available to you if that key is stored in your GPG keyring. Selecting this option will allow you to recover your data even in the case you
lose your own private key. This is possible because the data is not only encrypted for your own key, but also for the KMyMoney recover key. This key is only available to selected KMyMoney developers (at the time of writing only to the author). As of the release of KMyMoney version 4.7, the recover key is set to expire on 3 January 2015.

Under normal circumstances, you will open/save/close your file as usual. In the abnormal case of loss of your key, you have the chance to contact one of the developers who has access to the KMyMoney recover key and request help to recover your data. You may contact the developers via email to the KMyMoney developer mailing list at kmymoney-devel@kde.org.

### 22.4 Anonymous file

This format is not intended to be used for normal data storage. It is supported so that in case of a problem, you can supply the KMyMoney development team with your file without disclosing any of the confidential details in your financial data. For example, it changes institution, account, payee, and category names to strings such as “I000001” and “A000001,” it makes similar changes to all data such as account numbers, and it also randomly changes the amounts of transactions.

If instructed by the developers, use the **Save as...** menu item to store your data in anonymous format by selecting Anonymous files as the filter. This also changes the file extension to .anon.xml.

To verify that your problem still exists, reload this anonymized file and try to duplicate your problem. If the problem is still present, send the file to the developer mailing list at kmymoney-devel@kde.org for further investigation. If the problem does not show ... well, I don’t want to think about this scenario right now.
Chapter 23

Database

Tony Bloomfield  
2011-07-21  
4.6

23.1 Using relational databases

23.1.1 Introduction

As of release 1.0, KMyMoney allows you to hold your data in a relational database. One of the advantages of using this industry-standard format is that it may allow you to view your data using one of the graphic front ends such as OpenOffice.org® or LibreOffice®, perhaps in some format that KMyMoney currently doesn’t provide. Also, a little knowledge of SQL (Structured Query Language, the language used world-wide to access relational databases) should enable you more easily to export data to an external program, for example, a budgeting application.

23.1.2 Preparation

To access the database, KMyMoney uses the SQL module supplied by Qt™ Software as part of their Qt™ programming system. This module supports a number of different database systems through a collection of drivers. Among the more popular open-source systems for which drivers are available are MySQL®, SQLite (version 3 and upwards only), and PostgreSQL. The module also supports the ‘heavier’, more industrial, systems such as Oracle® and IBM DB2®.

With the exception of SQLite, these systems use a client/server model, where the ‘client’ software sits on ‘your’ machine, while the server lives on the same machine as the database itself, which may be elsewhere on a network. Of course, in the normal scenario for a personal finance application such as KMyMoney, ‘your’ machine acts as both client and server. Your first task therefore, having decided which database system you wish to use, is to install the client, and most probably server, software.

In addition to the database software itself, you must also install the corresponding Qt™ driver module. Most distributions will include driver modules for the more popular databases. Otherwise, check with the Qt software web site and search for ‘SQL drivers’
NOTE
SQLite does not operate on a client/server model; each database is held in a regular file, local or remote, accessed using the normal methods supplied by the underlying operating system. In this case, therefore, there is only one software package and the driver to install. Also, some of the following information, particularly that related to administration, may not apply to SQLite.

23.1.3 Administration

Looking after databases is a little more complex than dealing with regular files. Each system has different methods for performing those necessary administrative tasks such as creating databases, assigning permissions to various users, producing backups, etc. Describing these tasks is outside the scope of this manual, but all of the supported products provide comprehensive reference documentation, and a quick search of the web will point you at many tutorials on the subject.

23.1.3.1 Creating the database

Code has been included to create an initial database to hold your data if one doesn’t exist. However, it is strongly recommended that you pre-create a database, because most of the products provide a number of options which may be relevant. One that may be of particular importance to some would be the designation of the character set (e.g., UTF-8) to be used for text fields.

At this time, you will also need to specify permissions for various users to perform different operations on the database. In most systems, the user who creates the database will be automatically assigned all permissions, but this is an area in which the documentation should be consulted.

For your first use of the database, and occasionally at other times when the database layout changes, you will need permission (also called privileges) to create and alter tables and views (see next paragraph). There may be different names for the permission/privilege in different systems, but something like CREATE and ALTER should be commonplace. For normal running, you will need to be able to read and write records; these are normally defined in SQL as SELECT, INSERT, UPDATE, and DELETE permissions.

23.1.3.2 Creating Tables

On your first use, KMyMoney will attempt to create the necessary table structures. In order to achieve the maximum compatibility between various database types, only a subset of common data types are used. There may nevertheless be situations where a particular type is not supported, and in this case, provision has been made to generate the SQL code necessary to create tables. This code can then be modified as required and used to create the tables outside of KMyMoney. Should you find yourself in this situation, help can usually be obtained from kmymoney-devel@kde.org. See Manual Database Creation for more information.

23.1.4 Creating a Database

Using KMyMoney, open or import an existing data file, or create a new one. Then select Save as Database from the File menu. This will present the following dialog:
Complete the fields appropriate to the database type you have selected (as usual, mandatory fields will be highlighted) and click OK to create the database.

23.1.4.1 Database Type

This box lists all Qt™ SQL drivers installed on your system. Select the driver for your database type. If the one you want is not in the list, you need to install the appropriate driver. See your distribution documentation, or visit the Qt software web site and search for ‘SQL drivers’.

23.1.4.2 File (SQLite only)

SQLite has one database per file so enter the filename in which you wish to create the database. To browse the file system, click the icon to the right of the filename. For SQLite databases, the Host name, Username, and Password fields are not relevant. The SQLite file must have the appropriate read/write permissions set by the underlying file system to enable the appropriate access for the currently logged-in user.

23.1.4.3 Database name (others)

The default database name is KMyMoney, but you may choose some other name if you like. For some database types, KMyMoney may not be able to create the database, so it must be pre-created using the appropriate administrative procedure. However, KMyMoney will usually be able to create all table structures where necessary. If not, you can create them yourself. See Manual Database Creation for more information.

23.1.4.4 Host name

For the average user, the default name of ‘localhost’, being the machine you are currently using, is correct. For networked databases, enter the connected host name.
23.1.4.5 User name and password

Check the permissions set up on your database, or contact the database administrator, for the correct values to use here. The user name must be capable of selecting, inserting, updating, and deleting records. If the user name is the same as your login name, a password is not normally required.

23.1.5 Accessing your data

23.1.5.1 Table design

To access your data in KMyMoney, use the Open Database entry in the File menu. This will open a dialog similar to the above.

**NOTE**

If you created your database by first opening a file, and then doing Save as Database, as described above, then any subsequent changes to your data are saved only in the database, not in the file. This means that you can use the file as a backup or snapshot of your data at a particular time. To make a new backup like this, open your database, do File → Save As..., giving an appropriate file name. Remember to re-open your database, so KMyMoney does not continue to use the file.

To access your data in other formats, you will need to know a little about how it is held in relational databases. By far the easiest way to get a feel for this is to open the database in a front-end such as OpenOffice.org. This provides a list of the various tables which make up the database, and enables you to see the layout of each of them.

To extract data, e.g., into a spreadsheet or external file, it is almost invariably necessary to select linked data from more than one table. This is done by 'joining' the tables, using a field which is common to each. You can find a lot more information about how this is done from the online database tutorials mentioned above. The following table lists the fields used to define these inter-table relationships.

<table>
<thead>
<tr>
<th>Relationship</th>
<th>Match</th>
<th>With</th>
</tr>
</thead>
<tbody>
<tr>
<td>Institutions and Accounts</td>
<td>kmmInstitutions.id</td>
<td>kmmAccounts.institutionId</td>
</tr>
<tr>
<td>Accounts Parent/Child</td>
<td>kmmAccounts.id</td>
<td>kmmAccounts.parentId</td>
</tr>
<tr>
<td>Transactions and Splits (see Note 1)</td>
<td>kmmTransactions.id</td>
<td>kmmSplits.transactionId</td>
</tr>
<tr>
<td>Accounts and Splits</td>
<td>kmmAccounts.id</td>
<td>kmmSplits.accountId</td>
</tr>
<tr>
<td>Payees and Splits</td>
<td>kmmPayees.id</td>
<td>kmmSplits.payeeId</td>
</tr>
<tr>
<td>Schedules and Transactions</td>
<td>kmmSchedules.id</td>
<td>kmmTransactions.id</td>
</tr>
<tr>
<td>Transactions and Currencies</td>
<td>kmmTransactions.currencyId</td>
<td>kmmCurrencies.ISOCCode</td>
</tr>
<tr>
<td>Accounts and Securities (see Note 2)</td>
<td>kmmAccounts.currencyId</td>
<td>kmmSecurities.id</td>
</tr>
<tr>
<td>Securities and Prices</td>
<td>kmmSecurities.id</td>
<td>kmmPrices.fromId or kmmPrices.told</td>
</tr>
<tr>
<td>Currency Rates</td>
<td>kmmCurrencies.ISOCCode</td>
<td>kmmPrices.fromId or kmmPrices.told</td>
</tr>
</tbody>
</table>

Notes:
The KMyMoney Handbook

1 – txType = “N” for normal transactions, “S” for scheduled transactions
2 – if kmmAccounts.isStockAccount = “Y”

23.1.5.2 Field formats

Several of the data fields are held in an internal format which may not be immediately useful to external programs. In these cases, the information has been duplicated in both internal and external formats.

Monetary amounts and share values are shown both in numerator/denominator format, and, with a field name suffixed with ‘Formatted’, in the form as shown on your screens.

Similarly, some fields, such as account type appear both as a numeric code, and in a field suffixed ‘String’ in the form and language of the application.

23.1.5.3 Updating your data

Having data in an industry standard format does give you the ability to modify it outside the KMyMoney application. DO NOT DO IT unless you really know what you are doing, and always be certain to make a backup copy of your data first. If you get it wrong, KMyMoney may not be able to access your data, and you could even end up losing it altogether. You have been warned!

23.1.5.4 Stored queries

Most database systems allow you to store commonly used queries and procedures, and in some cases, these may be held as tables or other objects within your database itself. As you will have guessed from the above, all the tables used by KMyMoney begin with the lowercase letters ‘kmm’. This standard will be maintained, and only tables beginning with these letters will be updated. Thus, provided you avoid these in the naming of your queries etc., you should not experience any problems.

23.1.6 Manual database creation

NOTE
This section covers more advanced database usage and may be skipped by the general user.

23.1.6.1 When to use

There may be occasions when KMyMoney is unable to create the database automatically, or creates it without some options required by the user. For example, the database system used may not completely conform to standard SQL usage, or support may be introduced for new systems which have not been fully tested in KMyMoney.

Prior to using this facility, you should try just creating the database entry itself (i.e. with the CREATE DATABASE statement). Provided the database exists, KMyMoney may well be able to create the tables, etc. in the normal database save procedure described above.
23.1.6.2 Generating the SQL

If this fails, it is possible to generate the basic SQL commands needed to create the various tables, views and indexes required by the application. Select Generate Database SQL from the Tools menu. This will present the following dialog:

On selecting the database type, the appropriate SQL will appear in the SQL for creation text box; this can be edited by the user, or saved to a text file by clicking Save SQL. In the latter case, the database must be created using the administrative functions provided by the database system.

If after editing the text in the dialog, you want KMyMoney to create the database, you will need to complete the other fields in the dialog, as detailed in Creating a Database above, and click Create Tables. Note that, except in the case of SQLite, you will need either to include a suitable CREATE DATABASE statement as the first command, or have previously issued such a command externally to KMyMoney.

23.1.6.3 Warning

You should be very careful editing the definitions of any of the basic tables or views (those with names beginning with 'kmm'). Some changes, such as increasing the length of an integer field, may have little impact, but you should not remove or change the sequence of any fields, or KMyMoney may refuse to function, or may corrupt your data.

Whilst adding or removing indexes may improve performance, you should also be aware that the opposite may happen. Some knowledge of the internal operation of KMyMoney may help to get the best performance in these circumstances.

23.1.7 Encryption

Encryption of data in your database is not currently supported.
Chapter 24

Questions and Answers

Jack H. Ostroff
2014-08-30
4.7.01

This chapter addresses a number of issues that frequently cause confusion, especially in new users of KMyMoney. If you find that KMyMoney is doing something you don’t understand (or sometimes not doing something you want it to do,) please check this list before asking for help on one of the mailing lists. If your problem is not mentioned here, refer to the section on getting help.

Installation and Startup Questions

1. **KMyMoney crashes when I try to launch it.**
   
   There are many reasons KMyMoney might crash or give an error instead of starting up normally. You first need to determine if the problem is with the software or with your data. So, the first thing to try is to launch KMyMoney without opening your data file. If the application starts up, but crashes when you try to load your data file, try loading an older copy of your file. (You did make a backup, didn’t you?)

   If KMyMoney crashes on startup without trying to load a data file, there may be a problem with your installation. See the section on installing KMyMoney or the section on getting help.

2. **When I start KMyMoney I get a “Malformed URL” error. What’s wrong?**
   
   Usually the reason for this is that you didn’t run ‘make install’ as root. This step actually copies all of the icons, and other files needed by KMyMoney to run properly. If you did run this, make sure you passed the correct prefix to cmake at the beginning of your compile. See the section on compiling from source for more information.

3. **When I compile from source, all the icons show up as missing. What did I do wrong?**
   
   Usually the reason for this is that you didn’t run ‘make install’ as root. See the previous question/answer for more information.

4. **What options are useful to pass to cmake?**
   
   The most important option is -DCMAKE_INSTALL_PREFIX. This specifies where you want to install KMyMoney; it should be the same location where KDE is installed. In many distributions, cmake will find this location on its own, but if it can’t, you can use the command line tool kde4-config --prefix to read out what the prefix should be. For Red Hat®-based distributions, including Mandriva and Fedora, KDE is installed in /usr.
Another useful option is -DCMAKE_BUILD_TYPE. Normally this is not set, but if it is set to Debug, it will allow you to build KMyMoney with debug symbols, which help in trying to figure out crashes. This option is essential if you are a developer and want to contribute.

5. The Git version is broken! What do I do now?
   Usually the reason for this is that one of the developers made a change to the code that requires a clean reconfigure. See the end of the section on compiling from source for instructions. If you follow these steps carefully, and still have a problem compiling, please post a message to the KMyMoney Developers List at kmymoney-devel@kde.org, and include the failed output of either the cmake or make command.

6. I compiled from source, but the version number in the Help->About dialog no longer gets changed to show the latest git commit, like it used to?
   You probably ran $ make without running $ cmake or $ ccmake first. If you update the code, using $ git pull, one of those two commands is necessary to put the updated version number/git commit in the right place.

7. Will KMyMoney work on my X/Ubuntu™ desktop? Will KMyMoney work without a full KDE desktop?
   Yes, KMyMoney will work without a full KDE desktop, but you will have to install the basic KDE libraries first. The easiest way to do this is to use your distribution’s package management system, which will handle these requirements automatically. If you are going to install from source, you will probably need development versions of those libraries; refer to these instructions for details.

Configuration Questions

1. Can I change the start of the fiscal year, to match my tax year or accounting year?
   Yes, you can easily set the start of the year in the Global Options section of the Configure KMyMoney dialog.

Account and Transaction Questions

1. Why can’t I edit a transaction?
   You cannot make any changes to a transaction with a date before the opening date of the account it is in. The most common reason for this is importing all the data for an account. If the import file does not contain an opening date for the account, KMyMoney will use the current date. The way to fix this is to edit the account, and change the opening date to be earlier than any transaction in that account.

2. Why is a transaction shown in red and how can I get rid of the color?
   A transaction is shown in red if any part of the amount has not been assigned to a category. This is most commonly caused by importing a QIF or OFX file or by downloading statement data online. All you have to do is to modify the transaction such that the whole amount of the transaction is assigned to categories.

3. Why can’t I add an opening balance to an account?
   If you provide an opening balance when you create an account, it is shown as the first transaction for the account. If you do not, then the transaction is not there, and because it is a special type of transaction, you cannot simply add it as you could a deposit or withdrawal. However, you can add it later by editing the account.
4. When I created an account, I used the wrong type, and now it won’t let me change it. I can edit the account, but the dropdown for account type is either disabled, or does not list all the possible types.

You can easily change an account type between checking, savings, and cash. However, because of the way KMyMoney stores the account information, it does not allow other changes of account type. The way around this is to create a new account of the correct type, move all the transactions from the old to the new account, and then delete the old account.

5. I have a loan with 0% interest, but I get an error in the new loan wizard that does not let me use this value.

The internal calculations of the new loan wizard do not allow a 0% interest rate. The best way to handle this situation is to create a simple liability account with a starting balance for the amount of the loan, and then create a schedule for the required payments.

6. Why don’t I see all my transactions in the ledger?

There are several settings that control which transactions are displayed in the ledger view of an account. First, check the ledger filter area. If there is anything typed in the search box, only transactions containing that text will be shown. If the status dropdown has been changed from ‘Any status,’ then only transaction of the selected type will be shown. In addition, there are two important settings in the filter options section on the KMyMoney Settings dialog. If the Do not show transactions prior to field is set, only transactions on or after that date will be shown in the ledger. If the Do not show reconciled transactions box is checked, then no reconciled transactions will be shown.

7. I mistyped the name of a payee and want to change it in all transaction. Is there a global search/replace?

There is no global search and replace function in KMyMoney. Nevertheless, it is easy to change a payee’s name: select the Payees view and find the entry with the name you want to change. Click with the right mouse button on the payee, and select Rename payee. Enter the new name. Since the transactions only use a reference to the payee’s record, all transactions now show the new name.

8. Why can’t I delete an account?

In order to delete an account, KMyMoney can have no other references to it. That means you must delete all transactions, or move them to another account. If you still can’t delete an account, there may be scheduled transactions referring to that account, which may not be visible in the ledger. You need to delete any future transactions and the schedule itself, or switch them to a different account.

Import and Export Questions

1. Where do I find some more information about OFX parameters?

Here are some external sources which might give your more information: ofxblog and ofx-home.

Miscellaneous questions

1. Why is there no translation for ‘my’ language?

KMyMoney uses the KDE settings for language, so first, make sure that your region and language settings are correct. If they are, the most likely reason is that no one has offered to translate it yet. Translating KDE/Qt™-based applications is very simple, and does not require any programming skills. If you would like to translate KMyMoney into your language, please post a message to the proper team mailing list. Should you fail to find your language in the list or could not contact the team members please mail directly to the KDE translation mailing list (subscription required) and we will give you the details on how you can easily provide a translation for KMyMoney.
2. Why did the version number jump from 1.0.5 to 4.5, and what happened to KMyMoney2?
   The use of KMyMoney2 was a historical legacy from when the project went from KDE 1 to KDE 2. To avoid changing the name every time there was a new KDE version, we decided to stick with KMyMoney.
   The first version of KMyMoney that was considered sufficiently stable was labeled 1.0, even though it ran under KDE 3. As the project is now becoming more closely aligned with KDE we decided to use the same major release number.

3. How can I report a bug? How can I request a new feature?
   The developers encourage your feedback. See the section on Contacting the Developers / Reporting Bugs.

4. Why isn’t there an easy way to print some scheduled transactions, or part of the ledger, or ...
   Look in the Reports section. Many of the reports actually provide an easy way to print thing you can’t quite do directly from the ledger or other screens.
Chapter 25

Reference

2014-08-30
4.7.01

25.1 Menus

Below is a complete list of the menu selections in KMyMoney, with a very brief description of what each one does. Note that many of these menu choices will be unavailable, or grayed out, depending on the current display or state of the application. For example, you are not able to edit an account unless you have an account selected or displayed in the current view.

25.1.1 File Menu

File → New (Ctrl-N)
Creates a new empty KMyMoney data file. Only one KMyMoney file can be open at once, so this will close your current file first, if one is open.

File → Open (Ctrl-O)
Opens an existing KMyMoney data file.

File → Open Recent → ...
Allows quick access to recently opened files.

File → Open Database...
Opens an existing database.

File → Save (Ctrl-S)
Saves the currently open file.

File → Save As...
Saves the currently open file with a different filename.

File → Save As Database...
Saves the currently open file in a Database.

File → Import → ...
Imports financial data from other file types, such as QIF and Gnucash, or a template file of accounts and categories that can be used in setting up new accounts.
File → Export → ...  
Exports the current file as a different file type, such as QIF, or exports a list of your accounts and categories as a template.

File → Print (Ctrl-P)  
Prints the current file.

File → Backup  
Saves a backup the current file.

File → Personal Data  
Allows to edit personal data.

File → File information  
Displays information about the currently open KMyMoney file.

File → Close (Ctrl-W)  
Closes the current file.

File → Quit (Ctrl-Q)  
Quit KMyMoney

25.1.2 Edit Menu

Edit → Find transaction... (Ctrl-F)  
Search transactions.

25.1.3 View Menu

View → Show Transaction Detail (Ctrl-T)  
Shows transaction details in the Ledger view. With this option turned on, all lines of the transaction will be shown in the ledger. When it is turned off, only one line will be shown. If you only want to see details for the currently selected transaction, but only one line for the others, you can turn on the Ledger Lens.

View → Hide reconciled transactions (Ctrl-R)  
Hides reconciled transactions on the register.

View → Hide unused categories (Ctrl-U)  
Hides unused categories in the views.

View → Show all accounts (Ctrl-Shift-A)  
Shows all accounts in the views.

25.1.4 Institution Menu

Institution → New institution...  
Add a new institution.

Institution → Edit institution...  
Edit an institution.

Institution → Delete institution...  
Delete an institution.
25.1.5 Account Menu

Account \rightarrow New account...
  Adds a new account.
Account \rightarrow Edit account...
  Edits an account.
Account \rightarrow Delete account...
  Deletes an account.
Account \rightarrow Open ledger
  Displays the ledger view of an account.
Account \rightarrow Reconcile... (Ctrl-Shift-R)
  Reconciles an account through the reconciliation wizard.
Account \rightarrow Postpone reconciliation
  Postpones reconciliation of an account.
Account \rightarrow Finish
  Finishes reconciliation of an account.
Account \rightarrow Transaction report
  Opens a transaction report of an account.
Account \rightarrow Close account
  Closes an account.
Account \rightarrow Reopen account
  Reopens an account, if closed.
Account \rightarrow Unmap account
  Unmaps an online account.
Account \rightarrow Map to online account
  Maps an account to an online account.
Account \rightarrow Update account...
  Imports transactions from online banking for an account.
Account \rightarrow Update all accounts...
  Imports transactions from online banking for all accounts.

25.1.6 Category Menu

Category \rightarrow New category...
  Adds a new category.
Category \rightarrow Edit category...
  Edits a category.
Category \rightarrow Delete category...
  Deletes a category.
Category \rightarrow Open ledger
  Displays the ledger view of a category.
25.1.7 Transaction Menu

Transaction → New (Ctrl-Ins)
   Adds a new transaction.

Transaction → Edit
   Edits a transaction.

Transaction → Edit splits
   Edits the splits of a transaction.

Transaction → Delete
   Deletes a transaction.

Transaction → Duplicate
   Duplicates a transaction.

Transaction → Mark transaction as ... → Not Reconciled
   Changes a transaction to Not Reconciled status.

Transaction → Mark transaction as ... → Cleared (Ctrl-Shift-Space)
   Changes a transaction to Cleared status.

Transaction → Mark transaction as ... → Reconciled (Alt-Ctrl-Space)
   Changes a transaction to Reconciled status.

Transaction → Go to account
   Displays the other account of a transaction.

Transaction → Go to payee
   Displays the Payee view and focuses on the payee of the selected transaction.

Transaction → Create scheduled transaction...
   Creates a new scheduled transaction.

Transaction → Match
   Matches imported transactions.

Transaction → Unmatch
   Unmatches a transactions that KMyMoney has proposed as a match of imported transac-
   tions. Note that this menu choice is only present if a matched transaction exists.

Transaction → Accept
   Accepts a proposed merge of imported transactions.

Transaction → Select all (Ctrl-A)
   Selects all transactions on the register.

Transaction → Print check
   Prints the contents of the selected transaction in the displayed register, formatted accord-
   ing to the selected template. Note that this menu choice is only present if a transaction
   is selected in the register. See the section on configuring the Print check plugin for more
   information.
25.1.8 Tools Menu

**Tools → QIF Profile Editor...**
Modifies the QIF profile used to import or export QIF files.

**Tools → Currencies...**
Lists the currencies known to KMyMoney.

**Tools → Prices...**
Lists stock and currency prices.

**Tools → Update Stock and Currency Prices...**
Updates stock and currency prices from online sources using the Online Price Quotes feature.

**Tools → Consistency Check**
Runs a check on your file and tries to fix any problem it finds, if possible.
Make a backup of your file before running this option.

**Tools → Performance-Test**
Runs a performance test on your file and displays the results.

25.1.9 Settings Menu

**Settings → Hide/Show Toolbar**
Toggles the toolbar on or off.

**Settings → Hide/Show Statusbar**
Toggles the bottom status bar on or off.

**Settings → Enable all messages**
Re-enables any messages you may have turned off by checking Don’t tell me about this again in a dialog box.

**Settings → KDE Language Settings...**
Allows to change many locale based settings.

**Settings → Configure Shortcuts...**
Configures custom shortcuts.

**Settings → Configure Toolbars...**
Customizes KMyMoney toolbars.

**Settings → Configure KMyMoney...**
Configures KMyMoney settings.
25.1.10 Help Menu

Help → KMyMoney Handbook (F1)
Invokes the KDE Help system starting at the KMyMoney help pages. (this document).

Help → What’s This? (Shift+F1)
Changes the mouse cursor to a combination arrow and question mark. Clicking on items within KMyMoney will open a help window (if one exists for the particular item) explaining the item’s function.

Help → Report Bug...
Opens the Bug report dialog where you can report a bug or request a ‘wishlist’ feature.

Help → Switch Application Language...
Opens a dialog where you can edit the Primary language and Fallback language for this application.

Help → About KMyMoney
This will display version and author information.

Help → About KDE
This displays the KDE version and other basic information.

25.2 Widgets

KMyMoney has some specific widgets not found in other applications. The usage of these widgets is explained in this chapter.

25.2.1 Date entry widget

Whenever KMyMoney needs information about a specific date, e.g., the posting date of a transaction or the opening date of an account, it offers the user the date entry widget. This widget consists of three fields and a button. The fields present the day, the month, and the year, separated by the date separator characters specified by your locale settings. The button - if pressed - opens the datepicker widget.

Within the date entry widget, the left/right cursor keys can be used to switch between the day, the month, and the year fields. Using the up/down cursor keys, the value of the selected field can be...
incremented/decremented. The + and - keys can be used to increment/decrement a single day.
Month and year boundaries are considered and incremented/decremented if necessary. Pressing
T will set the date to today’s date.

The date can also be changed using the mouse. Clicking on the day, month, or year field selects
the field. The value can then be incremented/decremented using the arrow buttons on the right
of the widget. They act exactly the same as the up/down key.

The datepicker opens when the button to the right of the arrow buttons is pressed. It shows
four arrow buttons at the top, two on each side of the currently selected month name and year.
The leftmost buttons are used to decrement the year and the month; the buttons to the right of
the year are used to increment the month and the year. The button to the very right closes the
datepicker.

Beneath the buttons, the widget presents a calendar page for the selected month. Clicking a day
on the calendar selects that date, closes the datepicker, and transfers the selected date into the
day, month, and year fields.

At the bottom of the datepicker widget, there are a button, a text edit field, and a combo box.
Pressing the button selects today’s date in the datepicker. The text field can be used to enter a
specific date. Pressing the RETURN key shows that date in the datepicker widget. The combo
box allows the user to select a specific week, and continue to pick a date from there.

25.2.2 Value entry

The value entry widget consists of a text field (that accepts digits, thousands separators, and
decimal symbols) as well as a button to the right. Use the digits to enter the value. Separate the
fractional part by entering the decimal separator for your locale. If you click on the button to the
right or press a key representing a numeric operation (e.g., +,-,/,* or %) a little calculator will pop
up and allow you to calculate the final value.

Negative values can be entered by preceding the value with a minus sign. In case your locale
is set to display negative numbers with parentheses around the value, the value can also be
enclosed in parenthesis in the value entry widget.

Use the calculator widget just like a normal calculator and once done leave it by clicking on the
’=’ button or press the ’=’ key on your keyboard.

25.2.3 Payee/Payer entry

When you are requested to enter a payee/payer for a transaction, you can start entering the name
by pressing keys on your keyboard. As long as matching entries exist in the list of payees/payers
maintained by KMyMoney they will be presented in a box beneath or above the text entry area.
Using the mouse or the up/down keys one can select a name from that list. Using the keyboard
additionally requires you to select the entry by pressing the RETURN key.
If a name is entered that is not yet known to KMyMoney you will be asked if you want to create a new payee/payer record. If you do not wish to do so, then the field will be blanked. Otherwise, the record will be created and added to the list.

Once the edit field contains characters, the list only shows those payees that match the character sequence entered. Double-click on the arrow of the combo box to show all payees in the list.

25.2.4 Category/account entry

When you are requested to enter the name of a category or account, you can start entering the name by pressing keys on your keyboard. As long as matching entries exist in the list of categories/accounts known to KMyMoney they will be presented in a box beneath or above the text entry area. Using the mouse or the up/down keys one can select a name from that list. Using the keyboard additionally requires you to select the entry by pressing the RETURN key.

If a name is entered that is not yet known to KMyMoney you will be asked if you want to create a new category record. If you do not wish to do so, then the field will be blanked. Otherwise, the record will be created and added to the list.

Once the edit field is filled with characters, the list only shows those categories/accounts that match the character sequence entered. Double-click on the arrow of the combo box to show the complete list.
Chapter 26

Credits

2014-08-30
4.7.01
Program Copyright (c) 2000 - 2017 The KMyMoney Development Team
Documentation Copyright (c) 2000 - 2017 The KMyMoney Development Team

26.1 Original Author

- Michael Edwardes mte@users.sourceforge.net Original idea, much initial source code. Project admin.

26.2 Active Developers

- Thomas Baumgart ipwizard@users.sourceforge.net Release manager and de-facto Maintainer. Core engine. Project admin.
- Tony Bloomfield tonybloom@users.sourceforge.net GnuCash Importer. Database support.
- Robert Wadley robntina@users.sourceforge.net Artist. Icons, splash screen, home view. Screenshots.
- Alvaro Soliverez asoliverez@users.sourceforge.net Forecast. Reports.
- Fernando Vilas fvilas@users.sourceforge.net Database support.
- Cristian Onet onet.cristian@gmail.com Patches and Plugins
- Jack H. Ostroff ostroffjh@users.sourceforge.net Documentation.
- Migration to KDE4/Qt4 This was a massive effort, and many developers contributed. Apologies to any we forgot to name explicitly.

26.3 Developers of Previous Versions

- Ace Jones acejones@users.sourceforge.net Reports. OFX Import. Online Quotes. Documentation editor.
The KMyMoney Handbook

- Kevin Tambascio ktambascio@users.sourceforge.net Initial investment support.
- Felix Rodriguez frodriguez@users.sourceforge.net Project admin.
- John C tacoturtle@users.sourceforge.net Developer.

26.4 Special Thanks

- Javier Campos Morales javi_c@users.sourceforge.net Developer & Artist.
- Laurent Montel montel@kde.org Patches.
- Roger Lum rogerlum@gmail.com Documentation.
- Darin Strait darin.strait@ashdar-partners.com Documentation.
- Allan Anderson agander93@gmail.com Patches. CSV Importer Plugin.
- Colin Wright cdwright@gwi.net Patches and Documentation.
- Bernd Gonsior bernd.gonsior@googlemail.com Reports. Migration to KDE4/Qt™4.
- Ian Neal iann_bugzilla@blueyonder.co.uk Scheduled transactions and calendars.

This documentation is licensed under the terms of the GNU Free Documentation License. This program is licensed under the terms of the GNU General Public License.
Appendix A

Installation

This appendix primarily addresses the installation of KMyMoney under the Linux® operating system. The final section addresses other operating systems.

A.1 How to obtain KMyMoney

KMyMoney has existed for a number of years, and we have worked very hard on full integration into KDE. The earliest stable versions (1.0.x) required libraries from KDE 3, and so were not available in many Linux distributions, which had already migrated to KDE 4. However, with the release of version 4.5 in August 2010, KMyMoney could be easily compiled and installed on any version of KDE 4.3 or higher. The current version, 4.7, requires KDE 4.6, specifically kdelibs and kdepimlibs.

Although work has begun porting KMyMoney to the new KDE Frameworks 5, this is still very early, and not yet usable. Hopefully it will be available in the 5.0 version, which we expect to release in early 2015. Until then, if you are specifically interested in following this work, you should subscribe to the developers mailing list kmymoney-devel@kde.org.

The rest of this section will describe installing KMyMoney using the standard software installation process for your Linux distribution. The following section will discuss compiling from source.

A.1.1 Official Distribution Packages

The best way to install KMyMoney is to use the package manager of your distribution, such as apt-get, yum, portage, or pacman. This will take care of all the dependencies and required libraries. Although it takes some time after the release a new version of KMyMoney for all the distributions to add it to their official repositories, please check there first.

A.1.2 Unsupported Repositories

Many Linux distributions have users who provide unsupported repositories that offer more up-to-date packages than the distributions’ official repositories. A list of these may be found at the KMyMoney home page.
A.2 Compiling KMyMoney from Source

More up-to-date information on the latest available version and any known installation issues will be available on the KMyMoney home page. That page will also have links to tarballs of recent versions as well as instructions for obtaining the source from KDE Git, in case you want to compile the latest, development version.

As the previous paragraph implied, there are two distinct reasons to compile KMyMoney from source. If you cannot find a version specifically packaged for your distribution, please download the tarball of the most recent stable release. This is version 4.6.0 as of the time this is being written. This is the compile option recommended for normal users.

On the other hand, if you want to see the current state of development, to check out a recent bug fix or new feature, you can download a tarball which is a snapshot of the development repository. You can also check the source directly out of the repository. The version 4.x source is in KDE Git. (The version 1.0.x source was in SourceForge cvs, but it is no longer being developed or supported at all.) Instructions for access are on the project home page.

WARNING
The code in the Git repository and in development snapshots is under active development: it may have bugs, it may crash, and it may mess up or lose data. If you use it, be absolutely sure to make adequate backups. Unless you have a good reason to use this, stick to a stable released version.

A.2.1 Required libraries

KMyMoney depends on certain libraries in order to compile and run properly. First is KDE version 4.3.5 or later, specifically kdelibs and kdepimlibs. Depending on your distribution, you may need to explicitly load the ‘-devel’ versions in order to compile KMyMoney, rather than just running a pre-compiled version. As of version 4.6.0, KMyMoney also depends on libalkimia, version 4.3.1 or higher. Additional requirements may be detected during the ‘cmake’ step below.

Additional functionality can be obtained if extra libraries are available at compile time. The two most common are

- libofx, version 0.9.4 or higher, to be able to import financial data in the OFX format, and
- AqBanking, version 5.0.0 or higher, to be able to use certain on-line banking features. Note that version 5.0.14 or higher is strongly recommended, due to bugs in earlier versions.

A.2.2 Build instructions

KMyMoney uses the cmake build system. Further information can be found in the README.cmake file in the root folder of the source. The basic steps are the following:

$ mkdir build
$ cd build
$ cmake .. -DCMAKE_INSTALL_PREFIX=/usr/
$ make
$ sudo make install/fast

IMPORTANT
Note that the last step is required. KMyMoney expects to find certain components in standard locations, and if you run it from within the build directory without the install step, you will have missing icons or other surprises.
If you have compiled the source from git, and want to update to the latest revision, most of the
time you can do the following:

```bash
$ cd <path to root of source>
$ git pull --rebase
$ cd build
$ make
$ sudo make install/fast
```

However, changes made by the developers sometimes cause compile problems if you do not start
with a clean code base. In these cases, you need to do the following:

```bash
$ cd <path to root of source>
$ git pull --rebase
$ rm -r build
$ mkdir build
$ cd build
$ cmake .. -DCMAKE_INSTALL_PREFIX=/usr/
$ make
$ sudo make install/fast
```

### A.3 Installing KMyMoney without Linux

KMyMoney has been successfully compiled for Mac OS X, and is available at the [MacPorts website](https://www.macports.org/).

KMyMoney is also available for Windows. This initiative is still a work in progress, but great
improvements have been made in the past year. For more information about running KDE, in-
cluding KMyMoney on Windows see the [KDE on Windows Initiative page](https://kde.org/initiatives/windows/). For a standalone
installer that only installs KMyMoney see the download link on the right of the KMyMoney home
page. Note that the most recent version of this installer no longer works on Windows XP. At
the time of this release, it was not known if this could be changed, as the issue was related to the
tools used to build the application, not the application itself.

If you know of KMyMoney being successfully compiled and made available for any other oper-
ating system, please let us know, so we can spread the word.